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1.0     INTRODUCTION 

 

In this unit, we are going to learn basics of computer. Computer is a machine that 

performs tasks or calculations according to a set of instructions, or programs. 

Compared to those early machines, today's computers are amazing. Not only are 

they thousands of times faster, they can fit on your desk, in your lap, or even in 

your pocket. Computers work through an interaction of hardware and software.  

 

Hardware is physical component of a computer system.  It is a tiny rectangular 

chip inside the computer called the central processing unit (CPU), 

or microprocessor. It is the "brain" of computer—the part that translate 

instructions and performs calculations. Hardware items such as monitor, 

keyboard, mouse, printer, and other items are often called hardware devices. 

Software refers to the instructions or programs that tell the hardware what to do.  

 

The operating system (OS) is system software that manages computer and the 

devices connected to it. OS is responsible for management and coordination of 

activities and the sharing of the limited resources of computer. The OS acts as a 

host for other application software. 
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Lab Course We will be discussing about two well known operating systems: 

(a)   Windows operating system, and 

(b)   Linux operating system.  

 

1.1  OBJECTIVES 

                  

         After going through this unit, you should be able to: 

 understand about computer and it’s components; 

 features of Windows  XP; 

 know the  installation procedure of  Windows XP; 

 features of  Linux  (Fedora); 

 know the installation procedure of Fedora; and 

 know the utilities and basic commands of Fedora. 

 

1.2   FAMILIARIZATION WITH I/O PORT, KEYBOARD, 

MEMORY 

                

Computer plays a key role in how individuals work and how they live. Even the 

smallest organizations have computers to help them operate more efficiently, and 

many individuals use computers at home for educational, entertainment, and 

business purposes.  Thus you must be familiar with computers and its 

components. 

 

                 In the following sub-sections, we will discuss the same and there is practice 

session also at the end of this section. Hope you will enjoy this practice session. 

 

1.2.1 Computer and Motherboard     

 

Computer  : A computer is programmable machine that receives input, stores, 

manipulate data, and provides output in a useful format.  

 

Computer takes input from input devices and then compute in CPU and stores in 

memory and sends output to output devices. The most common device for input is 

the keyboard. When you type, you are putting information into the computer, 

which is known as input. The most common device for output is the monitor. 

These input output devices are connected through I/O Ports. 
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Figure 1.1 : Working of Computer 

 A computer system unit contains many parts. As shown in Figure 1.2(a) and 

Figure 1.2 (b). 

Motherboard : The motherboard is the main circuit board of a computer.  It is 

also known as the main board or system board. Typically, the motherboard 

contains the CPU, BIOS, memory, mass storage interfaces, serial and parallel 

ports, expansion slots, and all the controllers required to control standard 

peripheral devices, such as the display screen, keyboard, and disk drive. 

Collectively, all these chips that reside on the motherboard are known as the 

motherboard's chipset. The motherboard can be thought of as the "back bone" of 

the computer. 

 

 

 

Figure 1.2(a) : Overview of Motherboard 
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Figure 1.2 (b) : Detailed Overview of Motherboard 

CPU : The CPU is the central electronic chip that contains the processing power 

of the computer. Today, all CPUs are microprocessors. 

1. A microprocessor is a complete computer on a silicon chip.   

2. A microprocessor does all of the functions of a computer. 

 stores data and instructions waiting to be used. 

 follows changeable instructions. 

 does input, processing, and output. 

 

Memory : Memory is the part of the computer that temporarily stores 

applications, documents, and system operating information. 

  

1.2.2        I/0 Ports 

In this sub-section, we will study about I/O ports. 

Ports and Connectors : A port is a connector located on the motherboard or on a 

separate adapter. This we will discuss in following sub section.  

As shown in figure 1.2 an internal view of some of the I/O ports. On the back of 

computers are several I/O (or Input/output) ports. Above, on the very top are two 

PS/2 ports, normally used for mouse and keyboard connections. Below that are 

the USB, (or Universal Serial Bus), ports. Below those are two serial ports beside 

a long parallel port that is often used to connect to a printer. On the bottom right is 

a game port for joysticks or other game controllers. On the bottom left is a 

microphone hook up, a speaker hook up, and an additional hook up for another 

sound input device like a musical keyboard.  
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Figure 1. 3.  I/O Port 

I/O ports are there to connect to I/O devices. There are various I/O devices which 

are discussed in the next subsection:  

1.2.3     I/O Devices 

Few I/O devices are given Table 1.1. 

Table 1.1 : I/O Devices 

Here, we are discussing about Keyboard and mouse. Rest is kept for you to 

explore. 

Keyboard Basics           

Keyboard 

 is  used to type data into the computer. 

 is most common input device.  

 has special keys for giving the computer commands. 

 Commands tell the computer to do something, like save the file. 

 These special keys are called command or function keys. 

   Input Devices                                                                   Output Devices  

 

Mouse Monitor 

Joystick LCD 

Scanner Printer 

Light Pen Plotter 
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Figure 1.4: Overview of Keyboard 

     

Types of Keys              

Typing Keys / Main Typing Keypad: It holds alphabetic character such as letter, 

special characters and numbers for typing. 

Numeric Keypad: It can be used as numeric and directional keys, pressing the 

Num Lock key above the numeric keypad will tell whether the keys are on 

numeric or directional mode. If it is on, it is on numeric mode and can enter 

numbers. If it is off, it is on directional mode and only used for moving a cursor 

on screen UP, Down, Left or Right. 

Function Keys: There are 12 functions keys starting from F1 through F12. These 

keys are used for special purposes. 

Control Keys: It has two groups of keys, arranged from top to bottom. 

The top keys holds Insert, Home, Page Up, Page Down, Delete, and End keys. 

Insert key switches between insert and overtype modes. Home key brings you 

back at the beginning of a page. Page Up and Page Down keys help you to move 

one page or screen up or down. Delete key erases a text or page. The End key 

takes you at the end of a page. 

The bottom keys are independent directional keys, which let you to move the 

cursor Left, Right, Up and Down. Status lights, Escape key, Print Screen/SysRq, 

Scroll Lock, and Pause/Break are user for frequent functions. 

Status Lights : These light indicate whether Num Lock, Caps Lock or scroll 

Lock light is on /off. 

There are several short cut keys to make our work convenient when mouse is not 

working or if we do not want to do several manouvres with the mouse. It makes 

our work convenient while working with MS-Word. 

 

Shortcut Keys Description 
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Ctrl + A Select all contents of the page. 

eeeeeeeeee

Ctrl + B Bold highlighted selection. 

Ctrl + C Copy selected text. 

Ctrl + E 
Aligns the line or selected text to the center of the 

screen. 

Ctrl + F Open find box. 

Ctrl + I Italic highlighted selection. 

Ctrl + J Aligns the selected text or line to justify the screen. 

Ctrl + K Insert link. 

Ctrl + L Aligns the line or selected text to the left of the screen. 

Ctrl + M Indent the paragraph. 

Ctrl + P Open the print window. 

Ctrl + Spacebar Reset highlighted text to the default font. 

Ctrl + 1 Single-space lines. 

Ctrl + 2 Double-space lines. 

Ctrl + 5 1.5-line spacing. 

Ctrl + Alt + 1 Changes text to heading 1. 

Ctrl + Alt + 2 Changes text to heading 2. 

Ctrl + Alt + 3 Changes text to heading 3. 

Alt + Ctrl + F2 Open new document. 

Ctrl + F1 Open the Task Pane. 

Ctrl + F2 Display the print preview. 

Ctrl + Shift > Increases the highlighted text size by one. 

Ctrl + ] Increase selected font +1pts. 

Ctrl + Shift + < 
Decrease selected font -1pts if 12pt or lower, if above 

12 decreases font by +2pt. 

Ctrl + [ Decrease selected font -1pts. 

Ctrl + / + c Insert a cent sign (¢). 
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How keyboard connects to a computer? 

        Computer Keyboard can connect with a computer through a cable or signal 

(wireless connection). Until recently, a keyboard used to connect with the 

standard PS/2 type or Serial. 

Ctrl + R 
Aligns the line or selected text to the right of the 

screen. 

Ctrl + T Create a hanging indent. 

Ctrl + U Underline highlighted selection. 

Ctrl + V Paste. 

Ctrl + X Cut selected text. 

Ctrl + Y Redo the last action performed. 

Ctrl + Z Undo last action. 

Ctrl + Shift + F Change the font. 

Ctrl + Shift + > 
Increase selected font +1pts up to 12pt and then 

increases font +2pts. 

Ctrl + ' + <char> 

Insert a character with an accent (grave) mark, 

where <char> is the character you want. For 

example, if you wanted an accented è you would 

use Ctrl + ' + e as your shortcut key. To reverse 

the accent mark use the opposite accent mark, 

often on the tilde key. 

Ctrl + Shift + * View or hide non printing characters. 

Ctrl + <left arrow> Moves one word to the left. 

Ctrl + <right arrow> Moves one word to the right. 

Ctrl + <up arrow> Moves to the beginning of the line or paragraph. 

Ctrl + <down arrow> Moves to the end of the paragraph. 

Ctrl + Del Deletes word to right of cursor. 

Ctrl + Backspace Deletes word to left of cursor. 

Ctrl + End Moves the cursor to the end of the document. 

Ctrl + Home 
Moves the cursor to the beginning of the 

document. 
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serial bus) and wireless connectors. Most modern PCs (motherboards) even don’t

have PS/2 connectors, only USB. 

Since, there is no cable connection with main PC, wireless keyboard gets power 

from battery or a/c power connection. This is the side effect of wireless 

keyboards; you often have to change battery.  

Mouse  

The mouse is a small device used to point to a particular place on the   screen and 

select in order to perform one or more actions. It can be used to select menu 

commands, size windows, start programs etc. The most conventional kind of 

mouse has two buttons on top: the left one being used most frequently.     

 
                                       Figure 1.5 :  Mouse and its buttons  

Mouse buttons  

                    

Primary button / left button for left click 

Secondary button / right button for right click        

Scroll wheel for moving page up or down      

Mouse Actions  

Pointing   :  Point the object  

Left Click: Used to select an item.  

Double Click: Used to start a program or open a file.  

Right Click: Usually used to display a set of commands.  

Drag and Drop: It allows you to select and move an item from one location to 

another. To achieve this place the cursor over an item on the screen, click the left 

mouse button and while holding the button down move the cursor to where you 

want to place the item, and then release it.  

How Mouse is connected to PC  

Mouse is connected to pc similarly as keyboard. It can be connected with either 

PS/2 connectors or USB. The connections can be through a cable or wirelessly as 

well. 
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Now we discuss about one of the most important parts of computers i.e memory.   

Computers generally possess several distinct types of memory, each of which 

"holds" or stores information for subsequent use. The vast majority of computer 

memory can be placed into one of two categories: primary memory and 

secondary memory. 

 

Figure 1.6 :  Hierarchy of memory 

Primary memory, often called main memory, constitutes that device, or group of 

devices, that holds instructions and data for rapid and direct access by the 

computer's central processing unit (CPU). Primary memory is synonymous with 

random-access memory (RAM). 

 

Figure 1.7 :  RAM 

Modern RAM is made of semiconductor circuitry. RAM is a volatile form of 

information storage, meaning that when electrical power is terminated any data 

that it contains is lost. There are other semiconductor memory devices accessed 

by the CPU that are generally considered as being distinct from primary memory 

(i.e., different from RAM). These memory units include cache memory, read-only 

memory (ROM), and Programmable Read Only Memory (PROM) and 

EPROM (erasable programmable read-only memory 

Secondary memory, also called auxiliary memory or mass storage, consists of 

devices not directly accessible by the CPU. Hard drives, floppy disks, tapes, and 

optical disks are widely used for secondary storage. First, most secondary storage 

devices are capable of containing much more information than is feasible for 

primary memory (hence the use of the term "mass storage" as 

a synonym for secondary memory). A second, and essential, feature 

of secondary memory is that it is non-volatile. This means that data is stored with 

or without electrical power being supplied to the device, as opposed to RAM, 

which can retain its data only so long as electrical power is present. 

Like primary memory, many secondary memory devices are capable of storing 

information, as well as retrieving it. Magnetic technology devices (such as hard 

drives, floppy disks, and tape) have this read-write capability, as do magneto-

optical drives. However, some mass storage devices can only read data, as in the 

case of CD-ROM (Compact Disk-Read Only Memory) drives. CD-ROMs utilize 
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Operating System optical technology; however, newer optical technologies, such as CD-RW 

(compact disk-rewriteable), can both read and write information like 

magnetic storage devices. 

 

Hard Disk  

                   
    Figure 1.8(a) : Internal view             Figure 1.8(b) : External view 

 
The hard disk is the main, and usually largest, data storage device in a computer. 
The operating system, software titles and most other files are stored in the hard 
disk. 
       
Now let’s have a Practice Session 
 

Check Your Progress 1 

1. Find shortcut keys for the following: 

a) To Open Help. 

b) To repeat the last action performed. 

c) To save document 

d) To Bold the selected  text  

e) Change the text in Microsoft Word from uppercase to lowercase or capital 

letter at the beginning of every word. 

2.   List use of following function keys: 

           F1, F2, F3, F4, F5, F7, F8, F12 

3.   Type the following passage in MS-WORD 

over the past few years the growth of the computer industry has been quiet 

remarkable and today it is the fastest growing industry in our economy. 

Nowadays, many schools are equipped with computers for educating their 

students. Thereby making computers an integral part of education system. 

Teachers and profesors use computers for teaching, giving presentations, 

assessing various data banks, maintaining database of students, 

communication in the form of e mails or chat, browsng the Internet and 
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Lab Course Preparing students to have a competitive edge in the global job market. 

Computers have revolutionized the learning for students in a big way. They 

can watch various films on wild life, history, geography, science and 

encyclopedias with loud sound and excellent picture quality on 

CompactDisc’sorDVD’s. 

(a)  In this paragraph, there are few spelling errors. Try spelling check for 

this. Try to find and replace ‘loud’ by ‘‘excellent”.  

(b)  Now save this paragraph with the name ‘computer’ on your desktop. 

1.3  WINDOWS OPERATING  SYSTEM 

 

The main operating systems involved in networking now days are Windows and 

Linux. Both are having their own advantages and disadvantages. Linux works 

better on older, less powerful computer hardware because it requires less resource 

(memory or processing) as compared to Windows. Compared to Windows, Linux 

is virus-free and bugs free. Windows provides the user a mature, familiar and 

interactive interface that is easy to learn and understandable. But we think that a 

network administrator should have an expertise on both of these leading network 

operating systems. Even most of the network administrators are running both 

Linux and Windows on the server for the best networking. 

      

  This section provides you the:  

       

(1)   Discussions, demonstrations, and lab exercises to sharpen your skills and 

knowledge necessary to admin and support Windows XP/Linux 

networking. 

(2)   It contains an overview of Windows XP and Linux/Unix in the beginning 

to develop your understanding of these operating systems.  

(3)    Further in this course you have an example to introduce you in the lab.      

Then you have different lab exercises on Linux/Unix and on Windows XP. 

 

1.3.1 Overview of Windows  

 

Background to Windows  

 
 

Windows XP is an operating system that was produced by Microsoft for use on 

personal, including home and business desktops, laptops, and media centers. It 

was first released to computer manufacturers on August 24, 2001, and is the most 

popular version of Windows, based on installed user base. The name "XP" is 

short for "experience."  
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Operating System Windows XP was the successor to both Windows 2000 and Windows Me, and 

was the first consumer-oriented operating system produced by Microsoft 

System Requirement for windows XP. 

 Pentium 233-megahertz (MHz) processor or faster (300 MHz is 

recommended). 

 At least 64 megabytes (MB) of RAM (128 MB is recommended). 

 At least 1.5 gigabytes (GB) of available space on the hard disk. 

 CD-ROM or DVD-ROM drive. 

 Keyboard and a Microsoft Mouse or some other compatible pointing device. 

 Video adapter and monitor with Super VGA (800 x 600) or higher resolution. 

 Sound card. 

 Speakers or headphones. 

1.3.2 Windows Installing Procedure  

This procedure demonstrates how to install Windows XP Professional. The 

procedure to install Windows XP home edition is very similar to the professional 

edition. Since Windows XP Pro is more advanced operating system, it will be 

used to demonstrate the installation procedure. 

The best way install Windows XP is to do a clean install. It is not difficult to 

perform a clean installation. Before you perform the installation I recommend that 

you check Windows XP Compatibility List to ensure that your hardware is 

supported by XP. If your hardware is not on the compatibility list you can check 

your hardware manufactures website to download the drivers for Windows XP. 

Save all the necessary drivers onto floppy disks or CD before you start the 

installation. 

    

Step 1 : Start your PC and place your Windows XP CD in your CD/DVD-ROM 

drive. Your PC should automatically detect the CD and you will get a 

message saying "Press any key to boot from CD". Soon as computer 

starts booting from the CD your will get the following screen: 
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Lab Course Step 2 :  At this stage it will ask you to press F6  

 

Step 3  Press S to specify that you want to install additional device. 

 

Step 4 : You will be asked to insert the floppy disk with drivers. Press enter after 

you have inserted the disk. 

 

Step 5 : You will see a list of drivers for your HDD. Select the correct driver for 

your device and press enter. 

 

Step 6 : You will then get a Windows XP Professional Setup screen. You have 

the option to do a new Windows install, Repair previous install or quit. 

Since we are doing a new install we just press Enter to continue. 
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Operating System Step 7 : You will be presented with the End User Licensing Agreement. Press F8 

to accept and continue 

 

Step 8 : This step is very important. Here we will create the partition where 

Windows will be installed. If you have a brand new unformatted drive 

you will get a screen similar to below. In our case the drive size is 

8190MB. We can choose to install Windows in this drive without 

creating a partition, hence use the entire size of the drive. If you wish to 

do this you can just press enter and Windows will automatically partition 

and format the drive as one large drive. 

 

Step 9: Windows will show the total size of the hard drive and ask you how much 

you want to allocate for the partition you are about to create. I will choose 

6000MB. You will then get the screen below. Notice it shows C: Partition 

1 followed by the size 6000 MB. This indicates the partition has been 

created. We still have an unpartitioned space of 2189MB. Next highlight 

the unpartitioned space by pressing down the arrow key. Then press C to 

create another partition. You will see the total space available for the new 

partition. Just choose all the space left over, in our case 2180MB. 

 

Step 10 :  Choose format the partition using NTFS file system.This is the 

recommended file system. If the hard drive has been formatted 

before then you can choose quick NTFS format. We chose NTFS 

because it offers many security features, supports larger drive size, 

and bigger size files. 
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on the two images below : 

 
 
 

 

Step 11 : After the setup has completed copying the files the computer will 

restart. Leave the XP CD in the drive but this time DO NOT press any 

key when the message "Press any key to boot from CD" is displayed. In 

few seconds setup will continue. Windows XP Setup wizard will guide 

you through the setup process of gathering information about your 

computer. 

 

 

Step 12 :  Choose your region and language. 
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Operating System Step 13 :  Type in your name and organization. 
 

 
 
Step 14 :  Enter your product key. 
 

 
 
Step 15:  Name the computer, and enter an Administrator password. Don't forget 

to write down your Administrator password. 
 

 

Step 16:  Enter the correct date, time and choose your time zone. 

 
 

Step 17:  For the network setting choose typical and press next. 
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Lab Course Step 18 : Choose workgroup or domain name. If you are not a member of a 
domain then leave the default settings and press next. Windows will 
restart again and adjust the display. 

 

 
 

Step 19: Finally, Windows will start and present you with a Welcome screen. 
Click next to continue. 

 

 
 

Step 20 : Choose 'help protect my PC by turning on automatic updates now' and 

press next. 

 

 
 

Step 21 : Will this computer connect to the internet directly, or through a 
network? If you are connected to a router or LAN then choose: 'Yes, 

this computer will connect through a local area network or home 

network'. If you have dial up modem choose: 'No, this computer will 

connect directly to the internet'. Then click Next. 
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Operating System Step 22 : Ready to activate Windows? Choose yes if you wish to active Windows 
over the internet now. Choose no if you want to activate Windows at a later stage. 
 

 
 

Step 23: Add users that will sign on to this computer and click next. 
 

 
 
Step 24 : You will get a Thank you screen to confirm setup is complete. Click 

finish. 

 
 
Step 25 : Log in, to your PC for the first time. 

 
 

 

Step 26 : You now need to check the device manager to confirm that all the 
drivers has been loaded or if there are any conflicts. From the start 
menu select Start -> Settings -> Control Panel. Click on 
the System icon and then from the System Properties window select 
the Hardware tab, then click on Device Manager. 
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If there are any yellow exclamation mark "!" next to any of the listed device, it 

means that no drivers or incorrect drivers has been loaded for that device. In our 

case we have a Video Controller (VGA card) which has no drivers installed. 

Your hardware should come with manufacturer supplied drivers. You need to 

install these drivers using the automatic setup program provided by the 

manufacturer or you need to manually install these drivers. If you do not have the 

drivers, check the manufacturer’s website to download them. 

To install a driver manually use the following procedure: 

(a)  From the device manager double click on the device containing the 

exclamation mark. 

(b)  This would open a device properties window. 

(c)  Click on the Driver tab. 

(d)  Click Update Driver button. The Wizard for updating device driver pops up 

as shown below: 

 

 

 

You now get two options. The first option provides an automatic search for the 

required driver. The second option allows you to specify the location of the 

driver. If you don't know the location of the driver choose the automatic search 

which would find the required driver from the manufacturer supplied CD or 

Floppy disk. Windows would install the required driver and may ask you to restart 

the system for the changes to take affect. Use this procedure to install drivers for 

all the devices that contain an exclamation mark.  
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i)      Desktop 

 

The typical Windows XP desktop includes following desktop icons  

 

Icons are small pictures that represent files, folders, programs, and other items. 
Double-clicking a desktop icon starts or opens the item it represents. For e.g. 
Internet Explorer. It is used to quickly access Internet. 

The Taskbar is usually located on the bottom of the screen. It houses the Start 
button, clock, and a task button for each active program currently running and 
each open folder.  

ii)  Parts of a window 

      Most windows have the same basic parts: 
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   Title bar. Displays the name of the document and program (or the 

folder name if you’re working in a folder).

   Minimize, Maximize, and Close buttons. These buttons hide the 

window, enlarge it to fill the whole screen, and close it, respectively 

(more details on these shortly). 

   Menu bar. Contains items that you can click to make choices in a 

program. See Using menus, buttons, bars, and boxes. 

   Scroll bar. Lets you scroll the contents of the window to see 

information that is currently out of view. 

   Borders and corners. You can drag these with your mouse pointer to 

change the size of the window. 

a) Moving a window 

To move a window, point to its title bar with the mouse pointer  . Then drag 

the window to the location that you want. (Dragging means pointing to an 

item, holding down the mouse button, moving the item with the pointer, and 

then releasing the mouse button.) 

Changing the size of a window 

 To make a window fill the entire screen, click its Maximize button  or 

double-click the window's title bar. 

 To return a maximized window to its former size, click 

its Restore button  (this appears in place of the Maximize button). Or, 

double-click the window's title bar. 

 To resize a window (make it smaller or bigger), point to any of the 

window's borders or corners. When the mouse pointer changes to a two-

headed arrow (see picture below), drag the border or corner to shrink or 

enlarge the window. 

 
A window that is maximized cannot be resized. You must restore it to its 

previous size first. 

b) Hiding a window 

Hiding a window is called minimizing it. If you want to get a window out 

of the way temporarily without closing it, minimize it. 
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Operating System To minimize a window, click its Minimize button . The window disappears 

from the desktop and is visible only as a button on the taskbar, the long horizontal 

bar at the bottom of your screen. 

To make a minimized window appear again on the desktop, click its taskbar 
button. The window appears exactly as it did before you minimized it. 

Closing a window 

Closing a window removes it from the desktop and taskbar. If you're done with a 

program or document and don't need to return to it right away, close it. 

To close a window, click its Close button . 

c)  Switching between windows 

 If you open more than one program or document, your desktop can 

quickly become cluttered with windows. Keeping track of which windows 

you have open isn't always easy, because some windows might partially or 

completely cover others. 

 Using ALT+TAB. You can switch to the previous window by pressing 

ALT+TAB, or cycle through all open windows and the desktop by holding 

down ALT and repeatedly pressing TAB. Release ALT to show the 

selected window. 

 

Arranging windows automatically 

Now that you know how to move and resize windows, you can arrange them 

however you like on your desktop. You can also have Windows automatically 

arrange them in one of three ways: cascading, vertically stacked, or side by side. 
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click Cascade Windows, Show Windows Stacked, or Show Windows Side by 

Side. 

iii)  Program Management  

You can launch most of your applications via the Start button and Start Menu. 

Most of your applications can be launched by selecting Start, All Programs, then 

any program name, e.g. Microsoft Word. If an application is saved within a 

folder, you would launch it by selecting Start, Programs, folder name (e.g., 

Accessories), then program name (e.g., WordPad). 

You can switch between running applications by clicking on them in the Taskbar 

or holding down the Alt key, then depressing and releasing the Tab key. If you 

inadvertently launch multiple copies of the same program, you will find that all 

the of copies will be grouped on to one particular Tab button. The Tab will 

display the name of the program and the number of copies of the program that are 

open. To choose a specific copy, click the Tab button and all of the copies of the 

program names will pop up. Click the one you want to view and it will be 

displayed 

          

Similarly you can open other search engine like Google chrome & Fire fox 

explore  whole world . 

 

iv)  File Management  

 

Step by step illustration for  Creating and deleting  Folder : 

 Click on the Start button. 

 Place the pointer on My documents. 

 Select New from the menu File. 

 Select Folder. 

 Once the folder option has been selected you will see that on the right 

window a new folder will appear that has the name New Folder and that it 

is selected. Rename it My folder.or any other name you want.  

 Then select the folder, right click and then select option  delete  by 

clicking.  

 When it asks you if you want to send the folder to the Recycle 

Bin click Yes. 
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 Select the folder to be copied. 

 Once the folder has been selected, click on Copy. 

 Select the folder where you want to copy then open that folder  , right click 

and select   paste option.  

In the case of not having the folder created to which we want to copy to, 
click Make new folder,   rename new folder with name you want  and Click OK. 

Copy or Move Multiple Files or Folders 

1.  Double-click on the folder My documents and create folder 1 and folder 2 . 

2.  Select the folder ‘folder 1’ 

3.  Press CTRL , Select another folder ‘folder 2’   

4.  Select from right panel under ‘file and folder task ‘heading ‘Copy the selected 

items’ or ‘Move the selected items’ 

 

5)  The following window will be open  

 

6) Then double-click  the folder you want to move the selected items  

7)  if you want to copy in new folder then select ‘ make new folder ‘ and new 

folder is created then select copy  

This can also be done to move or copy Files. 

Some Windows XP Tips 

Check the Taskbar for the programs that are currently running on your computer. 

You should close (click on the X at the upper right) all duplicate instances of the 

same program to free up memory. 
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down the CONTROL and ALT keys, then depress and release the DELETE key. 

You will get a menu of the tasks currently loaded in memory. Highlight the 

application that hung (usually the one that is marked "not responding"), and click 

on End Task. You can usually unload the application gracefully without having to 

reboot your computer. 

Files deleted from your local hard drive will be saved in the Recycle Bin until you 

empty the Recycle Bin. To empty the Recycle Bin, right click on Recycle Bin, 

and select Empty Recycle Bin. If you need to recover deleted files from the 

Recycle Bin, right click on Recycle Bin, and select Explore. You should move the 

file from the Recycle Bin to another folder on the hard drive (for example, click 

and drag the file in Recycle Bin, Explore to the desktop). 

 

It's best to empty the Recycle Bin from time to time as deleted files saved in the 

Recycle Bin actually take up more hard disk space than if they were in a regular 

folder. But remember, once the Recycle Bin is emptied, you can NOT recover the 

deleted files. Also, files deleted from diskettes are not saved in the Recycle Bin. 

Finding a "Missing" Document 

If the document was created recently on your computer, launch the application 

you used to create it, and select File. Windows remembers the last nine 

documents you opened by default. 

If you remember the file name or part of the file name but not its location, click 

on the START button, Search, and Files or Folders. On the menu on the left side, 

select All Files and Folders. In the Look In box, select (C:). In the All or Part of 

Name: box, enter the file name, and click Search. Windows will list all instances 

of the file if it finds any matches. If you know part of the file name, you can enter 

it in A Word or Phrase In the File: box. 

Saving Documents 

In Microsoft Word, the default location to save your document is the My 

Documents folder. To save your document in a different folder, click on the 

yellow folder with the up-arrow to browse one level up, on the left side click on 

the yellow folder with the * to get to your Favorites folders, or click the yellow 

folder with a yellow * on it (on the toolbar) to create a new folder. The Save In: 

box shows the current folder. 
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Note: if you use Corel WordPerfect, your default folder for saving documents is 

My Files. You may use either folder but it's best to create a folder for each project 

and save your documents in their corresponding project folder. 

Check Your Progress 2 

 

1.   Find out whether your PC has compatibility to install windows XP. 

2.   Practice and install Windows XP in your PC. 

Check Your Progress 3 

 

1.  Organize your Desktop icons by name then change the Desktop theme also 

2.  Your desktop is showing date “Wednesday, may 22, 2011” and time “11:48 

AM” now change it to present date and time. 

3.   Create shortcuts for MS-Word. 

4.    i)  Create new folder rename it as “Lab1”.  

      ii)  Create new ms-word document. Type a paragraph on “computer operating 

system “and save it as “session 3”  

     iii)  Ask your friend to search document “session 3”                     

5.    How can you remove an item from the Start menu or from a Program menu? 

6.   Search Calculator, notepad, paint.  

7.   Where the pen drive is connected? 

8.   How will you install extra ram in your computer. 

1.4      LINUX OPERATING SYSTEM 

 

1.4.1  Overview of UNIX/ LINUX Operating System 

 

Even after thirty years of its creation UNIX is still regarded as one of the most 

versatile, flexible and powerful operating systems in the computer world. It was 

created at Bell Labs in 1970 written in the C programming language, which was 

developed at the same time. It supports large numbers of simultaneous users, runs 
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independence) and of course it was and is a simple, elegant, and easy to use (at 

least compared to its predecessors) Linux is a relatively new UNIX flavor derived 

from the work of Linus Torvalds, who was interested to develop a UNIX for 

academic use. Linux is one of the many versions of the UNIX operating system. 

Working on Linux means working on one of the flavors of UNIX. The main 

advantage that Linux is absolutely free, you need not spend even the cost CD it 

can be entirety free downloadable from the Internet. (No registration fees, no 

costs per user, free updates, and freely available Operating System and 

Networking Lab source code). It is portable (means can be configured on any 

processor like Intel, Solaris, etc), dual-bootable, fast, reliable, secure and 

versatile. These properties make it popular among the System Administrators. 

While working on it you may realize many more important features and 

advantages of Linux. Most of the exercises are command line based but similar 

exercises you can try on your GUI based Linux.   

 

Fedora 10, also known as Cambridge, was released on November 25th, 2008, and 

it brings faster boot experience with Plymouth, better printing, better webcam 

support, improved wireless network connection sharing, better software 

maintenance and update. We will learn  how to install the DVD edition of the 

Fedora 10 operating system on your PC. Why the DVD edition? Because we 

believe it offers most of the applications you'll need. However, this guide will 

make things very simple for you, but if you get stuck somewhere in the middle of 

the installation and you need help, do not hesitate to use our commenting system 

at the end of the article. 

 

1.4.2  How to install Linux Operating System 

 

 You will need the Fedora 10 DVD image that corresponds to your hardware 

architecture (i386 or amd64), and which can be downloaded from here. When 

the download is over, burn the ISO image with your favorite CD/DVD 

burning application (Brasero on Linux or Nero, CDBurnerXP, Roxio on 

Windows) on a blank DVD at 4x speed. 

 It is always recommend having an empty hard drive for a Linux installation 

(that means no other operating system on it, no Windows), and you must have 

a minimum of 10 GB free space for the Fedora installation. 

Great, now let's begin. Insert or leave the DVD in your CD/DVD-ROM device, 

and reboot the computer in order to boot from the DVD. Hit the F8 or F12 key 

(depending on your BIOS) to select the CD/DVD-ROM as the boot device. 

You'll be presented with a very nice Fedora artwork GRUB splash and some 

options... 
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At this stage, we simply suggest you press Enter, and wait for the system to load... 

 

 

  Select the "Skip" option when you're asked if you want to check the media 

before installation, and press "Enter"... 

 

Anaconda (the Fedora installer) will load and you'll see the welcome screen. Click 

"Next"... 
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Choose your language... 

 

 

 

 

Choose your keyboard layout... 
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Type a name for the computer. It can be anything you want... 

 

           Select your location (country/city)... 
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IT SOMEWHERE)...

 

 

 

Here, comes the partitioning part! If you have an empty hard drive, all you have 

to do is click "Next," but make sure the"Remove all partitions on selected drives 

and create default layout" option is selected. If you don't have an empty hard drive 

and you still want to install Fedora 10 on your machine, then make sure you select 

the "Use free space on the selected drives and create default layout" option (10 

GB minimum of free space is required). Click "Next"... 
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longer, the better) for the encrypted partition...

 

Click the "Write changes to disk" button when asked... 

 

The hard drive will be formatted and the partitions will be created... 

 

Now, you can select the desired packages... 
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Hit the "Next" button and everything will be done automatically from now on, 

just sit back and watch how the packages are copied to your hard drive.The 

installation process will take about 8-10 minutes (depending on your computer 

specs and the selected packages). 

 

               

                    It starts installing, wait for sometime 
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When the installation is over, you will get a "Congratulations, the installation is 
complete" screen. Click the "Reboot" button and your computer will 
automatically restart... 

 

Remove the DVD from your optical drive. Your brand new Fedora 10 operating 
system will boot for the first time... 

 

If you've chosen to encrypt your partition, then you'll be prompted for the 
password ... 
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The system will continue to boot and in a few seconds you will see the First Boot 
Configuration Wizard. Click "Forward" on the Welcome screen... 

 

Click "Forward" on the License screen... 
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Set the date and time... 

 
 

Click "Finish" and you will see the login screen. Enter the password for the 
regular user you've just created... 

 
That's it!  

1.4.3 Linux utilities and Basic Commands 

 

The following is a list of commonly used commands which are organized under 

different categories for understanding and ease of use. Keys proceeded by a ^ 

character are CONTROL key combinations.   
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^h   backspace erase previously typed character   

^u   erase entire line of input so far typed  

^d        end-of-input for programs reading from terminal  

^s         stop printing on terminal  

^q         continues printing on terminal  

^z         currently running job; restart with bg or fg  

DEL, ^c      kill currently running program and allow clean-up before exiting   

^\           emergency kill of currently running program with no chance of cleanup  

 

Login and Authentication   

 

Login          access computer; start interactive session  

Logout        disconnect terminal session  

Passwd       change local login password; you MUST set a non-trivial password  

Information   

 date          show date and time  

 history       list of previously executed commands   

 pine          send or receive mail messages  

 msgs         display system messages  

 man           show on-line documentation by program name  

 info            on-line documentation for GNU programs  

 w, who      who is on the system and what are they doing   

 who am i   who is logged onto this terminal  

 top           show system status and top CPU-using processes  

 uptime       show one line summary of system status  

 finger        find out info about a user@system  

File Management   

 cat           combine files  

 cp            copy files  

 ls           list files in a directory and their attributes  

 mv            change file name or directory location  

 rm           remove files  

 ln            create another link (name) to a file  

 chmod        set file permissions  

 des           encrypt a data file with a private key  

 find          find files that match specified criteria  

 

Display Contents of Files   

 

 cat           copy file to display device   

 vi            screen editor for modifying text files    

 more          show text file on display terminal with paging control  

 head          show first few lines of a file(s)  
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grep         display lines that match a pattern 

 lpr           send file to line printer  

 pr            format file with page headers, multiple columns etc.  

 diff         compare two files and show differences  

 cmp          compare two binary files and report if different  

 od           display binary file as equivalent octal/hex codes  

 file          examine file(s) and tell you whether text, data, etc.  

 wc           count characters, words, and lines in a file  

Directories   

 cd            change to new directory  

 mkdir        create new directory  

 rmdir         remove empty directory (remove files first)  

 mv            change name of directory  

 pwd           show current directory   

Devices   

 df            summarize free space on disk device   

 du           show disk space used by files or directories  

Special Character Handling for C-shell   

*             match any characters in a file name  

~user         shorthand for home directory of "user"  

$name        substitute value of variable "name"  

\             turn off special meaning of character that follows  

‘            In pairs, quote string with special chars, except !  

“             In pairs, quote string with special chars, except !, $  

`            In pairs, substitute output from enclosed command  

Controlling Program Execution for C-shell   

&              run job in background  

DEL, ^c       kill job in foreground  

^z             suspend job in foreground  

fg             restart suspended job in foreground  

bg             run suspended job in background   

;              delimit commands on same line  

( )             group commands on same line  

!              re-run earlier command from history list  

ps             print process status  

kill              kill background job or previous process  

nice           run program at lower priority  

at                run program at a later time  
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limit          see or set resource limits for programs  

alias          create alias name for program (in .login)  

sh, csh        execute command file         

 

Description of Commonly Used UNIX Commands  

 

The description for the most commonly used UNIX commands is given below in 

an alphabetic order.  

a)  cat   

cat allows you to read multiple files and then print them out. You can combine   

files by using the > operator and append files by using >>.   

     Syntax: cat [argument] [specific file]   

     Example:  

     cat abc.txt  

 If you want to append three files (abc.txt, def.txt, xyz.txt), give the command 

as,  

 cat abc.txt def.txt xyz.txt > all  

 

b)  cd, chdir   

cd (or chdir) stands for “change directory”. This command is the key 

command to move around your file structure.   

Syntax: cd [name of directory you want to move to]   

When changing directories, start with / and then type the complete file path, 

like   

cd /vvs/abc/def  

in this eg.  You are moving from vvs directory to abc directory then move to 

def directory . 

You can also move relative to the current directory by typing 

cd vvs/abc/def 

To move relative to the parent directory of your current directory, use 

Cd ../vvs/abc/def 

 

c ) chmod   

     chmod (which stands for “change mode”) changes who can access a particular 

file. A “mode” is created by combining the various options from who, opcode, 

and permission.  

   Syntax: chmod [option] mode file   

If you look at a list of files using the long list command ls –l, you’ll see the 

permissions, owner, file size, modification time, and filename. The first 

column of the list shows who can read, write, and execute the files or 

directories, in other words, the permissions. It basically shows who has 

permission to do what to a given file or directory. r stands for “read” and 

means that you’re allowed to read the file or directory. w stands for “write” 

and gives permission to edit or change the file as well as create, move, 

rename, or remove a directory. x stands for “execute” which gives permission 
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permissions. The first set represents the user (u), the second set represents the 

group (g), the third set represents other (o), and the fourth set represents all 

(a). The column will look like this:  rwxrwxrwx   

Each set of rwx represents user, group, and other respectively. Only the owner 

of a file or a privileged user may change the permissions on a file. There are 

two ways to change permissions on a file or directory, either numerically or 

by using lettered commands. Both ways use the command chmod. To add 

permissions to a file, you use +, to remove permissions you use-.   

For example, take a file:   

-rw-r--r-- 1 yash mony 476 Apr 14 17:13 vvs.txt  

To allow a group (mony, in this case) “write” access, you would type:   

chmod g+w vvs.txt  

  If you wanted to remove “read” ability from “other” you would type:   

chmod o-r vvs.txt  

It is also possible to specify permissions using a three-digit sequence. This is a 

more efficient way to change permissions (or at least it requires less typing), 

so use this method if it doesn’t confuse you. Each type of permission is given 

an octal value. Read is given the value of 4, write is given the value of 2, and 

execute is given the value of 1. These values are added together for each user 

category. The permissions are changed by using a three-digit sequence with 

the first digit representing owner permission, the second digit representing 

group permission, and the third digit representing other permission. For 

example, if you wanted to make vvs.txt readable, writable, and executable for 

the user, readable and writable for the group, and readable for other, you 

would type: chmod 764 vvs.txt  

 The first digit means readable and writable for the user (4+2+1), the second 

digit means readable and writable for the group (4+2+0), and the third digit 

means readable for other (4+0+0).  if you want to change the permissions on a 

directory tree use the -R option. chmod –R will recursively change the 

permissions of directories and their contents.   

d)  cp   

The cp command copies files or directories from one place to another. You 

can copy a set of files to another file, or copy one or more files under the same 

name in a directory. If the destination of the file you want to copy is an 

existing file, then the existing file is overwritten. If the destination is an 

existing directory, then the file is copied into that directory.   
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into the directory called laksh, you give  

the command as:   

cp favourites.html /vvs/laksh/  

A handy option to use with cp is -r. This recursively copies a particular 

directory and all of its contents to the specified directory, so you won’t have 

to copy one file at a time.   

e)  date   

The date command can be used to display the date or to set a date.  In unix the 

term date includes the time as well. 

Syntax: date [option] [+format] 

             date [options] [string]   

The first structure shows how date can be used to display the current date. A 

certain format can be specified in which the date should be displayed. Check 

the Unix  manual for specific formats and options. The second structure 

allows you to set the date by supplying a numeric string. Only privileged users 

will be able to use this second command structure.   

f)  diff   

       diff displays the lines that differ between two given files.   

       Syntax: diff [options] [directory options] file1 file2   

diff can be an extremely valuable tool for both checking errors and building 

new pages. If you run a diff between two files, you'll be shown what 

differences the files have line by line. The lines referring to file1 are marked 

with the < symbol. The lines referring to file2 are marked by the > symbol. If 

the file is a directory, diff will list .the file in the directory that has the same 

name as file2. If both of the files are directories, diff will list all the lines 

differing between all files that have the same name.  If you have a file that is 

not working properly, it can be a great help to check it against a similar file 

that is working. It will often quickly alert you to a line of code that’s missing.  

A handy option to use if you want to generally compare two files without 

noting the complex differences between them is the -h option (h stands for 

half-hearted). Using -i as an option will ignore differences in uppercase and 

lowercase characters between files, and -b will ignore repeating blanks and 

line breaks.  
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The exit command allows you to terminate a process that is currently 

occurring.  For example, if you wanted to leave a remote host that you were 

logged onto (see rlogin also), you should type exit. This would return you to 

your home host.   

h)  find   

     find searches through directory trees beginning with each pathname and finds 

the files that match the specified condition(s). You must specify at least one 

pathname and one condition.   

Syntax: find pathname(s) condition(s)   

There are several handy conditions you can use to find exactly what you want. 

The -name condition will find files whose names match a specified pattern. 

The structure for the name condition is:  find pathname -name pattern  

The condition -print will print the matching files to the pathname specified. -

printcan also be used in conjunction with other conditions to print the output.  

If you wanted to find all the files named favorites.html in the directory Ram, 

then  

you’d do this:    

find /Ram -name favorites.html –print  

This looks through the directory Ram and finds all the files in that directory 

that contain favorites.html, then prints them to the screen. Your output would 

look like this:   

 /Ram/sixteen_candles/favorites.html   

/Ram/favorites.html   

/Ram/breakfast_club/favorites.html   

All meta-characters (!, *, ., etc.) used with -name should be escaped (place a \ 

before the character) or quoted. Meta-characters come in handy when you are 

searching for a pattern and only know part of the pattern or need to find 

several similar patterns.  

For example, if you are searching for a file that contains the word “favorite”, 

then use the meta-character * to represent matching zero or more of the 

preceding characters.  

This will show you all files which contain favorite.   

find /Ram  -name '*favorite*' -print  
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that contain the word “favorite”. The output would look like this:   

/Ram/sixteen_candles/favorites.html  

/Ram/favorites.html  

/Ram/least_favorites.html  

/Ram/breakfast_club/favorites.html  

/Ram/favorite_line.html  

The -user condition finds files belonging to a particular user ID or name.   

i)  grep   

The grep command searches a file or files for lines that match a provided  

regular expression (“grep” comes from a command meaning to globally 

search for a regular expression and then print the found matches).   

Syntax: grep [options] regular expression [files]   

To exit this command, type 0 if lines have matched, 1 if no lines match, and 2 

for errors. This is very useful if you need to match things in several files. If 

you wanted to find out which files in our vvs  directory contained the word 

“bca” you could use grep to search the directory and match those files with 

that word. All that you have to do is give the command as shown:  

grep ‘bca’ /vvs/*  

The * used in this example is called a meta-character, and it represents 

matching zero or more of the preceding characters. In this example, it is used 

to mean “all files and directories in this directory”. So, grep will search all the 

files and directories in vvsand tell you which files contain “bca”.   

j)  head   

Displays the first ten lines of a file, unless otherwise stated.     Syntax: head   

[-n] [files]   

For example, the following command will display the first 15 lines of  

favourites.html.   

head -15 favourites.html  

k)  kill   

kill ends the execution of one or more process ID’s. In order to do this you 

must own the process or be designated a privileged user. To find the process 

ID of a certain job give the command ps. 
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There are different levels of intensity to the kill command, and these can be 

represented either numerically or symbolically. kill -1 or HUP makes a 

request to the server to terminate the process, while kill -9 or kill KILL forces 

a process to terminate absolutely. Most politely, UNIX users will attempt to 

kill a process using-1 first before forcing a process to die.   

l)     ls   

ls will list all the files in the current directory. If one or more files are given, 

ls will display the files contained within “name” or list all the files with the 

same name as “name”. The files can be displayed in a variety of formats 

using various options.  

Syntax: ls [options] [names]   

ls is a command you'll end up using all the time. It simply stands for list. If 

you are in a directory and you want to know what files and directories are 

inside that directory, type ls. Sometimes the list of files is very long and it 

flies past your screen so quickly .You miss the file you want. To overcome 

this problem give the command as shown below:   

ls | more  

The character | (called pipe) is typed by using shift and the \ key. | more will 

show as many files as will fit on your screen, and then display a highlighted 

“more” at the bottom. If you want to see the next screen, hit enter (for 

moving one line at a time) or the spacebar (to move a screen at a time).  | 

more can be used anytime you wish to view the output of a command in this 

way.  A useful option to use with ls command is -l. This will list the files 

and directories in a long format. This means it will display the permissions 

(see chmod), owners, group, size, date and time the file was last modified, 

and the filename.   

 drwxrwxr-x  vvs   staff  512  Apr 5 09:34 sridhar.txt  

 -rwx-rw-r-- vvs   staff  4233 Apr 1 10:20 resume.txt   

-rwx-r--r-- vvs   staff  4122 Apr 1 12:01 favourites.html   

There are several other options that can be used to modify the ls command, 

and many of these options can be combined. -a will list all files in a 

directory, including those files normally hidden. -F will flag filenames by 

putting / on directories, @ on symbolic links, and * on executable files.   

m)    man   

The man command can be used to view information in the online Unix 

manual.   
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man searches for information about a file, command, or directory and then 

displays it on your screen. Each command is a subject in the manual. If no 

subject is specified, you must give either a keyword or a file. You can also 

search for commands that serve a similar purpose. For example, if you want 

more information about the chmod command, you should type:   

    man chmod  

A screen will then appear with information about chmod. Type q to quit.   

n)  mkdir   

mkdir creates a new directory.   

Syntax: mkdir [options] directory name   

For example, to create a directory called parkhyath in the present working 

directory, give the command as,  

mkdir prakhyath  

o)  more   

      more displays the contents of files on your screen.   

Syntax: more [options] [files]   

To have the next line displayed, hit the return key, otherwise press the 

spacebar to bring up the next screen. Press h for assistance with other 

commands, n to move to the next file, or q to quit.  

p) less   

less is similar to more in that it displays the contents of files on your screen. 

Unlike more, less allows backward and forward movement within the file. It 

does not read the whole file before displaying its contents, so with large files 

less displays faster than more. Press h for assistance with other commands or 

q to quit.   

Syntax: less [options] [files]   

q)  mv   

mv moves files and directories. It can also be used to rename files or 

directories.   

Syntax: mv [options] source target   

If you wanted to rename vvs.txt to vsv.txt, you should give the command as:   
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After executing this command, vvs.txt would no longer exist, but a file with 

name  

vsv.txt would now exist with the same contents.   

r)   passwd   

The passwd command creates or changes a user’s password. Only the owner 

of the password or a privileged user can make these changes.   

Syntax: passwd [options] files   

s)  pwd   

pwd prints the pathname of the current directory. If you wanted to know the 

path of the current directory you were in you give the command as pwd. You 

will get the complete path.  

t)  rm   

rm removes or deletes a link to a file from a directory. If a file has more than 

one link then removing a link does not delete the file.  But when the last link 

to a file is removed, the file gets deleted. 

A link is a name of a file.  In unix a file can have many names. 

Syntax: rm [options] files   

In order to remove a file, you must have write permission to the directory 

where the file is located. While removing a which does’t have write 

permission on, a prompt will come up asking you whether or not you wish to 

override the write protection.   

The -r option is very handy and very dangerous. -r can be used to remove a 

directory and all its contents. If you use the -i option, you can possibly catch 

some disastrous mistakes because it’ll ask you to confirm whether you really 

want to remove a file before going ahead and doing it.   

u)  rmdir   

   rmdir allows you to remove or delete directories but not their contents. A 

directory must be empty in order to remove it using this command.   

Syntax: rmdir [options] directories   

If you wish to remove a directory and all its contents, you should use rm -r.   
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1.  Practice to install Fedora 10 in your pc. 

 

2. First try to execute the following commands on your   operating system and 

write down the results and use of each command.  

• man ( find manual help)  

• cd   

• ls, ls -a   (try to find out other options of ls using man)  

• cd .   

• pwd       

• cd ..   

• ls -al   

• ls -al | more   

• cat passwd  22  

• cd –   

• chmod  

   We hope you will stop here and you will keep digging more and more 

commands but do it after the session.  

 

Check Your Progress 5 

 

1  Try to explore the file system, write what is there in /bin, /usr/bin, /sbin, /tmp 

and /boot. Find and list the devices that are available in your system.  

2  Make your own subdirectories called rc1 and rc2 in your home directory, 

mca? Ok, now delete the subdirectory called rc2 .  

3  Create a file called ignou.txt that contains the words "hello I am student of 

IGNOU". Now copy this file and paste to other director. Copied? Can you 

move the file also from one directory to another?    

4 In the previous question you have a file ignou.txt; change its permission to 

rwxrwxr-x. You can try different possibilities to changes in its permissions. 

One possibility may be rwxr-xr-x permissions. Find out what are the different 

commands available that can be used to change the permissions of a file/files.  

5  Display the names of all files in the home directory using find .Can you 

display the names of all files in the home directory that are bigger than 

500KB.   

6  Display a sorted list of all files in the home directory that contain the Word 

ignou inside them. Hint: Use find and grep and sort. Can you use locate to 

find all filenames that contain the word ignou?  

7  Use egrep to try to find out which lines in an ignou.txt file are satisfied by the 

regular expression given: (^ [0-9]{1,5}[a-zA-z ]+$)|none and check the result 

with  different combinations of lines.   

8  Change your password and write down the restrictions for given password. 
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1.5  SUMMARY    

 

In this section you have studied a brief introduction of computers, the history, and 

familiarization with its basic features including the technical description, the 

advantages and the differences between the two network operating systems: 

Windows and Linux/Unix. Last but not the least you would have understood the 

concepts better by undergoing through the interesting exercises   

1.6  ANSWERS TO CHECK YOUR PROGRESS  

 

Check Your Progress 1 

1.   a)  F 1 

      b)  CTRL+Y   

     c)  CTRL+S 

     d)  CTRL+B 

     e)  Shift +F3 

2.  Try it yourself 

                 

3.    Over the past few years the growth of the computer industry has been quiet 

remarkable and today it is the fastest growing industry in our economy. 

Nowadays, many schools are equipped with computers for educating their 

students. Thereby making computers an integral part of education system. 

Teachers and professors use computers for teaching, giving presentations, 

assessing various data banks, maintaining database of students, communication in 

the form of e mails or chat, browsing the Internet and Preparing students to have a 

competitive edge in the global job market. Computers have revolutionized the 

learning for students in a big way. They can watch various films on wild life, 

history, geography, science and encyclopedias with loud sound and excellent 

picture quality and commentaries on Compact Discs or DVD’s. 

 

Check Your Progress 2 

 

1. Refer Sec 1.3.2 

 

2. Try it yourself. 

 

Check Your Progress 3 

 

1.  The computer has a clock located on the right side of the task bar. 

 

You can also check and modify the properties of the clock with the dialog box 

that appears next. It appears as you double-click on the clock on the task bar. 
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To change the Date follow these steps: 

1)     Double-click on the clock on the task bar to open the dialog box. 

2)    To change the month, place the pointer on the month box and click 

with the mouse on the arrow to the right. A list with the months will 

be displayed. Select the appropriate month. 

3)    To change the year, place the pointer on the year box and with the 

arrows  you can change the year. 

4)      To change the days select it on the calendar that appears. 

5)     Click Apply and OK  

 

To change the Time do the following: 

1)     Place the pointer on the clock. 

2)    To change the time select the time digits with the arrows to the right 

and adjust to the necessary time. 

3)     This same process must be done with the minutes and seconds. 

2.  To create a desktop shortcut for a default folder such as My Computer and My 

Document: 

 

 

 

. 

3:   To create a program desktop shortcut: 

 

 
 
 
 
 
 
 

1. Click on the start button 
 
2.  Right click on My Computer or My Document on 

the right panel of the start menu 
 
3.  Click on "Show on Desktop" just like it shows on                           

the picture 

 

1. Click on the start button 
2. Select "All Programs" 
3. Select and right click the program you 

want place on the desktop                           
4. Select "Send To" from the displayed 

menu 
5. Click on "Desktop (create shortcut)" 
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5.  Click on the Start button and choose Control Panel Click on Add or Remove 

Programs option, a window will display with the three basic options shown on 

the left side of the picture as it appears below. Then click on Change or 

Remove Programs. 

 

6.  Click on the Start button and choose Search button and type Calculator 

/notepad / paint. It will open the respective application. 

  

Check Your Progress 4 

 

1.  Refer to the section 1.4.1  

 

2.  Try it your self  

 

 

Check Your Progress 5 

 

Try exercise 1-8 yourself. 
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2.0  INTRODUCTION 

 
Computers have been in use in businesses, schools, hospitals, homes for many 

years now. Apart from being used to automate large systems and processes, they 

have made a big difference in office automation. Day-to-day office tasks such as 

creating documents, letters, memos, faxes, filing, storing, retrieving, mailing has 

become simpler and sophisticated with the use of computers. There are many 

software applications that help to create, edit, save and print documents, letters, 

mailing labels and reports. Same software can be used by students to create their 

project reports or assignments, at home to make a list of things to do or to buy and 

by anyone for any kind of document work.  
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future retrieval and reference is known as a Word Processor. We will study 

about Word Processor, its features and how to use it in this unit. 

2.1 OBJECTIVES 

After going through this unit, you will be able to : 

 learn what a Word Processor is and how to use it; 

 create, edit, save, preview and print a document; 

 format a document with different page layouts, borders, headers, footers and 

other settings; 

 manage and Manipulate text, font, colour, size, table and images; and  

 use different features available in word processor to check spelling or 

grammar, use dictionary or create multiple letters.  

2.2 WHAT IS WORD PROCESSOR ? 

A word processor is a software program capable of creating, storing, and printing 

documents. It helps you to create a document, format it, correct your mistakes, 

save, review and print it. 

Word processors vary considerably, but all word processors support the following 

basic features: 

 Cut, copy and paste text 

 Insert or delete text 

 Set page size and margins 

 Search and replace 

 Word wrap 

 Print 

Word Processors that support only above features (and may be few more) are 

called Text Editors. Most word processors, however, are quite advanced and 

support many additional features as listed below: 

 Allows to create, delete, move, copy, rename and search for files. 

 Allows to specify font, size, colour, header, footer, page numbering, footnote, 

cross-reference, bullets and numbering, table, images, graphics, table of 

contents and indexes. 

 Allows to specify page layout, page orientation and margins. 

 Allows use of spell checker, thesaurus, macros, merges. 

 Allows to open and edit multiple documents at the same time in separate 

windows. 
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The word processors that support above features are called full featured word 

processors. There are many word processors available in the market. We will 

consider MS Word 2007 for our study. We will understand what the above feature 

are and how we can use them. 

 

2.3  WORD BASICS 

 

In this section we will cover how to start, open, create, save and close a word 

document and what do different parts in a Word window stand for. The editing 

and formatting of the created document will be covered in the next section. 

 

2.3.1  Starting Word 

 

You can start MS Word by either of the following two ways: 

 Click on Startà All ProgramsàMicrosoft Officeà Microsoft Office Word 

2007. 

 Double click on the MS Word icon on the desktop (if you have one). 

 

When word opens, a new document with default name as Document1 is opened. 

For each additional document you open, the number increases by one. Please note 

that you can open more than one document at a time. 

 

You may also start Word by clicking on a document saved on your hard drive. 

Word will open automatically and the document will be displayed in the 

document area. 

 

When you open word from the menu or desktop icon, the screen will look like in 

Figure 2.1. 

 

 

 

 

 

 

 

Figure 2.1: Microsoft Word Window 

Quick Access Toolbar 

 Microsoft Office Button Document Title on Title Bar 

Minimize, Restore Down and Close Buttons

Status Bar Text Area 

Ribbon 

Tabs on the 
Ribbon 

Group on Tab 

Ruler Dialog Box 
Launcher for 
the Group 
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Let us familiarize ourselves with the key commands and resources in Word 

Window: 

The Microsoft Office Button 

It is the button in the upper-left corner of the Word Window. When you click on 

the button, it displays a menu that can be used to create a new document, open an 

existing document, save a document, print a document and perform many other 

tasks.

The Quick Access Toolbar 

It is present next to the Microsoft Office Button on the top. It provides you access 

to the commands you frequently use. By default Following appear on the Quick 

Access Toolbar: 

 Save: To save your file (you may also press keyboard button Ctrl+S). 

 Undo: To rollback the action that you last took (Ctrl+Z). 

 Redo: To reapply the action you rolled back or to repeat an action(Ctrl+Y). 

The Title Bar 

It is next to the Quick Access toolbar at the top. It displays the title of the 

document on which you are currently working. By default, the first new document 

is named as Document1. For each additional document you open, the number 

increases by one. You may save the documents by any legal filename you want. 

The Ribbon 

The Ribbon is the panel at the top portion of the document, right below the Title 

Bar. To begin with it has following seven tabs:  

 Home: It has basic commands for creating and formatting the documents. It 

has controls for working with the clipboard, setting fonts, formatting 

paragraphs, applying styles and using Find and Replace. 

 Insert: It has commands for inserting pages, tables, pictures, shapes, other 

illustrations, links, headers, footers, symbols, signature line and much more. 

 Page Layout: The commands here help to set the layout of the document, 

apply a theme to the document to set the overall look of the document, set the 

margins, background colours, etc. 

 References: It has commands that let you create Table of contents, footnotes, 

indexes, etc. 

 Mailings: Has commands for creating mail merges. 



 

60  

Lab Course 

 
 Review: Has commands to track changes and add comments to the 

documents.

 View: Helps to change the document views. 

 

(We cover in detail each of the above features in the later sections of this unit.) 

Besides these basic tabs, additional tabs appear from time to time, depending on 

the context we are working in. These tabs are called contextual tabs. For example, 

if you select a drawing, a Drawing Tools contextual tab appears that has 

commands to help you manipulate the drawing. These contextual tabs appear in a 

different colour to make them easy to spot. 

 

The commands on each tab are organized into groups. Hence, a group is a 

collection of logically related command buttons that you can use to develop or 

edit your Word document. Commonly used features are displayed on the Ribbon 

and additional options can be accessed through the dialog box launcher at the 

bottom-right corner of each group. 

 

The Ruler 

 

The ruler can be found right below the Ribbon. The ruler is useful for document 

layout purposes. It is used to set the margins, tab stops, align text, graphics, tables 

and other elements in a document. You may change the setting to show or hide 

the ruler. 

 

The Text Area 

 

You can type you content in the Text Area. The blinking vertical line is the cursor 

which marks the insertion point. As you type, text displays at the cursor location. 

The vertical scroll bar on the window helps you to move up and down the 

document. 

 

The Status Bar 

 

The Status Bar is at the very bottom of the window. It provides information such 

as the current page and the number of words in the document. You can change 

what displays on the Status Bar by right clicking on the Status Bar and selecting/ 

deselecting the options from the menu. You may also view your document in one 

of the following ways using the hot buttons in the status bar: 

 Draft View: It is used to quickly edit your document. It shows the page in a 

simplified format and is most frequently used view. 

 Web Layout: Shows how a page will appear when viewed from a Web 

Browser. 

 Full Screen Reading: Shows the page in a way that it makes it easy and 

comfortable to read your document onscreen. 

 Print Layout: Shows the document as it will look when it is printed. 
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allows you to see either the entire contents of the document, or just chapter 

headings or section heading and so on. 

2.3.3 Setting up Your Word Environment 

Before you begin creating Word documents, you may want to set up your Word 

environment and become familiar with a few key tasks such as how to maximize 

and minimize the Ribbon, configure the Quick Access toolbar, display the ruler, 

etc. 

Minimize and Maximize the Ribbon 

 Right click anywhere in the main menu 

 Select Minimize the Ribbon in the menu that appears. This will toggle the 

Ribbon on and off. 

 

Figure 2.2 : Minimize the Ribbon 

The check mark beside ‘Minimize the Ribbon’ option indicates the feature is 

active. You may choose to use this option, if you prefer not to use the Ribbon, but 

use different menus and keyboard shortcuts. This has the advantage of giving you 

more screen space to work on the document. 

Add Commands to Quick Access Toolbar 

 Click the arrow (customize quick access toolbar) to the right of the Quick 

Access toolbar. 

 Select the command you wish to add from the drop down menu. The 

command will appear in the Quick Access Toolbar 

 

Figure 2.3 : Adding Commands to Quick Access Toolbar 
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You may want to add frequently used commands to your Quick Access Toolbar, 

to make the specific Word features more convenient to you.

Display or Hide the Ruler

 

 Click the View Ruler icon over the scrollbar. 

 

Figure 2.4 : View Ruler Icon 

The View Ruler icon is a toggle button that shows or hides the ruler. 

Customize the Status Bar 

 

 Right click anywhere on the Status Bar. 

 From the menu that appears, select the options that you want to see on the 

Status Bar. Each click on an option will toggle it between show and hide on 

the Status Bar. 

 

Customizing the Environment Using Word Options 

 

The Word options menu allows you to customize Word 2007 according to your 

preferences.  

 

 Click the Microsoft Office Button 

 Click on ‘Word Options’ button located at the bottom of the menu. 
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Figure 2. 5: Word Options Button 

When you click on ‘Word Options’ button, an extensive menu will open.  It is has 

more than hundred configurable options, not including submenus! 

You can set your preferences for Autocorrect, printing, saving, custom directories, 

colour scheme, spell check, grammar check, updating fields and much more. In 

addition this menu contains help options, such as repairing Microsoft Office or 

changing security settings. You may not be able to understand most of these 

options for now. We will take up some examples now and cover some more 

options while we progress through this unit.  

 Change the Colour of the Office Ribbon: 

a. Click the Office Button. 

b. Click the Word Options. 

c. On the Popular Tab, under Color Scheme, select the preferred colour. 

 Change the Default Document Folder: 

a. Click the Office Button. 

b. Click the Word Options. 

c. On the Save Tab, under Save Documents, click Browse button next to the 

Default File Location text box. 

d. Navigate to and click the folder you want to be your default. 

e. Click OK twice. 
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 Reorder Items on Quick Access Toolbar: 

a. Click the Office Button.

b. Click the Word Options. 

c. On the Customize Tab, under Customize Quick Access Toolbar, select 

the command and then use the up/ down arrow key to change its position 

on the bar. 

 

2.3.4  Creating a New Document 

 

You can create a new document as follows: 

 

 Click the Microsoft Office Button. 

 Select New. The New Document dialog box appears. 

 Select Blank Document under ‘Blank and Recent’ section. It will be 

highlighted by default. 

 Click Create. A new, blank document appears in the Word window. 

You may also use keyboard shortcut Ctrl+N to create a new document. 

2.3.5  Opening an Existing Document 

 

You can open an existing document in one of the following ways: 

 

 Click the Microsoft Office Button. 

 Select Open. Select the required document in the dialog box. 

                                    OR 

 Use keyboard shortcut Ctrl+O to select and open an existing document. 

                                     OR 

If you have recently used document then 

 Click the Microsoft Office Button. 

 Choose from the Recent Documents section. 

                                      OR 

 Go to Windows Explorer. Find your document. 

 Right mouse click on the document and select Open. 

 

2.3.6  Saving a Existing Document 

 

 Click the Microsoft Office Button. 

 Select Save from the menu. 

                    OR 

 Use keyboard shortcut Ctrl+S 

                     OR 

 Use Save on the Quick Access Toolbar 
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the same file name. If you are saving the document for the first time, then Save 

As dialog box appears which accepts the document name and location (folder) 

where it is to be saved. 

Using Save As Option 

You may use Save As option as below: 

 Click the Microsoft Office Button. 

 Select Save As from the menu. The Save As dialog box appears. 

 Select the location where you wish to save the document. 

 Enter the name for the document 

 Click the Save button 

The Save As option can be used to: 

 Create a backup copy of the document by saving it at another location or by 

different name. 

 Save the document as a template 

 Save the document in a format that is fully compatible with Word97-2003 

 Save the document in other formats, for example PDF 

2.3.7 Working with Multiple Documents 

Multiple documents can be opened simultaneously if there is such a need. To see 

the list of open documents: 

 Click on View tab of the Ribbon 

 Click on Switch Windows in the Window group. A drop down list of all open 

documents is displayed. 

The current document has a checkmark besides its name. You may select any 

document from the list to make it current. 

2.3.8 Closing a Document 

To close a document: 

 Click the Microsoft Office Button. 

 Select Close from the menu. 

The current document closes. The next document in the list becomes current.       

If there is no other open document, then only Word window is there. 
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2.4 EDITING AND FORMATTING TEXT

In this section we will study how to add, delete, insert, copy, paste, drag and drop 

text in a document and then how to design a creative and effective document 

using the formatting features of Word. 

2.4.1  Text Basics 

In this section we will learn how to insert, select, delete, copy, paste, drag and 

drop text.  

To Insert Text 

 Move the mouse to the location where you wish the text to appear in the 

document and left click the mouse there.  

OR 

 Use the arrow buttons on the keyboard to reach the location where the text 

should appear. 

The insertion point (blinking cursor) appears. Start typing the text at the insertion 

point. You may also use the following keyboard shortcuts or Tab or Enter keys 

to move through the document: 

 Home: To reach the beginning of the line 

 End: To reach end of the line 

 Ctrl+Home: To reach beginning of the document 

 Ctrl+End: To reach end of the document 

To Delete Text 

 Place your cursor next to the text you wish to delete. 

 Press the Backspace key on the keyboard to delete the text on the left of the 

cursor. 

 Press the Delete key to delete the text on the right of the cursor. 

To Select Text 

 Place your cursor next to the text you wish to select. 

 Left-click your mouse and while holding it down, drag you mouse over the 

text to select it. Release the mouse button. The selected text gets highlighted. 

OR 

 Press the Shift key on the keyboard and use arrow keys to highlight the text. 

When you select a text or image using mouse, a Mini Toolbar with formatting 

options appear. This happens only when the option has been selected in Word 
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Word Processor Options --> Popular. Mini Toolbar makes formatting commands easily 

accessible. 

Shortcuts for selecting a portion of the text are:

 To select Whole Word: double-click within the word OR use 

Shift+Ctrl+arrow(right or  left) keys on the keyboard. 

 To select Whole Paragraph:triple-click within the paragraph OR use 

Shift+Ctrl+arrow(up or  down) keys on the keyboard. 

 To select Entire Document: Use Editing à Select à Select All from the 

Home Tab   OR  

 press Ctrl+A 

To Cut, Copy and Paste Text 

 Select the text you wish to cut or copy. 

 Click the Copy command on the Home Tab OR use the keyboard shortcut 

CTRL+C to copy the text.  

OR 

 Click Cut command on the Home Tab OR use the keyboard shortcut 

CTRL+X to cut the text.  

 Set the cursor where you wish to paste the text 

 Click the Paste command on the Home Tab OR the keyboard shortcut 

CTRL+V. The text will appear at the cursor position. In case of copy, there 

will be a duplicate copy of the selected text. In case of cut, the selected text 

will be moved from its original place to the new cursor position. 

To Drag and Drop Text 

 Select the text you wish to copy. 

 Left-click your mouse and while pressing the mouse button, drag the text to 

the location where you wish it to appear. The cursor will have a text box under 

it to indicate that you are moving text. 

 Release the mouse button and the text will appear at the desired position. 

2.4.2 Formatting Text  

In this section you will learn how to manage the font, font size, colour, 

indentation, justification, paragraphs, styles, etc to create an effective document. 



 

68  

Lab Course 

 
 

 

 

 

 

Figure 2.6 : Text Formatting Options 

To understand how to use text formatting features we will work towards writing 

following text: 

 

 

 

 Open a new document and type the following text: 

Invitation for 36th
 
Annual Concert 

Use Enter key for Newline: To get the text in two lines as above 

 Set the cursor right before 36 and press Enter key from the keyboard. You 

will get the text as  Invitation for 36th
 
Annual Concert. 

Change the Font: to change the font of the above text: 

 Select the text 36th
 
Annual Concert. 

 Click on the drop down arrow next to the font style box in the Font Group of 

the Home Tab. A drop down menu appears. 

 Move the cursor over various font styles. A live preview of the font will 

appear for the selected text. 

 Choose the font called Baskerville Old Face from the menu. Font style will 

change for the selected text. 

 Now select Invitation for and set the font to Bodoni MT for this text. 

Change the Font Size: 

 Select the text 36th
 
Annual Concert. 

 Click on the drop down arrow next to the font size box in the Font Group of 

the Home Tab. A drop down menu appears. 

Invitation for  

36
TH 

ANNUAL CONCERT 

Font Style box 

Font Size box 

Font Colour box 

Left Justify 

Bullets 

Bold Text 

Italics Text 

Underline Text 

Strikethrough 

Decrease Indent 

Bottom Border 

Increase Indent 

Show/ Hide 
Formatting 
Symbols 

Text Highlight 
Colour box 

Line Spacing 

Numbering 
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Word Processor  Move the cursor over various font sizes. A live preview of the font size will 

appear for the selected text.

 Choose the 28 as the font size. Font size will change for the selected text. 

 Now select Invitation for and set the font size to 18 for this text. 

Change the Font Colour: 

 Select the text 36th Annual Concert. 

 Click on the drop down arrow next to the font colour box in the Font Group of 

the Home Tab. A font colour menu appears. 

 Move your cursor over the various font colours. A live preview of the colour 

will appear in the document. 

 Choose the colour of your choice for the text. You have a choice of lot many 

colours than in the menu. Click on More Colors at the bottom of the menu to 

access the Colors dialog box. You can choose any colour from there also. 

Note: You must have noticed that whenever you select text, a Mini Toolbar 

appears. You may use that toolbar also to format the selected text. The toolbar 

appears only if it is set in the Word Options menu. 

To use the Bold, Italic and Underline Commands 

 Select the text Invitation for. 

 Click the Bold command in the font group. The selected text becomes bold. 

Similarly you may use Italics or underline command whenever needed. You may 

also use keyboard shortcuts once you have selected the text: 

Bold: Ctrl+B 

Italics: Ctrl+I 

Underline: Ctrl+U 

To change the Text Case 

 Select the text 36th
 
Annual Concert. 

 Click the Change Case command in the Font group on the Home tab.  

 Select UPPERCASE form the drop down list. The selected text changes to all 

uppercase. 

To Change the Text Case 

 Select the text 36th
 
Annual Concert. 

 Select Center Align text from the Paragraph group on the Home Tab. The 

selected text is centered. 

There are four alignment options: 

Align Text Left (Ctrl+L): Aligns all the selected text to the left margin. 

Center (Ctrl+E): Aligns text an equal distance from the left and right margins. 
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Align Text Right (Ctrl+R): Aligns all the selected text to the right margin. 

Justify (Ctrl+J): Justified text lines up equally to the right and left margins.  

To Add the Border 

 Select the text around which you wish to have a border. 

 Click on the drop down arrow of Border command in the Paragraph group on 

the Home tab. 

 Choose what kind of border you want from the drop down list. We will 

choose Outside Borders for our purpose. 

To Add the Superscript or Subscript 

There are instances where we need text below or above the baseline, for example 

in mathematical formulae (X
3
) or chemical symbols (H2O). To learn how to 

achieve this effect, we take the following example: 

(a –  b)
2
 = (a + b)

2
 – 4ab 

 

 Type the following text 

 

(a –  b)
2
 = (a + b)

2
 – 4ab 

 Select the text 2 after (a– b).
 
 

 Select Superscript from the font group in Home Tab. (a – b)
2 

 becomes         

(a – b)
2
. Similarly change (a + b)

2
 to (a + b)

2
. 

You can choose Subscript from the Font group in Home tab to give the subscript 

effect to the select text. 

 

2.4.3  Formatting Paragraphs, Adding Lists and Working with Styles 

In Word, when you type content, each time you press Enter key, a new 

paragraph is created. You can format each paragraph by setting the font, 

indentation and alignment, specifying the space between two paragraphs or 

between lines in a paragraph.  

Styles are set of formats like font size, colour, alignment, etc that you can apply to 

a paragraph all together in one go. 

To Format Line Spacing 

 Select the text you want to format. 

 Click on line spacing command in the Paragraph group on Home tab.   

 Select any of the spacing options from the drop down list  

                                             OR 
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Line Spacing Options… from the drop down menu. Set the appropriate value 

in the Line spacing drop down box. 

To Format Paragraph Spacing 

 Click on line spacing command in the Paragraph group on Home tab.   

 Click the Add Space Before Paragraph or Remove Space After Paragraph 

from the menu. 

OR 

 You may select Line Spacing Options… to open the Paragraph dialog box. 

 Set the Before and After points in the Paragraph section. 

Line spacing is measured in lines or points, which is referred to as leading. 

When you reduce the leading, you automatically bring the lines of text closer 

together. 

Using Indents and Tabs  

Indentation is a good way to draw attention to a specific text. You may use Show/ 

Hide command in the Paragraph group of the Home tab to see the non printing 

characters such as spacebar or Tab key markings. This is particularly useful while 

working with tabs and indents. 

 Use the Tab key to indent a single line of text. You can also indent multiple 

lines together by selecting all the lines and then pressing Tab key. Shift+Tab 

will decrease the indent. 

 Multiple lines can also be indented using Indent commands in the Paragraph 

group on the Home tab. You can use these commands multiple times. 

Modify Default Indent Setting 

 Select the text for which you would like to modify the indent setting. 

 Select the Page Layout Tab. 

 In the Paragraph group, under Indent, set the values for Left and Right 

Indents. 

The Tab Selector 

You can set tabs to get several lines of text indented properly. Without any tabs 

added, each press of the tab key moves the cursor along by one inch. You can 

specify precisely where you want your text to start after you press the tab key, so 

that you get the layout you want. 
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Figure 2.7 : Tab Selector 

The tab selector is above the vertical ruler on the left. The tab option changes 

when you click on the tab selector. To set the tab stop: 

 Click the tab selector till you see the tab stop you want to use. 

 Click at the point on the horizontal ruler where you want that tab stop. 

 To remove the tab, just click and drag it off from the ruler. 

The tab options are: 

Symbol Tab Type 

   Left Tab - Moves the text right as you type 

   Center Tab – Centers text according to the tab 

   Right Tab – Moves text to the left as you type 

   Decimal Tab – Aligns decimal numbers using the decimal point 

   Bar Tab – Draws a vertical line of the document 

 First Line Indent – Inserts the indent marker on the ruler and 

indenets the first line of text in a paragraph 

 Inserts the hanging indent marker and indents all lines other than 

the first line 

Working with Lists 

Bulleted and numbered lists can be used in your documents to arrange and format 

text to draw emphasis. To create a new list: 

 Select the text you want to format as a list. 

 Click the Bullets or Numbering command in the Paragraph group on the 

Home Tab. 

 Click the bullet or numbering style you want to use. It will appear in the 

document. 

Tab Selector 

Hanging Indent 

First Line Indent 

Left Tab 

Center Tab Right Tab 
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item is added to the list.

 You can also change the bullets or numbering style anytime. Select the text in 

the existing list and use the Bullets or Numbering command in the Paragraph 

group to select an alternate bullet or numbering style. 

 You can use Define New Bullet or Define New Number format to change 

the bullet style and colour or number style and font. 

Applying Styles  

Styles are powerful tools that can help you create professional looking documents 

easily. A style is a predefined combination of font style, colour, size of text that 

can be applied to selected text.  

Create a new Style 

 Click the arrow in the bottom right corner of the Styles group on the Home 

Tab. This opens the Styles task pane. 

 There are three buttons at the bottom left corner of the Styles task pane. These 

buttons are New Style, Style Inspector and Manage Style. Click New Style 

button. A dialog box appears. 

 Enter the name of the style and set all the formatting requirements like font 

style, size, alignment, justification, etc. 

 If you want the style to be available to all the new documents from now 

onwards, then select the option New Document based on this template. 

Selecting and Applying a Style 

 Select text to format. 

 In the Style group on the Home tab, hover over each style to see a live 

preview in the document. Click More drop down arrow to see additional 

styles. 

 Click to select the style. The selected text is formatted in the selected style. 

OR 

 Click Change Styles command on the Ribbon. 

 Select the style set from the menu that appears. Change is reflected in the 

entire document. 

Format Painter Command 

Format Painter is a copying tool that allows you to copy formatting from text to 

text, or from one graphic or table to another. Format Painter is available in the 

Clipboard group Home Tab. 

 Click the formatted text or graphics. 

 Click on Format Painter button. The cursor will change. 
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 Click the unformatted text or graphics to change the style. The text or graphics 

will format exactly as the previous section.

 

2.4.4  Working with Tables and Illustrations 

A table is a grid of cells arranged in horizontal rows and vertical columns. Tables 

can be customized and are useful for various tasks such as presenting text 

information and numerical data for financial reports, catalogs, etc. 

An illustration like Pictures, Shapes, ClipArts, Charts, etc make documents 

visually more appealing and adds clarity and readability to the document. 

Creating a New Table 

 Place the cursor where you want table to appear 

 Select the Insert Tab  

 Click Table command 

 Drag your mouse over the diagram squares to select the number of rows and 

columns in the table. Click to create the table with selected number of cells. 

Modifying the Table. 

When you select a table in the document, Design and Layout tabs appear under 

Table Tools on the Ribbon.  

 Using commands on the Layout Tab, you can make a variety of modifications 

to the table such as adding or deleting columns and rows, merge or  split cells, 

change cell size, align cell text, change text direction, etc. 

 

Figure 2.8 : Layout Tab 

 Using the Design Tab, you can choose a Table Style and modify table border 

or shading.  

 

Figure 2.9 : Design Tab for Table Tools 
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 Click on the down arrow of table styles for More Styles. 

Choose the option New Table Style… OR Modify Table Style… at the 

bottom of the menu.  

Adding/ Deleting Row or Column with right mouse click 

 Place the cursor in the row below/above which you wish to add the row. 

 Right click the mouse for a menu to appear. 

 Select Insert àinsert rows below OR insert rows above OR insert columns to 

the   left OR insert columns to the right option as per your requirement. 

 You can also use Delete option from the menu to delete the rows or columns. 

Convert Existing Text to a Table 

 Select the text you wish to convert. 

 Select the Insert tab. 

 Click the Table command. 

 Select Convert Text to Table form the menu.  

 A Dialog box appears. Choose the correct option at Separate text at. 

Inserting and Modifying Illustrations 

 Place your cursor where you want the illustration. 

 Click the Insert Tab on the Ribbon. 

 Click on Picture/ ClipArt/ Shapes/ SmartArt/ Chart depending on your 

requirement from the Illustrations group. 

 The dialog box will open and you can choose the illustration of your choice. 

 When you choose a shape, you have to draw it on the document after your 

selection. Other illustrations are automatically copied once you have chosen 

them. 

 You will notice that following contextual Tabs appear depending on the 

illustration: 

 Picture/ ClipArt : Format under Picture Tools 

 Shapes    : Format under Drawing Tools 

 SmartArt   : Design and Format under SmartArt Tools 

 Chart    : Design, Layout and Format under Chart Tools 

 Using the above options on the Ribbon, you can change the style, size, colour, 

position, alignment, orientation, etc of the illustration. 

 You can also do your setting using the Right mouse click on the picture. 



 

76  

Lab Course 

 
 When you have text and shapes overlapping one another, you can use Bring 

to Front and Send to Back Ordering options so that they overlap, but still 

are visible. The Order option is available when right click on the object. 

 

2.5  DOCUMENT FORMATTING, PROOFING AND 

PRINTING FEATURES 

In this section we will learn Word features that are applicable to whole document 

and not just text or paragraph. We will also learn what features to use to make our 

document look professional and polished. 

To Change Page Orientation 

 Select Page Layout Tab on the Ribbon. 

 Click Orientation command in the Page Setup group. 

 Choose the orientation you want – Landscape (horizontal) or Portrait 

(vertical). 

To Change Paper Size 

 Select Page Layout Tab on the Ribbon. 

 Click Size command in the Page Setup group. 

 A drop down menu appears with all the available paper sizes. Current size is 

highlighted. 

 Choose the size option. Page size of document changes. 

To Set Page Margins 

 Select Page Layout Tab on the Ribbon. 

 Click Margins command in the Page Setup group. 

 Choose the predefined margins from the list. 

OR 

 Customize your margins by selecting Custom Margins from the menu and 

entering the desired margins in the appropriate fields. 

To Insert a Break 

 Select Page Layout Tab on the Ribbon. 

 Place your cursor at the insertion point 

 Click Breaks command in the Page Setup group. A menu will appear. 

 Choose the appropriate break. A Page break moves text from the insertion 

point to a new page. A Section break creates a barrier between parts of the 

document for formatting purposes. We will study about sections a little later 

in the unit. 
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 Position the cursor before which you need to add a blank page. 

 Select Insert Tab on the Ribbon. 

 Select Blank Page from the Pages group. 

 A blank page is added before the insertion point. This option should be used 

minimally since at times it poses formatting problems. 

To Add Borders to Page 

 Select Page Layout Tab on the Ribbon. 

 Click Page Borders command in the Page Background group. 

 In the Page Border Tab select the appropriate border. Apply to Whole 

document for border on all the pages of the document. 

To Add Background Colour / Pattern/ Shading to Page 

 Select Page Layout Tab on the Ribbon. 

 Click Page Color command in the Page Background group. 

 You can choose a colour from the menu or select Fill Effects… 

 The Fill Effects dialog box appears. It has four tabs: Gradient, Texture, 

Pattern and Picture. You may set any one of them at a time. 

To Add Watermark to the Page 

 Select Page Layout Tab on the Ribbon. 

 Click Watermark command in the Page Background group. 

 You may choose from the pre-existing ones in the list OR setup a custom 

picture or text watermark. 

 The Watermark will appear on all the pages of the document. 

Working with Headers and Footers 

The header is a section of the document that appears in the top margin, while the 

footer is a section that appears in the bottom margin. 

 Select Insert Tab on the Ribbon. 

 Select Header from the Header & Footer group.  

 You can either select from the built-in options from the list OR Blank Header/ 

Footer OR Edit Header/ Footer from the menu. 

 The Design tab with Header and Footer tools appears. It has all the header/ 

footer design option that you can use for your document. 
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Figure 2.10  :  Design Tab for Header & Footer Tools 

 Type the information in the header and the footer. You may insert Date & 

Time, Page numbers, Author, etc. You also have an option to specify different 

header/ footer for first page of the document or for even and odd numbered 

pages. 

To Create a Document in Columns Layout 

Columns are used in many types of documents, but are most commonly used in 

newspapers, magazines, academic journals and newsletters. To add columns to a 

document: 

 Select the text you want to format. 

 Select the Page Layout Tab. 

 Click on Columns command in the Page Setup group. 

 Choose the number of columns you want. 

 The document changes in the column format. 

Applying Themes 

A theme is a set of formatting choices of colour, font and styles that can be 

applied in combination to an entire document. To apply a theme: 

 Select the Page Layout tab. 

 Click the Themes command. Please note that the document should not be in 

compatibility mode for the Theme group to be enabled. 

 Select a Theme from the list. The formatting like font styles, sizes, colours, 

lines and fill effects would change. 

You cannot apply a Theme to a document without applying styles first. Themes 

look for and replace the formats of each of the styles. 

Create Custom Theme 

 First Create New Theme Colours using Colors command in Themes group 

of Page Layout. Use drop downs to change the colours for each part of the 

document and then enter the name for the theme colour. Save. 

 Similarly Create New Theme Fonts and select Effects.  

 Now, Click Themes command and select Save Current Theme.  

 Enter the theme name and save. 
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By default, Word automatically checks your document for spelling and grammar 

and indicates the errors by coloured lines.

 A red line is indicates misspelled word. 

 A green line indicates grammar error. 

 When there is an error, just right-click on the red/green underlined and select 

the correct word from the suggested list. You may also choose to Ignore the 

underlined word. 

You can also wait and the spelling and grammar check after completing the 

document. Click the Spelling and Grammar Command in Proofing group on the 

Review tab. 

Find and Replace Text 

If you realize that you need to change a word in the document, for example some 

date, location, name, etc that you know exists in the document but don’t know 

where exactly it is you can use Find option. 

 Click Find in the Editing group. You can also use Ctrl+F keyboard shortcut. 

 In the Find tab enter the text you are looking for.  

 You may go to the occurrence one by one using Find Next or use Find in… to 

see all the occurrences. 

 If you want to replace the text with some other text, then use the Replace tab 

in the dialog box. Enter the text to replace with.  

 You can replace once by one (Replace button) or all in one go (Replace All). 

And if you don’t want to replace an occurrence, then click Find Next. 

 You can also directly use Replace command in the Editing group OR Ctrl+H.  

AutoCorrect Option 

Autocorrect option provides feature using which you can replace as you type. It 

helps to correct typos and misspellings as they occur. For example, if you 

accidently type ‘teh’ Word changes it to ‘the’. This feature saves time and helps 

eliminate errors. 

Autocorrect is also used to apply special formatting, for example, (C) is changed 

to the copyright symbol. 

Customizing AutoCorrect 

 Click Office Button. 

 Click Word Options. 

 Select Proofing in the left pane. 
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 Click Auto Correct Options… button. 

 Select the AutoCorrect tab. 

 In the section Replace text as you type, under Replace add the abbreviation or 

the text you want to replace. 

 Under the label With enter the correct text that you want. 

 Click Add and then OK. 

Thesaurus 

Thesaurus quickly shows the synonyms for a word that you type. 

 Right-click the word and choose Synonym from the menu that appears. 

 A menu listing synonyms for the word appears. 

 Choose the appropriate word 

                    OR 

 Click the Review Tab. 

 Click Thesaurus in the Proofing group. 

 Research task pane opens with the synonyms listed of the selected word.  

Preview before Printing 

 Click Office Button. 

 Select Print à Print Preview. The document open in the Print Preview mode. 

 Click Print to print the document or Close Print Preview to come back to the 

document in original mode. 

You can modify page margins, orientation, page size, etc in Print Preview mode. 

To QuickPrint the Document 

 Click Office Button. 

 Select Print à QuickPrint 

 The document prints to the default printer. 

To Print the Document 

 Click Office Button. 

 Select Print à Print. The Print dialog box appears. 

 Select the pages you would like to print – All pages, Current page or range of 

pages. 

 Select the number of copies. 

 Check the Collate if you are printing multiple copies of a multipage 

document. 

 Select the printer from the drop down list. 

 Click on Options… button and you can set other printing options, for example 

if you need to print the background colour or not. 

 Click OK to print. 



81 

Word Processor 
2.6 OTHER WORD FEATURES

There are many other features in Word that help us to create professional and 

error-free documents. Let us learn more about those features. 

Inserting HyperLinks 

A hyperlink is a piece of Text or image in an electronic document that can 

connect readers to another portion of the document or a different web page. To 

insert a Hyperlink: 

 Select the text or image you would like to make hyperlink. 

 Right-click on the text or image and select Hyperlink option form the menu. 

OR 

 Select Insert tab.  

 Click Hyperlink in the Links group. The Insert Hyperlink dialog box appears. 

The selected text will be in the Text to Display field OR it will be disabled 

for an image. 

 Type the Web address in the Address field and Click OK. 

 The image or text will now be a hyperlink 

 You can use options Edit Hyperlink, Remove Hyperlink to Open Hyperlink 

that appear when you right click on the hyperlink. 

Understanding Sections 

Sections are the basis of Word’s page layout formatting. You can divide your 

document into any number of sections. Each section can have its own page 

formatting with respect to paper size, margins, page orientation, number and 

spacing of columns, header, footer, footnotes, endnotes, page numbering or line 

numbering. A single page can contain multiple sections. 

Create a Section 

 Position the cursor where you want the new section to begin. 

 Click Page Layout tab on the Ribbon. 

 Click Breaks button in the Page Setup Group. 

 Choose one of the Section Breaks from the drop down list: 

Next Page: The new section begins from the following page. 

Continuous:  The new section begins from the next line of the same page. 

Even Page: The new section begins on the next even numbered page. 

Odd Page: The new section begins on the next odd numbered page. 
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Creating an Index of a Document 

Indexes help to locate specific portions of the document easily. Creating an index 

is a three step process: 

 Mark all the words and phrases within your document that you want to appear 

in the index. 

 Create the index from the marked words. 

 Carefully review the index created and fix if there are any issues. 

Marking Index Entries 

 Select the word or phrase you want in the index.  

 Click References Tab 

 Click Mark Entry in the Index group of the tab OR press Alt+Shift+X. It 

opens the Mark Index Entry dialog box. 

 Ensure that the content in the Main Entry Field is correct and click the Mark 

button. 

 To index an entry under a different word, type the alternative entry in the 

Main Entry Field and click the Mark button again. 

 Mark any additional index entries by highlighting them in the document and 

clicking the Mark button. 

 After you mark all of the index entries you want, click the Close button. 

Inserting the Index 

 Place the cursor where you want Index to appear. 

 Select the Reference Tab on the Ribbon. 

 Click Insert Index button in the Index group. 

 Select the index style from the Formats drop down in the Index dialog box 

that opens. 

 Set the other controls as per your needs. 

 Click OK 

The index is inserted into the document. 

Adding Footnotes and Endnotes 

Footnote is the additional information that is found at the bottom of a page. Often 

a footnote will contain the source of the information or additional information 

about the text contained in the document. 

Endnote is additional information or credits given at the end of the document 

instead of at the end of each page. 

To insert a footnote or an endnote: 

 Place the cursor where you want the little footnote reference number to appear 

in the text. 

 Click on the References Tab. 

 Click the Insert Footnote/ Insert Endnote button in the Footnotes group. 

 Type the footnote/ endnote. 
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Click on the arrow in the lower right corner of the Footnotes group to launch 

the Footnote and Endnote dialog box. 

 Make the required changes. You can change a footnote to endnote or vice 

versa as needed, using the Convert button in the dialog box. 

 To delete a footnote, select the footnote reference number in the text and press 

Delete. 

Building Table of Contents 

Table of Contents (TOC) is a listing of all the headings (each with the page 

number) you designate throughout your document beforehand. When you create a 

TOC, Word searches your document for heading paragraphs to include in the 

table, recognizing them by the styles you assign to them. 

 Apply Heading styles to your chosen headings. 

 Move the cursor to the place where you want to see your TOC. 

 Click Reference Tab. 

 Click Table of Contents button in the Table of Contents group.  

 Choose the TOC style you wish to use from the menu list. 

 To Customize, click the TOC button and select Insert Table of Contents… 

 A Table of contents dialog box appears. Choose the options for your table: 

Show Page Numbers: to display/ not display the page numbers in TOC. 

Right-Align Page Numbers: to place page numbers either right next to the 

corresponding text or at the right margin. 

Tab Leader: to change or remove the dotted line that connects each TOC entry to 

the page number 

Formats: to select one of several predefined formats for the TOC. 

Show Levels: to specify which heading level to include in the table. 

Re-Building Table of Contents 

After you create TOC, it does not reflect later changes you make to the document. 

You need to update or rebuild it as follows: 

 Click the Update Table button in TOC group on References tab. 

 Click OK to update the table. 

Adding Comments 

Comments are simple notes, suggestions, questions, thoughts, Ideas or advice that 

can be transparently added to the document without altering the text. Comments 

are always labeled with your initials and a sequential number. If number of people 

are commenting on the document, then each persons’ comment appear in a 

different colour. To add a comment in your Word Document: 



 

84  

Lab Course 

 

 

Figure 2.11 : Adding Comments 

 Select the text for which you wish to add a comment. 

 Click the Review Tab. 

 Click on New Comments button in the Comments Group. In the markup area, 

you see a comment bubble containing the comment number and writer’s 

initials. 

 Type your comment. Comment is added in the markup area. 

 To close the comment window click the X (Close) button. 

Track and Review Changes 

To note the changes in a document, you need to activate revision tracking feature. 

 Click Review Tab. 

 Click Track Changes button in the Tracking group. 

 To turn off revision, click the track changes button again. The only clue that 

you have properly activated revision tracking is that Track Changes button 

appears highlighted in the Ribbon. 

With revision tracking, any new text that you add appears in red underline. 

Text you delete is colored with red strikethrough. 

 

Figure 2.12 : Adding text with Track Changes On 

Begin at the start of the document and Click Next button in the Changes group of 

Review tab to go to the next change in your document. 

 To accept the change, click Accept button. 

 To reject the change, click Reject button. Change is removed from the 

document. 

 You can also accept or reject all changes in one go. 

 You can also right click any revision mark to accept or reject it. 

Save the final document. 
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Document map enables you to see a quick overview of a document’s structure, 

especially when using the heading styles.

 Click View tab on the Ribbon 

 Select Document Map check box in Show/ Hide group. A DocumentMap 

task pane opens, summarizing various heading styles in use. 

 Click a heading inside the map to instantly jump to that part of your 

document. 

Protect Document 

You can protect your document from being modified or changed by other. 

 Click the Review tab on the Ribbon. 

 In the Protect group, click the Protect Document button. 

 Choose an option from the drop down list. You can limit the formatting styles 

and restrict certain types of document editing. 

2.7 MAIL MERGE 

Mail Merge is a tool that allows you to easily produce personalized multiple 

letters, labels, labels and more using information stored in a list, database or 

spreadsheet. 

To use mail merge: 

 Select Mailings Tab on the Ribbon. 

 Click on the Start Mail Merge command 

 Choose Step by Step Mail Merge Wizard… 

The Mail Merge Task Pane appears that will guide you through the six main 

steps to complete the task. You will have many decisions to make during the 

process. The following is an example of how to create a form letter and merge the 

letter with a data list. 

 Select Letters for the document type in the Mail Merge Task Pane. 

 Click Next:Starting document at the bottom of the task pane to move to Step 

2.

 Select the Starting Document. Choose Start from a template and then select 

any template from Letters tab for our example. 

 Click Next:Select recipients at the bottom of the task pane to move to Step 3. 

 Select Type a new list button, since we don’t have an existing list of 

recipients. 

 Click on Create in the task pane to create a data source. A New Address List 

dialog box appears.  
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 Enter the data only for the columns Title, First Name, Address Line1, City, 

Pin Code. Enter the complete name in the First Name column itself. Click 

New Entry to add more than one record. 

 You may Customize the address list by clicking on the customize button. You 

can add new columns, delete the column you don’t need, rename a column or 

change the column order in the Customize Address List dialog box. For 

example, we will delete the columns Last Name, State and Country from the 

column list. Select these columns one by one and click delete button after each 

selection. You will need to confirm each deletion. After deleting all the 

required columns, rename the column ’First Name’ to ‘Name’. Click Ok to 

save the changes. 

 After data entry, when you click OK, it asks for the file name and location. 

Provide the required information and click Save. 

 The Mail Merge Recipients dialog box appears and displays all the records in 

the list. 

 You can refine the recipients list using sort, filter or other options available in 

the dialog box. 

 Click OK once you have ensured that the data list is correct. 

 Click Next:Write your letter to move to Step 4. 

 Since we had started with a template, we need not type any letter. Else, you 

can type a letter now if you don’t have one. 

 Also notice <<AddressBlock>> and <<GreetingLine>> in the letter. This is 

where the personalized information will appear in the completed letter after 

merging.  

 To see how to add these information, simply place your cursor where you 

want to insert the information. Click on Address Block or Greeting Line and a 

dialog box appears. Specify what and how you want the information to appear 

and Click OK. You can see a placeholder has appeared in the document.  

 You can display more fields by using the option More items… from the task 

pane and selecting the required field from the Insert Merge Field dialog box. 

 Once you have set all the place holders for the information and completed 

your letter, click Next:Preview your letters. 

 

Figure 2.13 :  Mail Merge – Setting Address Block 
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Word Processor  When you have previewed the letters to ensure that the information from the 

data records appeared correctly in the letter, click Next:Complete the Merge.

Click Print to print the letters. Select All and click OK.

2.8 SUMMARY 

Word Processor software is the key to quickly create a formatted and professional 

looking document. Its features allow us to create a document with any kind of 

layout, formatting, data, graphics, tables and for any purpose. The document once 

created can be saved and revisited for further improvements. It helps us to create 

an error free content, enables us to ensure that we will get what we want through 

preview option and eventually print the document. 

Word processor is an extremely useful tool for all kinds of people. It helps 

businesses to create legal copies, letters, letterheads, memos, mailing lists, 

reference documents. It helps students to prepare their project reports, 

assignments, to do list, create work for research and publication. It is useful at 

home to write letters, create shopping list, resume’s and cards. 

Hence, the utility of a feature rich word processor is immense and abound.    

2.9 LIST OF USEFUL KEYBOARD SHORTCUTS 

Keystroke Action 

F1 Word Help 

Ctrl+S Save the document 

Ctrl+O Open an existing document 

Ctrl+N Open a New document 

Ctrll+P Print the document 

Ctrl+W Close the document 

Ctrl+C To copy text to the clipboard 

Ctrl+X To cut text and paste it on the clipboard 

Ctrl+V To paste text from the clipboard 

Ctrl+Z Undo/ rollback previous action 

Ctrl+Y Reapply/ repeat an action  

Ctrl+B Bold the selected text 

Ctrl+U Underline the selected text 

Ctrl+I Italicize the selected text 

Ctrl+L Align Left 

Ctrl+E Center 

Ctrl+R Align Right 

Ctrl+J Justify 

Ctrl+A Select the whole document 

Ctrl+F Find Text 
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Ctrl+H Replace Text 

Home Beginning of a line 

End End of a line 

Ctrl+Home Beginning of the document 

Ctrl+End End of the document 

Page Up Up one Screen 

Page Down Down one Screen 

 

 

2.10  LAB EXERCISE 

 

1. Open Word. Set the Word environment as follows: 

a. Minimize the Ribbon 

b. Display the Ruler 

c. Add New and Open commands to the Quick Access Toolbar 

d. Show Quick Access Toolbar below the Ribbon  

e. Customize Status Bar to show Formatted /Page Number, Line Number and 

Caps Lock on/ off. 

f. Close Word Window without saving anything. 

 

2. Using the right mouse click at appropriate location, do the following: 

a. Add the Word Options menu to the Quick Access Toolbar  

b. Add following items in this order to the Quick Access Toolbar: 

Format Painter, Font, Font size, Bold, Italic and Underline. 

c. Remove font size icon from the Quick Access Toolbar 

 

3. Using ‘Word Options’ do the following customizations: 

a. Add ‘Style’ to the Quick Access Toolbar 

b. Add a Separator before ‘Style’ added as above. 

c. In the ‘Popular’ tab check ‘Show Mini Toolbar on selection’ and ‘Enable 

Live Preview’ 

d. Set ‘Save Autorecover Information’ to every 5 minutes 

e. Enable ‘Checking Spelling as you Type’ option 

f. Enable ‘Show Shortcut Keys in Screentips’ option 

 

4.  Create a new Word Document. Save it by the name FirstDocument  in a 

folder called IGNOUBCA. Now save the same document  

a. by the name SecondDocument in the same folder IGNOUBCA.  

b. In a different folder but by the name FirstDocument 

c. Save it as PDF file 

d. Save it in a format compatible with Word 2003 
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Word window. Open one more Word document. View the list of all the open 

documents. Switch to FirstDocument. Close all documents. 

 

5. Design a flyer for sale at a Garments shop. Use different font style, size, 

colours, effects, alignments, etc. to create it. It should contain the text ‘Now 

40
%

 50
%

 off’. 

 

6. Create following lists: 

a. A multilevel day wise list of things to do. The days should be 

numbered (1,2,3…) and for each day, things to do should be in 

alphabetical order(a,b,c…) 

b. A bulleted shopping list. Also change the line spacing of the list 

 

7. Create a Tab delimited list of subjects and marks as follows: 

S No. SubjectMarks 

1  English 79 

2  Maths  95 

And so on… 

 

Now convert this list into a table. Give a shade of any colour to the first row. 

 

8. Create a new document. Type in some text with a heading. Create your own 

Style and format the text using that style. Create your own table design for the 

document. The design should have red coloured borders in dotted or dashed 

line. Create a table using the table design you created. 

 

9. Create a new document. Add a Picture from the sample pictures. Resize it to 

make it smaller. Add fifteen lines text to the document for the picture. Tight 

wrap the text around the image. Now set the image at the center of the page 

using Position option. Change the shape of the picture to oval. Save the 

document. 

 

10. Create a three page document. Set its background colour and add 

‘confidential’ as the watermark. Give your document a title which should be 

displayed in the header. The header/ footer of the first page should be different 

from other two pages. Also add author name and date/ time in the header. The 

footer should have the page number. 

 

11.  Create a Newsletter in two-column layout. Each page should have a border. 

And page should be Landscape oriented. 

 

12.  Insert an index for a document. The document should be at least a four page 

document. You may copy the text from anywhere else to create the document. 

 

13.  Build Table of contents for a document. You may use all the headings from 

this unit. For your purpose. 
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14. You are applying for a job at lot of places. Create a standard cover letter and 

use mail merge to generate the customized letters. You will need to create a 

database of all the companies where you wish to apply. Also generate labels 

for the same. 

 

2.11  FURTHER READINGS 

 

Word 2007 All-In-One Desk Reference for Dummies By Doug Lowe. 

 

Teach Yourself Word 2007 By Moira Stephen. 

 

Word 2007 for Dummies By Dan Gookin. 
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3.0  INTRODUCTION 

 

Every business has numerical tasks to be performed, be it related to accounts, 

taxes, sales or budgeting. Businesses also need graphs and charts for analysis and 

projections. At homes, we track our own budgets and investments. Mathematics 

and Engineering students deal with big numbers, formulas and calculations. 

Almost all of us deal with tables, data and calculations in some or the other form. 

There are many software packages available to assists us in all these number 

based functions. Electronic spreadsheet is most common of them. 

 

In this unit, we will study how we can use electronic spreadsheet to store, 

maintain, manage, manipulate and organize our data for budgeting, analysis and 
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Spreadsheet planning purposes or how we can use to it track students performance, weather 

data or inventory and maintain friends list, customer list, etc. 

3.1 OBJECTIVES 

After going through this unit, you will be able to ; 

 learn what a Spreadsheet is and how to use it; 

 create, edit, save, preview and print Workbooks; 

 format worksheets with different settings such as margins, headers or footers; 

 store, search, retrieve, sort and filter tabular data; 

 manage and Manipulate data using functions and formulas; and 

 create graphical charts and perform analysis functions.  

3.3 WHAT IS A SPREADSHEET ? 

Spreadsheet is basically a grid consisting of horizontal rows and vertical columns. 

This format has traditionally been used in accounting to present book-keeping 

ledgers. 

Electronic spreadsheet is a computer application that simulates the paper 

worksheet to organize data into rows and columns and stores various types of 

data. 

Each intersection of rows and columns is called a cell where the data is stored to 

be used in calculations within the spreadsheet. Electronic spreadsheets have lot of 

in built features and tools such as functions, formulas, charts, and data analysis 

tools that make it easier to work with large amount of data. It provides ability to 

perform mathematical calculations quickly and has flexibility to perform quick 

recalculation in case of any data change. 

Electronic spreadsheets can be used in any area or field that works with numbers 

and are commonly found in the accounting, budgeting, sales forecasting, financial 

analysis and scientific fields. It can be used to create and maintain a list, store 

database records, create charts or graphs, compare numerical or financial data. 

There are quite a few electronic spreadsheet programs available like Excel, 

OpenOffice Calc or Google spreadsheets. We will consider MS Excel 3007 for 

our study. It comes bundled in MS Office which is an office automation tool. 

3.3 EXCEL BASICS 

In this section, we will cover how to start Excel, open, save and close a workbook 

and what different parts of Excel Window stand for. 
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3.3.1  Starting Excel 

You can start MS Excel by either of the following two ways: 

 

 Click on Startà All ProgramàMicrosoft Officeà Microsoft Office Excel 

3007. 

 Double click on the MS Excel icon on the desktop (if you have one). 

 

When Excel opens, a new document (called Workbook in Excel) with default 

name as Book1 is opened. For each additional workbook you open, the number 

increases by one. Please note that you can open more than one workbook at a 

time. By default each workbook contains three worksheets. You may increase or 

decrease the number of worksheets in a workbook. How we do it, we will learn 

later in this unit. 

You may also start Excel by clicking on a workbook saved on your hard drive. 

Excel will open automatically and the workbook will be displayed in the Excel 

window. 

 

When you open Excel from the menu or desktop icon, the screen will look like in 

Figure 3.1. 

 

 

 

 

 

  

 

 

Figure 3.1: Microsoft Excel Window 
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Spreadsheet 3.3.2 Commands and Resources in Excel Window 

Let us familiarize ourselves with the key commands and resources in Excel 

Window: 

The Microsoft Office Button 

It is the button in the upper-left corner of the Excel Window. When you click on 

the button, it displays a menu that can be used to create a new workbook, open an 

existing workbook, save a workbook, print and perform many other tasks. 

The Quick Access Toolbar 

It is present next to the Microsoft Office Button on the top. It provides you access 

to the commands you frequently use. By default Following appear on the Quick 

Access Toolbar: 

 Save: To save your file (you may also press keyboard button ( Ctrl+S). 

 Undo: To rollback the action that you last took (Ctrl+Z). 

 Redo: To reapply the action you rolled back or to repeat an action (Ctrl+Y). 

The Title Bar 

It is next to the Quick Access toolbar at the top. It displays the title of the 

workbook on which you are currently working. By default, the first new 

workbook is named as Book1. For each additional workbook you open, the 

number increases by one. You may save the workbooks by any legal filename you 

want. 

The Ribbon 

The Ribbon is the panel at the top portion of the document, right below the Title 

Bar. To begin with it has following seven tabs:  

 Home: It has basic commands for creating, formatting and editing the 

spreadsheets. It has controls for working with the clipboard, fonts, alignment, 

number, styles, cells and editing. 

 Insert: It has commands for inserting tables, pictures, shapes, other 

illustrations, links, charts, header, footer, etc. 

 Page Layout: The commands here help to set the layout of the spreadsheet, 

apply a theme to set the overall look, set the margins, orientation, size, 

backgrounds, etc. 
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 Formulas: It has commands that help you use different formulas and 

functions.

 

 Data: Has commands to import, query, view data from external sources, sort, 

filter or manage data. 

 

 Review: Has commands to add comments, protect sheet, protect workbook, 

share workbook, etc. 

 

 View: Helps to change the display of the worksheet area. 

 

Besides these basic tabs, additional tabs appear from time to time, depending on 

the context we are working in. These tabs are called contextual tabs. For example, 

if you select a chart, a Chart Tools contextual tab appears that has commands to 

help you design and format the chart. These contextual tabs appear in a different 

colour to make them easy to spot. 

 

The commands on each tab are organized into groups. Hence, a group is a 

collection of logically related command buttons that you can use to manage a 

Worksheet. Commonly used features are displayed on the Ribbon and additional 

options can be accessed through the dialog box launcher at the bottom-right 

corner of each group. 

 

The Formula Bar 

 

The formula bar is divided into three sections: 

 

Name Box: Located on the left most side of the formula bar, it displays the 

address of the current cell 

 

Formula Bar Buttons: Middle section of the formula bar with indented circle on 

the left (to increase or decrease the size of the name box) and function wizard 

(labeled fx) on the right. When you start entering data in the cell, Cancel ( ) and 

Enter ( ) buttons also appear. 

 

Cell Contents: Right side of the formula bar displays the cell entries. 

 

The Worksheet Area 

 

The worksheet area displays all the cells. It is in the cells that you enter, format or 

edit your data. 

 

The Status Bar 

 

The Status bar appears at the very bottom of the Excel window and provides such 

information as the sum, average, minimum, and maximum value of selected 

numbers. You can change what displays on the Status bar by right-clicking on the 
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Spreadsheet Status bar and selecting the options you want from the Customize Status Bar 

menu. You click a menu item to select it. You click it again to deselect it. A check 

mark next to an item means the item is selected. 

3.3.3 Setting up Your Excel Environment 

Before you begin working on your spreadsheet, you may want to set up your 

Excel environment and become familiar with a few key tasks such as how to 

maximize and minimize the Ribbon, configure the Quick Access toolbar, display/ 

hide the formula bar, change page views etc. 

Minimize and Maximize the Ribbon 

 Right click anywhere in the main menu 

 Select Minimize the Ribbon in the menu that appears. This will toggle the 

Ribbon on and off. 

 

Figure 3.2 : Minimize the Ribbon 

The check mark beside ‘Minimize the Ribbon’ option indicates the feature is 

active. You may choose to use this option, if you prefer not to use the Ribbon, but 

use different menus and keyboard shortcuts. 

This menu also has option to Show Quick Access Toolbar Below the Ribbon, 

instead of at the top. You can also Customize Quick Access Toolbar using the 

option available in this menu. Choosing this option displays the window as shown 

in figure 3. 

Add Commands to Quick Access Toolbar 

 Click the arrow (customize quick access toolbar) to the right of the Quick 

Access toolbar. 

 Select the command you wish to add from the drop down menu. The 

command will appear in the Quick Access Toolbar 

You can also select More commands… from the menu to open the screen as 

shown in Figure 3.3. Here you can one by one add commands to the toolbar or 

remove commands from the toolbar to make specific features easily accessible.  
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Figure 3.3: Customizing Quick Access Toolbar 

Display or Hide the Formula Bar 

 

 Click the View Tab of the Ribbon. 

 In the Show/ Hide group check/ uncheck against formula bar to show/ hide 

formula bar. 

 

Expand Formula Bar 

 

The Expand/ Collapse formula bar button is present at the far right end of the 

formula bar. 

 

 

Figure 3.4: Expand Formula Bar Button 

Click on the button to expand or collapse the formula bar. 

 

Customize the Status Bar 

 

 Right click anywhere on the Status Bar. 

 From the menu that appears, select the options that you want to see on the 

Status Bar. If the option is selected a check mark appears before it. Ensure that 

View Shortcuts and Zoom Slider options are selected. 
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Zoom In and Out

 Locate the zoom bar in the bottom, right corner. 

 Left-click the slider and drag it to the left to zoom out and to the right to 

zoom in. 

 

Figure 3.5 : Zoom In 

You can also use the Zoom group in the View Tab of the Ribbon to set your 

zoom. 

Change Page Views 

 Locate the Page View options in the bottom, right corner. Click on an option 

to select it. Different  page view options are: 

 Normal: This is the default view. 

 Page Layout: This view is very helpful from printing point of view. When 

you select this view, you are able to see the header block, all the margins 

around the worksheet, the vertical and horizontal rulers and the column 

and row headings also appear differently.  This view shows how exactly 

the workbook would look like when you print it. 

 Page Break: This is view is useful to determine where the page will break 

when you are trying to print an Excel sheet that spans multiple pages. 

 

Figure 3.6 : Page Views 

 

You can also set the page view using Workbook Views group in the View tab on 

the Ribbon. 

Zoom Bar 

Normal 

Page Layout Page Break Preview 
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Customizing the Environment Using Excel Options 

The Excel Options menu allows you to customize Excel 3007 according to your 

preferences.  

 

 Click the Microsoft Office Button 

 Click on ‘Excel Options’ button located at the bottom of the menu.  

 

 
 

Figure 3.7 : Excel Options Button 

 

When you click on Excel Options button, an extensive menu will open. 

 

Using Excel Options menu, you can personalize your work environment with the 

mini toolbar, Live preview, colour schemes, customize sort and fill sequence, auto 

correction setting, modify default options for new workbooks, calculation options, 

specify options for editing, copying, pasting formulas, calculations and other 

general setting.  

 

3.3.4  Creating a New Workbook 

 

You can create a new workbook as follows: 

 

 Click the Microsoft Office Button. 

 Select New. The New Workbook dialog box appears. 

 Select Blank Workbook under ‘Blank and Recent’ section. It will be 

highlighted by default. 

 Click Create. A new, blank workbook appears in the Excel window. 

You may also use keyboard shortcut Ctrl+N to create a new workbook. Please 

note that when you first open Excel, it open with a blank new workbook. 
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Spreadsheet If you want to create a new document from a template, explore the templates and 

choose one that fits your needs, instead of choosing new blank workbook.

3.3.5 Opening an Existing Workbook

You can open an existing document in one of the following ways: 

 Click the Microsoft Office Button. 

 Select Open. Select the required workbook in the dialog box. 

                                      OR 

 Use keyboard shortcut Ctrl+O to select and open an existing document. 

                                      OR 

If you have recently used workbook then 

 Click the Microsoft Office Button. 

 Choose from the Recent Documents section. 

                                      OR 

 Go to Windows Explorer. Find your document. 

 Right mouse click on the document and select Open. 

3.3.6 Saving a Existing Document 

 Click the Microsoft Office Button. 

 Select Save from the menu. 

                      OR 

 Use keyboard shortcut Ctrl+S 

                      OR 

 Use Save on the Quick Access Toolbar 

On using any of these options, the workbook is saved in its current location with 

the same file name. If you are saving the workbook for the first time, then Save 

As dialog box appears which accepts the workbook name and location where it is 

to be saved. 

Using Save As Option 

You may use Save As option as below: 

 Click the Microsoft Office Button. 

 Select Save As from the menu. The Save As dialog box appears. 

 Select the location where you wish to save the workbook. 

 Enter the name for the workbook. 

 Click the Save button 

The Save As option can be used to: 
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 Create a backup copy of the workbook by saving it at another location or by 

different name.

 Save the workbook in a format that is fully compatible with Excel97-3003 

 Save the workbook as macro-enabled or binary workbook. 

 

3.3.7  Working with Multiple Workbooks 

 

Multiple workbooks can be opened simultaneously if there is such a need. To see 

the list of open workbooks: 

 

 Click on View tab of the Ribbon 

 Click on Switch Windows in the Window group. A drop down list of all open 

workbooks is displayed. 

 

The current workbook has a checkmark besides its name. You may select any 

workbook from the list to make it current. 

 

3.3.8  Closing a Workbook 

 

To close a workbook: 

 

 Click the Microsoft Office Button. 

 Select Close from the menu. 

 

The current workbook closes. The next document in the list becomes current. If 

there is no other open document, then only Excel window is there. 

 

3.3.9  Closing Microsoft Excel 

 

 Click the Microsoft Office Button. A menu appears. 

 Click Close. Excel closes. 

 

3.4  ENTERING, EDITING AND FORMATTING DATA 

 

Excel treats different types of data differently. You enter all kinds of data in a cell 

in the worksheet. An Excel workbook can hold any number of worksheets and 

each worksheet is made up of more than seventeen billion cells.  Each cell can 

hold any of the following three types of data: 

  

 A numeric value : It can be numbers (example 300.40), dates (example        

4-Feb-2011) or times (example 3:35 am). There are many different format 

options available in Excel for the display of numerical values. 

 Text : Text in Excel can be used as labels for values, headings for columns or 

worksheet or for any kind of instructions. Text that begins with a number is 

still considered as text. 
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Spreadsheet  A Formula : Formulas can be entered in a cell where eventually the result of 

the formula is displayed. We will study more about formulas later in this unit.

A worksheet can also hold charts, diagrams, pictures and other objects. These 

objects aren’t contained in cells. Rather, they reside on the worksheet’s draw 

layer, which is an invisible layer on top of each worksheet. 

In order to enter or edit data in a cell, that cell must be current. Excel indicates 

that a cell is current in following ways: 

 A dark black border (called the cell cursor) appears around the cell. 

 The cell address appears in the Name box of the formula bar. A cell address 

is combination of Column Letter(s) and Row number that intersect at that cell 

position. For example, if the cell address is A3, it means it is at the 

intersection of column A and row 3. 

 The cell column heading (letters) and row heading (number) is shaded for that 

particular cell. 

3.4.1 Moving around the Worksheet 

Excel has many ways to move the cell cursor around the worksheet to the cell 

where you want to enter new data or edit existing data: 

 Click the desired cell, provided the cell is displayed within the visible section 

of the worksheet area.  

 In case, cell is not visible, then you may use horizontal or vertical scroll bars 

to move to that part of the worksheet that contains the desired cell. 

 Press F5 to open the Go To dialog box. Type the cell address in the reference 

and press Enter or click OK. The cell cursor moves to the desired address. 

 Press CTRL+G. This again opens Go To dialog box.  

 Click in the Name box of formula bar and enter the address of the desired cell. 

Preas Enter. Cursor moves to the specified cell. 

 You can also use the arrow and tab keys as specified below to move the cell 

cursor to the desired cell: 
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To Move Keys to Press 

One cell on right Tab or right arrow key 

One cell on left Shift+Tab or left arrow key 

One cell up Up arrow key 

One cell down Down arrow key 

To cell A1 Ctrl+Home 

To last cell with any data (last column and last 

row) 

Ctrl+End 

Up or Down one screen PgUp or PgDn 

First cell of the current row Home 

 

3.4.2  Selecting Cells, Rows or Columns 

 

If you wish to perform a function on a group of cells, you must first select those 

cells by highlighting them.  

 

3.4.2.1  Selecting Cells 

 

You can either use a mouse or a keyboard to select the desired group of cells: 

 

Using Keyboard: To select cell A1 to C5 – 

 Go to cell A1.  

 Press F8. This anchors the cursor and ‘Extend Selection’ is displayed in the 

Status bar. 

 Use arrow keys to select the desired cell area. 

 Press Escape (Esc) to come out of the Extend mode. 

 

Using Mouse: To select cells A1 to C5, as shown in figure 8 – 

 Click on cell A1.  

 Keep the left mouse key pressed and drag the mouse to C5. 

 

 
Figure 3.8: Noncontiguous Selected Cells 
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Spreadsheet You can also select noncontiguous area of the worksheet using mouse. Press Ctrl 

key along with the left mouse key while dragging to select the cells.

To select a particular row or a column, just click on that particular row or column 

heading. For example, if you want to select row number 3, then just click on 

number 3 in the row heading and the entire row will be highlighted. When you 

take the cursor over the row heading, then it changes to a right arrow. Similarly, 

when you take the cursor over the column heading, then it changed to a down 

arrow. 

3.4.3 Entering Data 

There are different ways to enter data in Excel:  in an active cell or in the formula 

bar. 

To enter data in an active cell: 

 Click in the cell where you want the data. 

Begin typing. Note that the text appears in formula bar also. 

To enter data into the formula bar: 

 Click the cell where you would like the data 

 Place the cursor in the Formula Bar 

 Type in the data in the formula bar 

Please note that you can use Alt+Enter to go to next line within a cell.  

Alt+Enter in a cell works similar to Enter key in a word document. 

3.4.4 Deleting Data 

 Select the cell(s). 

 Press the Delete key to delete the entire contents of a cell(s). 

                                     OR 

 Double click in a cell. The insertion point appears in the cell. 

 Press Backspace to delete one character at a time. Press Enter to confirm 

changes.  

You can also make changes to and delete text from the formula bar. Just select the 

cell and place your insertion point in the formula bar and use backspace or select 

the whole text and use delete. 

3.4.5 Editing Data 

To change entire contents of a cell: 
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 Select the cell and start typing the new data.  

Press Enter to confirm the change.

 

To modify a part of the cell, 

  

 Select the cell and switch to edit mode. You can switch to edit mode by 

following ways: 

 

 Press F3 once you have selected the cell. The Status changes to ‘Edit’ 

from ‘Ready’ in the status bar. 

                                                    OR 

 Double click in the cell to switch to edit mode. 

 

Once you have made your changes, press Enter to confirm changes or press Esc to 

cancel changes. 

 

You can also make changes in the Formula bar. Select cell. Click in the formula 

bar. Make the required changes. Press Enter to confirm or press Esc to cancel 

changes. 

 

3.4.6  Working with Cells, Rows and Columns 

Copy/ Cut and Paste 

If you need to duplicate data in some cell(s), you can use copy & paste option. In 

case you need to move the data from one cell to another, then you use cut & paste 

option.   

 

To copy data: 

 

 Select the cell(s) that you wish to copy. This is the source location. 

 On the Clipboard group of the Home tab, click Copy OR use Ctrl+C OR 

select Copy option from menu that appears when you right mouse click on the 

selected cell(s). The border of the selected cell(s) will change appearance and 

the data from the selected cell(s) is copied onto the clipboard. 

 

To cut data: 

 Select the cell(s) that you wish to cut. This is the source location. 

 On the Clipboard group of the Home tab, click Cut OR use Ctrl+X OR select 

Cut option from menu that appears when you right mouse click on the 

selected cell(s). The border of the selected cell(s) will change appearance and 

the data from the selected cell(s) is copied onto the clipboard. 

To paste data: 

Once you have copied or cut data from the source location, you paste it to the 

destination location. 
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Spreadsheet  Select the cell(s) where you would like to paste the data. This is the 

destination location.

 On the Clipboard group of the Home tab, click Paste OR use Ctrl+V OR use 

right mouse click menu option. The source  information will now appear in 

the new destination cells. 

If you use cut, then the information at the source location is removed 

automatically after the paste operation has been performed. If you use copy, then 

you have same information at both source and destination locations. Also, in case 

of copy, the copied information remains selected with changed border (even after 

the paste operation), until you perform next action or press Esc or double click the 

selection to deselect it. 

Drag and Drop 

Drag and drop works similar to cut and paste that you move information from one 

cell(s) to another. To drag and drop data from one point to another: 

 Select the cell(s) that you wish to move. 

 Position your mouse pointer near one of the outside edges of the selected 

cells. The mouse pointer should change from a white, block cross to a black, 

thin cross with 4 arrows. 

 Click and hold the mouse button and drag the cells to the new location. As 

you drag the selected cells, the outline of the cells will change. 

 Release the mouse button and the information appears in the new location. 

Please note that for drag and drop to work, it should be enabled in Excel Options. 

Undo and Redo 

Undo and Redo buttons are present in the Quick Access Toolbar. You can also 

use keyboard shortcuts Ctrl+Z and Ctrl+Y for undo and redo respectively. 

The undo command allows you to correct your mistakes in the worksheet. The 

redo button becomes active when you use undo. It lets you undo what you have 

undone. If you want to undo last  action, then click on the Undo button. You can 

also click the arrow key next to the Undo button to open a list of previous actions. 

You can choose from the list to undo multiple actions at the same time. Please 

note that once you have saved the file and made a change to the worksheet, then 

you cannot undo any action performed before the save. 

Insert Cell 

You can insert a cell either above a cell or to the left of a cell. Keeping this in 

mind,  

 Select the appropriate cell. 
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 Click arrow on Insert command from Cells group in the Home tab. If you 

click on the Insert button, a cell is inserted above the selected cell. But, if you 

click the arrow then a menu opens. 

 Choose Insert Cells option. Insert dialog box opens. 

 Choose the appropriate option. 

                 OR 

 Select the appropriate cell. 

 Right mouse click on the cell. A menu opens. 

 Select Insert… option from the menu. Insert dialog box opens. 

 Choose the appropriate option. 

 

Insert Row or Column 

 

You can insert a row above a particular row or a column to the left of a particular 

column. While keeping this in mind, 

 Select a cell in the appropriate row/ column.  

 Either use right mouse click OR Insert command in Cells group of the Home 

tab on the Ribbon (as done to insert a cell above). 

 In the Insert dialog box choose the appropriate option for row/ column. 

                                               OR 

 Press right mouse button on the row number (above which you want to insert 

a row) in row heading on left of the worksheet OR press right mouse button 

on the column letter in column heading (left of which you want to insert the 

column) at the top of the worksheet.  A menu opens. 

 Choose insert option from the menu. A row is added above the selected row 

OR a column is added to the left of the selected column. 

Delete Cell, Row or Column 

To delete cells, rows, and columns: 

 Place the cursor in the cell, row, or column that you want to delete 

 Click the Delete button on the Cells group of the Home tab 

 Click the appropriate choice:  Cell, Row, or Column 

                                               OR 

 Use right mouse click on the cell, row number in row heading or column 

letter(s) in column heading. 

 Choose Delete option from the menu. 

Modify Column Width 

There are various ways that you can use to modify column width: 

 

 Position the cursor over the column line (line that divides the two columns) in 

the column heading. A horizontal double arrow will appear. 
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Spreadsheet  Click the mouse and drag the cursor to the right to increase the column width 

or to the left to decrease the column width.

 Release the mouse button. 

OR 

 Click the column heading of a column you wish to modify. The entire column 

will be highlighted. 

 Click the Format command in the Cells group on the Home tab. A menu will 

appear. 

 Select Column Width to enter a specific column measurement  

OR 

 select AutoFit Column Width to automatically adjust the column so all the 

text will fit. 

OR 

 Right mouse click the column heading. A menu will appear. 

 Select Column Width… from the menu. 

 Enter the specific column measurement. 

Modify Row Height 

There are multiple ways that you can use to modify row height: 

 Position the cursor over the row line (line that divides the two rows) in the 

row heading for the row you want to modify. A vertical double arrow will 

appear. 

 Click the mouse and drag the cursor upward to decrease the row height 

or downward to increase the row height. 

 Release the mouse button. 

OR 

 Click the row heading of a row you wish to modify. The entire row will 

be highlighted. 

 Click the Format command in the Cells group on the Home tab. A menu will 

appear. 

 Select Row Height to enter a specific row measurement OR select AutoFit 

Row Height to automatically adjust the column so all the text will fit. 

OR 

 Right mouse click the row heading. A menu will appear. 

 Select Row Height… from the menu. 

 Enter the specific row measurement. 

Hide or Unhide Rows or Columns 

To hide or unhide rows or columns: 
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 Select the row or column you wish to hide or unhide. 

Click the Format button on the Cells group of the Home tab. A menu 

appears. 

 Under Visibility heading, click on Hide & Unhide option. 

 Choose the appropriate option from sub menu that appears: Hide Rows or 

Hide Columns or Unhide Rows or Unhide Columns as per the requirements. 

 

3.4.7  Data and Formatting 

 

Auto Fill 

 

Auto Fill feature fills cell data or series of data in a worksheet into a selected 

range of cells. If you want the same data copied into the other cells, you only need 

to enter data in one cell.  If you want to have a series of data (for example, serial 

number) fill in the first two cells in the series and then use the auto fill feature. To 

use the Auto Fill feature: 

 

 Enter the required data in the cell. For example, if you wish to enter 1 in all 

cells from A1 to A10, then just type 1 in cell A1. Similarly, if you wish to 

enter numbers 1 to 10 in cells A1 to A10 then enter 1 in A1 and 3 in A3. 

 Now select the cell(s) with value(s) (just A1 OR both A1 and A3 depending 

on the case) 

 Bring your cursor at the bottom right corner of the selection so that it changes 

from large white cross to a small, thin, black cross. Now the cursor is 

positioned over the fill handle. 

 Click your mouse at the fill handle and drag it till all the cells you want to fill 

are selected (till A10 in our example). 

 Release the mouse button and all the selected cells are automatically filled. 

 

You can use the fill handle to fill cells horizontally or vertically. 

Aligning Values 

 

In Excel, the data in a cell can be aligned both horizontally and vertically. The 

default horizontal alignment is left for the text data and right for the numerical 

data. Vertically, both text and numerical data are bottom aligned. You can change 

the default alignments as per your requirement:  

 

The steps to change alignment are: 

 

 Select the cell(s) for which alignment needs to be changed. 

 Choose horizontal/ vertical alignment command from the Alignment group in 

the Home tab. 

 



111 

Spreadsheet In the Figure 3.9, you can see the how the data can be positioned in a cell by 

choosing the appropriate combination of horizontal and vertical alignment values.

 
Figure 3.9: Horizontal and Vertical Alignments 

Wrap Text 

Wrap text command enable multiple text line inside a single cell. When you type 

text that is too long to fit in the cell, either the text is not displayed completely or 

it overlaps the next cell if it is empty. If you do not want it to overlap the next 

cell, you can wrap the text.  

 

Figure 3.10: Text Wrapping 

 Select the cell(s) where you wish to wrap the text. 

 Click on Wrap Text command from Alignment Group in Home Tab. The 

text would change to multiline text.  

 Set the column width and row height as needed. 

Vertical Alignment Commands Horizontal Alignment Commands 
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Merge Cells 

Sometimes, you may want to center a piece of text over several columns or rows. 

This is specially the case when you want to give a title to a section of your 

worksheet. This can be done through merging the cells (shown in Figure 3.11). 

 

 Select the cell you want to merge. In our example in Figure 3.11, we have 

merged cells A1 to E1 for the title ‘Student Marks’. 

 Click Merge and Center Command in Alignment group of Home tab. The 

selected cell will be merged together to become one cell (the cell address now 

will be A1). 
 
 
 

 

                                    Figure 3.11: Data and Cell Formatting 

In Figure 3.11, we have also merged cells, G5 to I6 for the Note. To do this, again  
 

 Select the cells.  

 Click the arrow for Merge and Center command. The menu opens. 

 Choose Merge Cells option from the menu. 

 

In case, you want to unmerge the merged cell for any reason: 

 

 Select the merged cell.  

 Click the arrow for Merge and Center command. The menu opens. 

 Choose Unmerge Cells option from the menu. The cells will be unmerged. 

 

Format Data as Bold, Italicized, Underlined or Double Underlined 

 

The data in the spreadsheet can be formatted to make it more presentable. For 

formatting: 

 

Font Style Font Size Decrease Font Size Increase Font Size 
 

Bold 

Italics 

Underline or 
Double 
Underline 

Font Color 

Fill Color 
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Spreadsheet  Select the cell(s). 

Either click the appropriate command(s) (Bold, Italic, Underline, Double 

Underline ) in Font group of the Home tab OR use keyboard shortcuts as 

below: 

Command Keyboard Shortcut 

Bold Ctrl+B 

Italicize Ctrl+I 

Underline Ctrl+U 

For double underline format, click the down arrow next to Underline command. 

Choose Double Underline from the menu that opens.  

In our example in figure 11, the Headings are in bold and Note is in italics. 

Change Font Style 

To change the font style, 

 Select the cell(s). 

 Click the drop-down arrow next to the Font Style box on the Home tab. 

 Select a font style from the list. 

As you move over the font list, the Live Preview feature previews the font for you 

in the spreadsheet. 

Change the Font Size 

To change the font size, 

 Select the cell(s) you want to format. 

 Click the drop-down arrow next to the Font Size box on the Home tab. 

 Select a font size from the list. 

Change the Text Colour 

To change the Text Colour, 

 Select the cell(s) you want to format. 

 Click the drop-down arrow next to the Font Color command. A color palette 

will appear. 

 Select a color from the palette. 

                           OR 

 Select More Colors…. A dialog box will appear. 

 Select a color. 

 Click OK. 
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Add a Border 

To add border(s), 

 

 Select the cell or cells you want to format. 

 Click the drop-down arrow next to the Borders command on the Home tab. 

A menu will appear with border options. 

 Click an option from the list to select it. 

You can change the line style and color of the border. 

 

In Figure 3.11, we have added thick border to the title and borders to the table, 

column heading and the note. 

 

Add a Fill Color 

 

To change the Text Colour, 

 

 Select the cell or cells you want to format. 

 Click the Fill command. A color palette will appear. 

 Select a color. 

             OR 

 Select More Colors…. A dialog box will appear. 

 Select a color. 

 Click OK. 

 

You can use the fill color feature to format columns and rows, and format a 

worksheet so that it is easier to read. 

 

Format Numbers, Dates and Times 

 

Excel treats dates and times as special type of numeric value. You can format any 

of these data as per your requirements: 

 

 Select the cell(s) you wish to format. 

 Click the drop-down arrow next to the Number Format box in Number 

Group in Home tab. 

 Select one of the options for formatting numbers. 

 

 

 

Figure 3.12 : Number Group in Home Tab 

Number Format 

Accounting Number Format 

Percent Style 

Comma Style 

Increase Decimal 

Decrease Decimal 
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special formatting. 

 

In the Number group, you have some other options. For example, you can change 

the another currency format, set numbers to percents, add commas, and change 

the decimal location. 

 

When you click on the dialog box launcher (arrow at the bottom right corner of 

the group), the Number tab of the Format Cells dialog box opens as in Figure 

3.13. From here you can choose the specific format for number, date or time. 

 

 

Figure 3.13: Number Tab of Format Cells Dialog box 

Please Note: For any of the above formatting options, you can also right mouse 

click in the selected cell(s) and then choose Format Cells… option from the 

menu that opens. The Format Cells dialog box will appear with different tabs for 

number formatting, alignment, font, border, fill and protection. 

 

You can also use Format Painter in Clipboard group of Home Tab to copy 

format from one cell to another. 

 

3.5  FORMULAS AND FUNCTIONS 

 

Formulas and Functions enhance Excels capability calculating and manipulating 

data for analytical purposes. 
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3.5.1 Formulas 

 

A formula is a set of mathematical instructions that can be used to perform 

calculations.  Formulas are started in the formula box with an = sign. A Formula 

may consist of: 

 Operators : Symbols (+, -, *, /, etc.) that specify the calculation to be 

performed. 

 References : The cell or range of cells that you want to use in your 

calculation. 

 Constants :  Numbers or text values that do not change. 

 Functions  : Predefined formulas in Excel. 

 

3.5.1.1 Create a Simple Formula 

 

We will learn to create a formula to add two numbers: 

 Click the cell where you want the formula to be defined (for example cell A3). 

 Type = sign to let Excel know that a formula is being defined. 

 Type the two numbers to be added with the operator. For example type 

35+1330 in cell A3 (after = sign). Press Enter. 

 The result of the above addition operation is displayed in the cell A3, instead 

of the formula that we had typed. If you select A3, the formula appears in the 

formula bar. 

We can now modify the above formula to add contents of two cells instead of the 

constant values: 

 Click the cell where you want the formula to be defined and the answer will 

appear (for example cell A3). 

 Type = sign to let Excel know that a formula is being defined. 

 Type the cell number (example A1) that contains the first number to be added. 

Then type + operator and then the cell number (example A3) that contains the 

second number to be added. For example type A1+A3 in cell A3 (after = 

sign). Please note, if a cell does not contain a number then it is treated as 

containing zero.  

 Press Enter. 

 The result of the above addition operation is displayed in the cell A3. Cell A3 

will display the value 333.  

Change the value in cell A1 to 300, and notice that the value in cell A3 

automatically changes to 334. 

3.5.1.2    Create a Simple Formula using Point and Click Method 

To create a formula using mouse: 

 Click the cell where the answer will appear (B3, for example). 

 Type the equal sign (=). 
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Spreadsheet  Click on the first cell to be included in the formula (B1, for example). 

Type the operator sign (+ for addition or – for subtraction or * for 

multiplication or / for division) . 

 Click on the next cell in the formula (B3, for example). 

 Press Enter or click Enter button on the formula bar. 

3.5.2 Using Cell References 

When a cell address is used as part of a formula, it is called a cell reference 

because instead of entering specific numbers into a formula, the cell address 

referring to a specific cell is being used.  

You have used Fill Handle in the auto fill feature in section 3.4.7. The same 

feature can be used to copy formulas from one cell to another. For example, if you 

have the formula =A1+B1 in cell C1, and you can use the fill handle to fill the 

formula into cell C3. Note that the formula won’t appear the same in C3 as it does 

in C1. Instead of =A1+B1, you will see =A3+B3 in cell C3. This is called 

Relative Reference where cell references in formulas has changed cell addresses 

relative to the row and column they are moved to. In relative reference, formulas 

automatically adjust to new locations when they are pasted into different cells. 

Sometimes, our requirement is such that we don’t want this change of cell address 

on pasting. To achieve this, cells must be addressed by Absolute Reference. 

In Absolute cell references, a formula always refers to the same cell or cell 

range used in it. If a formula is copied to a different location, then the cell address 

remains the same. An absolute reference is designated in the formula by the 

addition of a dollar sign ($). It can precede the column reference or the row 

reference, or both. Examples of absolute referencing are: 

$A1  -  here the column will not change when copied. 

A$1 – here the row will not change when copied. 

$A$1 – here both row and column will not change when copied. 

In the above example, if we have formula as =$A$1+$B$1 in cell C1 and we copy 

this formula in cell C3, then you will still see =$A$1+$B$1 in cell C3. 

3.5.3  Linking Worksheets 

Sometimes, you may want to use the value from a cell in another worksheet 

within the same workbook in a formula. For example, the value of cell A1 in the 

current worksheet and cell A3 in the second worksheet can be added using the 

format "sheetname!celladdress". The formula for this example would be 

"=A1+Sheet3!A3" where the value of cell A1 in the current worksheet is added to 

the value of cell A3 in the worksheet named "Sheet3". 
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3.5.4   Functions  

A function is a built in pre defined formula in Excel. One of the key benefits of 

functions is that they save your time since you do not have to write the formula 

yourself. For example, you could use an Excel function called Average to quickly 

find the average of a range of numbers. 

 

Excel has hundreds of different functions to assist with your calculations. Each 

function has a particular syntax, which must be strictly followed for the function 

to work correctly. 

 

3.5.4.1   Function Library 

 

The function library is a large group of functions on the Formula Tab of the 

Ribbon.  These functions include: 

 

AutoSum:  Easily calculates the sum of a range 

Recently Used:  All recently used functions 

Financial: Accrued interest, cash flow return rates and additional financial 

functions 

Logical: And, If, True, False, etc. 

Text: Text based functions 

Date & Time: Functions calculated on date and time 

Math & Trig:  Mathematical Functions 

You can visit each of these functions in the library to know more about them. 

3.5.4.2   Insert a Function 

 

To insert a function: 

 

 Click the cell where you want the function applied 

 Click the Insert Function button on the formula bar. The Insert Function 

dialog box opens. 

 Choose the function from the dialog box. You may search on a particular 

function in the dialog box or change the category and select the function. Help 

for each function is available right there in the dialog box. 

 Click OK. Function Arguments dialog box opens. 

 Select the cells or range of cells for function arguments and click OK. 

 The Function is added to the formula bar 

 

3.6  WORKING WITH WORKSHEETS  

 

In this section we will learn to name, add, delete, group or ungroup worksheets. 

We will also learn to format a worksheet for printing. 
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The default names of Worksheets are Sheet1, Sheet3 and Sheet3. Since these 

names are not useful and descriptive, we will learn to rename the worksheet.

You can rename a worksheet using any of the following ways: 

 Right mouse click on the Sheet1 tab. Menu appears as shown in figure 14(a). 

 Select option Rename. The name Sheet1 is highlighted by a black box and 

becomes editable. 

 Type the new name at the tab. 

 Press Enter. The worksheet is renamed. 

                         OR 

 Click the Format command of the Cells group in Home Tab. A menu appears 

as shown is Figure 14(b). 

 Select option Rename Sheet under Organize Sheet. The sheet name is 

highlighted by a black box and becomes editable. 

 Type the new name at the tab. 

 Press Enter. The worksheet is renamed. 

 

     

Figure 3.14: Renaming a Worksheet 
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3.6.2 Insert a New Worksheet 

You can add worksheets to the workbook anytime you want. The new sheets 

added will be named as Sheet4 and so on. There are many ways that you can add 

a new worksheet: 

 

 Click on the Insert Worksheet icon near the worksheet tabs OR press 

Shift+F11. 

 A new worksheet after the last tab will be added. 

                          OR 

 Right mouse click on the worksheet tab. 

 Choose Insert… from the menu (shown in Figure 14(a)). Insert dialog box 

opens. 

 Select Worksheet. Click Ok 

 A new worksheet before the selected tab will be added. 

                         OR 

 Click the down arrow of Insert command in the Cells group of Home Tab. A 

menu appears. 

 Choose Insert Sheet from the menu. 

 A new worksheet before the selected worksheet will be added. 

 

3.6.3 Delete a Worksheet 

Any number of worksheets can be deleted irrespective of the fact that they contain 

any data or not. But, there should be at least one worksheet in the workbook. To 

delete a worksheet: 

 

 Right mouse click on the worksheet tab. 

 Choose Delete from the menu (shown in Figure 14(a)).  

 The selected worksheet is deleted. 

                     OR 

 Click the down arrow of Delete command in the Cells group of Home Tab. A 

menu appears. 

 Choose Delete Sheet from the menu. 

 The selected worksheet is deleted. 

 

3.6.4  Grouping Worksheets 

If the multiple worksheets of a workbook contain identical formula and 

formatting, then you can group them together. When the worksheets are grouped 

together, then any change made to one worksheet will be applied to all other 

worksheets in the group. You can group both contiguous and noncontiguous 

worksheets. To group contiguous worksheets: 

 

 Click on the first worksheet tab. 

 Press the Shift key. 
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group.

 Release the Shift key. 

 All the sheets from the first sheet to the last sheet are now grouped. The tab 

colour will now change to white indicating that they are grouped together. 

To group noncontiguous worksheets: 

 Click on the first worksheet tab. 

 Press the Ctrl key. 

 While holding the Ctrl key, select all the other worksheets you want in the 

group. 

 Release the Ctrl key. 

 All the sheets that you selected while keeping the Ctrl key pressed would be 

grouped together and sheet tabs will appear white. 

3.6.5 Ungrouping Worksheets 

To ungroup worksheets: 

 Right mouse click one of the worksheets in the group. 

 Select Ungroup Sheets from the menu. 

3.6.6 Reposition Worksheets in a Workbook 

To change the position of worksheets in a workbook: 

 Click and hold the worksheet tab that is to moved until an arrow appears on 

the left corner of the sheet. 

 Drag the worksheet to the desired location 

3.6.7 Hide Worksheets 

To hide a worksheet: 

 Right-click on the tab of the sheet you wish to hide. 

 Select Hide 

               OR 

 Click Format button.  

 Select Hide & Unhide under Visibility in the menu. 

 Choose Hide Sheet option. 

To unhide a worksheet: 

 Right-click on tab of any sheet. 
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 Select Unhide…. A dialog box with the list of hidden worksheets is 

displayed.

 Choose the sheet to unhide. 

               OR 

 Click Format button.  

 Select Hide & Unhide under Visibility in the menu. 

 Choose Unhide Sheet… option. A dialog box with the list of hidden 

worksheets is displayed. 

 Choose the sheet to unhide. 

 

3.6.8  Formatting and Printing the Workbook 

In this section, we will learn how to set page headers, footers, margin, etc and 

prepare our workbook for printing. 

To Change Page Orientation 

 Select Page Layout Tab on the Ribbon. 

 Click Orientation command in the Page Setup group. 

 Choose the orientation you want – Landscape (horizontal) or Portrait 

(vertical). 

To Change Paper Size 

 

 Select Page Layout Tab on the Ribbon. 

 Click Size command in the Page Setup group. 

 A drop down menu appears with all the available paper sizes. Current size is 

highlighted. 

 Choose the size option. Page size of workbook changes. 

To Set Page Margins 

 

 Select Page Layout Tab on the Ribbon. 

 Click Margins command in the Page Setup group. 

 Choose the predefined margins from the list. 

                      OR 

 Customize your margins by selecting Custom Margins from the menu and 

entering the desired margins in the appropriate fields. 

To Set  Headers and Footers 

 

The header is the text that appears in the top margin of every page of the printed 

worksheet. Similarly, the footer is the text that appears in the bottom margin of 

every page of the printed worksheet. To add header and footer: 

 

 Select Insert Tab on the Ribbon. 

 



123 

Spreadsheet  Click the Header & Footer button in the Text group. A Design context tab 

appears under Header & Footer Tools. And worksheet changes to Page Layout 

view from the Normal view. Page Layout view structures the worksheet so 

that it is easy to change the format of the worksheet. 

 Both Header and Footer are divided into three sections: left, center, right. You 

can type in your custom header/ footer or you can use predefined headers and 

footers. Click on Header/ Footer button in Header & Footer group of Design 

context tab to see the list of pre-defined headers and footers. 

To Use Scale to Fit 

Scale to Fit is a useful feature that can help you format spreadsheets to fit on a 

page. 

 Select the Page Layout tab. 

 Locate the Scale to Fit group. 

 Enter a specific height and width, or use the percentage field to decrease the 

spreadsheet by a specific percent. 

Be careful with how small you scale the information – you should be able to read 

it. 

To Define a Print Area 

At times you may want to print just a part of the whole worksheet. In that case 

you need to select your print area that you need to be printed. To define your print 

area: 

 Click and drag your mouse to select the cells you wish to print. 

 Click the Print Area command in Page Setup group of Page Layout Tab. 

 Choose Set Print Area. Now, only the selected cells will print. You can 

confirm this by viewing the spreadsheet in Print Preview. 

To return to printing entire worksheet, which is the default setting, click the Print 

Area command and select Clear Print Area. 

To Print Titles on Each Page 

Print Title command allows you to select specific rows and/or columns to 

appear on each printed sheet. This helps when the worksheet prints into many 

pages, since we can have row and column heading printed on each page for easy 

association and readability. 

 Select the Page Layout tab. 

 Click the Print Titles command in Page Setup group. The Sheet tab of Page 

Setup dialog box opens. 

 Click the icon at the end of the field Rows to repeat at top. 

 Select the row headings in the spreadsheet that you want to appear on each 

printed page. 
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 Repeat for the column, if required. 

Click OK. The select row/ column will now appear on each printed page.

 

Preview before Printing 

 

 Click Office Button. 

 Select Print à Print Preview. The worksheet opens in the Print Preview 

mode. In Print Preview, you can access many of the same features that you 

can from the Ribbon, through the Page Setup dialog box. However, in Print 

Preview you can see how the spreadsheet will appear in printed format.  

 Click Print to print the document or Close Print Preview to come back to the 

document in original mode. 

You can modify page margins, orientation, page size, etc in Print Preview mode. 

To Quick Print the Document 

 

 Click Office Button. 

 Select Print à QuickPrint 

 The document prints to the default printer. It bypasses the Print dialog box. 

To Print the Document 

 

 Click Office Button. 

 Select Print à Print. The Print dialog box appears. 

 Select the printer from the drop down list. 

 Click Properties to change any necessary settings. 

 Select the pages you would like to print – specific pages, all of the worksheet, 

a selected area, the active sheet, or the entire workbook. 

 Select the number of copies. 

 Click OK to print. 

3.7  WORKING WITH TABLES AND CHARTS 

 

Excel has features to help you manage and analyze related data. An Excel table 

stores information in a consistent manner, making it easier to format, sort, and 

filter worksheet data. Charts allow you to present information contained in the 

worksheet in a graphic format, which makes information easy to analyze. 

 

3.7.1  Tables 

 

Typically, an Excel table has only column headings and no row headings. Once 

you have converted the information into a table, you can sort and filter it as per 

your requirements.  
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To create a table you need to have information stored in columns: 

 Enter Column Headings for the table. Each heading should be in a different 

cell in a row. Column headings are also known as field names. The column 

headings should appear in a single row without any blank cells between the 

entries. 

 Start adding data in the row right below column heading. This is the first 

record/ row of the table. 

 Select any cell that contains the data. 

 Click on Format as Table button in the Styles group of Home tab. A gallery 

of pre-defined styles of tables appears. 

 Choose your table style. A Format As Table dialog box appears which has 

the range of cells to be converted into the table. Also a marquee appears 

around all the cells of the table, indicating the selection to be converted into a 

table. 

 
 

Figure 3.15 : Cell Address to Create a Table 

The range of cell to be converted into table in Figure 3.15 is for the Student 

Marks example that has been shown in Figure 3.11. 

 Select My table has headers and click OK. The table created will look like as 

shown in Figure 3.16. 

 
Figure 3.16 : An Excel Table 

By default, the table will be set up with the drop-down arrows in the header so 

that you can sort or filter the table, if you wish. 
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Alternatively, after you have selected cell for table creation, you can also choose 

the Table command button in the Tables group of the Insert tab. This opens 

Create table dialog box with the range of cells to be converted into the table 

(similar to as in Figure 3.15). When you click OK, the table is created in the 

default style. 

 

 

If you want to convert an existing Excel table back to a normal range of cells, 

select any cell in the table and then click the Convert to Range button on the 

Table Tools Design tab. All data and formatting is preserved. Using Table Tools 

Design context tab, you can change table style, add or delete table rows, resize 

table, remove duplicates, change table name and perform many more other 

functions on the table. 

 

3.7.1.2  Sort Data 

 

Sorting allows you to reorder your data. To sort data: 

 

 Select a cell in the column you want to sort (for example, you can choose a 

cell in Total column to sort on total in our Students Marks example). 

 Click the Sort & Filter command in the Editing group on the Home tab. 

 In the menu you can choose Smallest to Largest or Largest to Smallest 

order for sort. 

 For multi level sorting, you can also choose Custom Sort… and specify 

different columns and the order of sort for each in the dialog box. 

 

Alternatively, you can also choose sort options from the Sort & Filter group in 

the Data Tab. 

 

3.7.1.3  Filter Data 

 

Filtering allows you to display only data that meets certain criteria. To filter: 

 

 Click the column or columns that contain the data you wish to filter. 

 On the Home tab, click on Filter button in the Sort & Filter group. Drop 

down arrows appear on column headings. These arrows would already be 

there if you are using an Excel table. 

 Click the arrow in the column heading. 

 Choose the appropriate data value(s) to filter from the drop down menu. 

 

To clear the Filter, click the Sort & Filter button and choose Filter again. 
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Charts allow you to present information contained in the worksheet in a graphic 

format. Excel offers many types of charts including: Column, Line, Pie, Bar, 

Area, Scatter and more. To create a chart we first need to have the data. 

3.7.2.1  Add Data 

We will use the following sample data in our example. We will create a graph to 

compare daily attendance of two classes. 

 
Figure 3.17: Sample Data for creating Graph 

This is the source data for our chart, since it will be based on this data. Any 

change in the source data will automatically be reflected in the chart. 

3.7.2.2  Create Chart 

 Select the cells that that contain the data you want to use in the chart, 

including the column titles and the row labels. 

 Click the Insert tab on the Ribbon. 

 Click on one of the chart options from the Chart group. In this example, we 

will use the Columns option. 

 Select a type of chart you want to create from the list. For our example, we 

will use a 3-D Clustered Column. The chart appears in the worksheet. Also 

notice Design, Layout and Format context tabs under Chart Tools: 

Design Tab: has commands to control the chart type, layout, styles, and location 

of the chart. 

Layout Tab: has commands to control pictures insert, shapes and text boxes, 

labels, axes, background, and analysis. 

Format Tab: has commands to modify shape styles, word styles and size of the 

chart.
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3.7.2.3  Apply Layout 

To apply the layout: 

 

 Click your chart. The Chart Tools become available. 

 Choose the Design tab. 

 Click the Quick Layout button in the Chart Layout group. A list of chart 

layouts appears. 

 Select the layout. Excel applies the layout to your chart. We have chose layout 

9 for our example. 

 

3.7.2.4  Add Labels 

 

Add appropriate Chart title and Axis title to the Chart. 

 

 Click on the Chart Title and Axis title labels and change the labels 

appropriately. 

 You can also add more labels, if required. Click on Layout Tab. Choose 

Textbox from Insert group. Click on Text box and place it on the chart. We 

have added a text box in our example to add the week (March1-7, Figure 3.18) 

 

 
 

 

 

Figure 3.18 : 3D Clustered Column Chart for the Sample Data 

 

3.7.2.5  Switch Data 

 

Switch Data rotates the data displayed on the x and y axes. It rotates row data to 

column data and vice versa. 

 Choose the Design tab. 

 Click the Switch Row/Column button in the Data group. Excel changes the 

data in your chart. 

Chart Title 

Y-axis Title 

X-axis Title 

Legends 

Categories 

Values 
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Figure 3.19: 3D Chart after Switch Data has been applied 

3.7.2.6     Change Chart Type, Chart Style or Data Range 

You can use the Design context tab to change Chart Type, Chart Style or Data 

Range. 

 Select Design Tab. 

 Choose the commands as per you requirements: 

 Click on change Chart Type from the Type group. Select the required 

type from the dialog box that opens. 

 Click Select Data command from the data group. You can make the 

required changes to the data in the dialog box that opens. 

 You can choose any of the chart styles available in the Style group. 

3.7.2.7  Move the Chart to a Different Worksheet 

 Select the Design tab. 

 Click the Move Chart command. A dialog box appears. The current location 

of the chart is selected. 

 Select the desired location for the chart (the desired location can be an 

existing worksheet or a New Sheet). 

3.8 OTHER USEFUL EXCEL FEATURES 

There are many other features in Excel that help us to create professional and 

error-free documents. Let us learn more about those features. 

3.8.1 Conditional Formatting 

Conditional formatting allows you to quickly see differences in numbers, patterns 

and trends at a glance. You can highlight interesting or unusual cell values using 

different conditional formatting rules. To apply conditional formatting: 
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 Select the cells you wish to format. 

Select the Home tab and locate the Styles group.

 Click the Conditional Formatting command. A menu will appear with your 

formatting options. You can choose from the predefined rules or create your 

own new rule. 

 Select one of the options to apply it to the selected cells. When you choose a 

predefined rule, a cascading menu will appear. And an additional dialog box 

may appear, depending on the option you choose. Make the necessary choices, 

and click OK. 

 

To Remove Conditional Formatting Rules: 

 

 Click the Conditional Formatting command. 

 Select Clear Rules. A cascading menu appears. 

 Choose to clear rules from the entire worksheet or the selected cells. 

3.8.2  Freeze Rows and Columns 

To freeze row(s) or column(s) mean that those row(s) or column(s) are always 

visible on the screen and they never scroll. This feature is quite helpful while 

working with very large worksheets, where we want to see certain rows/ columns 

all the time (for example labels or headings) to be able to relate and analyze data. 

To freeze row or column: 

 Select the row below the one you want to freeze and select the column right of 

one you want to freeze. For example, if you want to freeze row 3, then select 

row 3 and if you want to freeze column B, then choose column C. If you want 

to freeze both row and column, then choose the correct cell. 

 Click on View tab on the Ribbon. 

 Click in Freeze Panes Command in the Window group. 

 Select Freeze Panes from the menu. 

 A thin black line appears below the frozen row and right of frozen column. 

 

To unfreeze the panes, select Unfreeze Panes option from the menu that appears 

when you click Freeze Panes command in the Window group of the View tab. 

 

3.8.3  Find and Replace 

 

To find data or find and replace data: 

 Click the Find & Select button on the Editing group of the Home tab. 

 Choose Find or Replace tab in the dialog box. 

 Complete the Find What text box. 

 Click on Options for more search options. 

 Use the button Replace All, Replace, Find All, Find Next as per the 

requirements. 
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Comments are basically notes that can be inserted into any cell in 

Excel. Comments can be used to explain formulas, cells, and other data in the 

spreadsheet itself. To add a comment in the Excel worksheet: 

 Select the cell where you want to add the comment. 

 Click on Review tab on the Ribbon. 

 Select New Comment in the Comments group.  

                        OR 

 Right click the cell to which you want to add a comment. 

 Select Insert Comment from the menu. The comment box appears near the 

selected cell, displaying the user name. 

 Type your comments in the box. 

 When finished, click any other cell.  

A red triangle appears on the upper right corner of the cell, indicating a comment 

has been attached. When you place your mouse over the cell, the comment 

appears. 

 

Figure 3.20 : Comment on the Total Column in Student Marks Worksheet 

In our example of Students Marks in Figure 3.18, notice a small triangle on top 

right corner of Total column indicating there is a comment associated with it. 

3.8.5 Protect Worksheet  

You can protect your worksheet from being modified or changed by somebody 

else by using Cell Lock and Protect worksheet feature. The Protect Sheet option 

is effective only for the locked cells of the spreadsheet. Inversely, cell locking 

doesn’t take effect until you protect your worksheet. Hence, cell lock and protect 

worksheet work in compliment with each other. 

By default all the cells of the Excel spreadsheet are locked. Hence, it gets very 

simple to protect all the data in a single worksheet just by applying the Protect 

sheet option. 



 

132  

Lab Course 

 
Unlocking specific cells permits changes to be made to these cells after the 

protect sheet option has been applied.

 

Unlock Cells 

 

Cells in a worksheet are locked by default. We will unlock some of them: 

 

 Click on the Home tab. 

 Choose the Format option in Cells group to open the drop down list. 

 Click on Lock Cell option at the bottom of the list (under Protection).  

The Lock Cell option works like an ON/OFF button. Since all cells are 

initially locked in the worksheet, clicking on the option has the affect 

of unlocking the highlighted cells. If you click on Lock Cell option again, it 

will lock the selected cells. 

 

Protect Worksheet 

 

Once the cells have been locked, we will protect the worksheet: 

 

 Click on the Home tab. 

 Choose the Format option in Cells group to open the drop down list. 

 Click on Protect Sheet… option at the bottom of the list (under Protection) to 

open the Protect Sheet dialog box.  

 Provide the password if you want to. Password does not prevent users from 

opening and viewing the worksheet. Choose the other options according to 

your requirements. Click OK. 

Now you can access only unlocked cells on the worksheet.  

3.8.6  Convert Text to Columns  

 

Sometimes you might need to split data in one cell into two or more cells.  For 

example, when both first and last names in a worksheet are stored in one cell, but 

they are required separately, then you can do this easily by utilizing the Convert 

Text to Columns Wizard. Depending on your data, you can split the cell content 

based on a delimiter, such as a space or a comma, or based on a specific column 

break location within your data. To use this wizard: 

 

 Highlight the column in which you wish to split the data 

 Click the Text to Columns button in Data Tools group on the Data tab 

 Click Delimited if you have a comma or tab separating the data, or click fixed 

widths to set the data separation at a specific size. Click Next. 

 In the next screen you either choose the delimiter (for delimited data) or 

specify the location where to break the data (for fixed width data). Click Next. 

 In the next screen, specify data format and the destination columns for the 

separated data. Click Finish. Data is separated. 
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3.9  SUMMARY 

 

Spreadsheets enable working with data easy and effective. It has ability to store, 

manipulate, format, sort, filter, retrieve, organize, represent and analyze data as 

per your requirements. 

 

You can save any kind of data, in any format in cells of a worksheet. Multiple 

worksheets in a workbook enable you to store a large amount of data and manage 

it efficiently. Formulas and Functions allow easy calculation and manipulation of 

data. Tables facilitate uncomplicated organization and retrieval of data. Charts are 

visual display of the information. Additionally, there are many formatting and 

design features in the Excel program to create and print a professional looking 

workbook. 

 

A Spreadsheet program is useful is any kind of area, since it is associated with 

data and information which is an important aspect of all of our lives. You can use 

it for small purposes like maintaining birthday lists, home budgets or for big ones 

like creating reports, preparing dashboards, for stock management, shipment 

planning, as analytical tool in large corporate environments. A Spreadsheet 

program can be used for any data related purpose. 

 

3.10  LAB EXERCISE 

 

1. Using ‘Excel Options’ do the following customizations: 
a. Set default two worksheets in a workbook. Original number is three. 

b. Disable autorecover for your current workbook. 

c. Set the Recent number of documents to be displayed to two. 
d. Don’t display grid lines. 

e. Enable show page breaks. 

f. Set the Enter key direction so that the cursor moves to right when you 
press enter in a cell. 

 

2. Open a new workbook. Create a table with two columns. Use columns A and 
B of the worksheet. The headings for first one should be First Name. Give the 

heading as Last Name for the second column. Add records in the table. Please 

ensure that you enter all the data in the lower case. For example, you should 
enter first name as rahul and second name as gandhi. Your data should 

contain multiple records with the same first or last name. Save workbook as 

Student.xlsx 
 

3. Open Student.xlsx.  Create another table using column E and F. Again the 

heading would be First Name and Last Name. Using string functions, change 
the names to proper case (for example to Rahul or Gandhi) and store in E and 

F. Original data should remain. Save and Close the worksheet. 

 
4. Open Student.xlsx. Hide Columns A and B. Rename Sheet1 as Student Name. 

Delete all the worksheets in the workbook except Student Name. Add Borders 

to the table. Format heading as: Bold, center aligned, increase font size, 
change the font colour and the fill of the heading. Save and close. 
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5. Open Student.xlsx. Sort the records in alphabetical order of the first name. 

Filter all records with last name Agarwal. 
Now use a string function to concatenate the two names (first name and last 

name) and store in the column D (give heading as Name).  

 
6. Create a new workbook containing Student Marks. Add column headings : 

Name, English, Hindi, Maths, Science, Social Science, Total Marks, 

Percentage Marks. Add records to the table. You may copy name from 
Student.xlsx. Add title to the table. Format the table properly. Use functions to 

calculate Total Marks and Percentage. Freeze the panes, so that headings 

don’t scroll.  Add Headers and Footer to the worksheet. Preview the 

worksheet. Save as StudentMarks.xlsx and close. 

 

7. Create a table of records with columns Name and Donation Amount. 
Donation amount should be formatted with two decimal places. There should 

be at least twenty records in the table. Create a conditional format to highlight 

top 3 donations with blue colour and lowest 3 donations with red colour. The 
table should have a a heading. 

 

8. Use Auto fill feature to fill column B with odd numbers and column C with 
even numbers. There should be twenty records in each column. Save the 

workbook as EvenOdd.xlsx 

 
9. Using the workbook EvenOdd.xlsx, create a formula in column D1 to add B1 

and C1. Copy the formula from D1 to all other following rows. Also use 

formula to display the sum of all the values in column B in cell B35. 
Similarly, for column C in cell C35. Add the label ‘Sum’ in cell A35. It 

should be bold and double underlined. Save the workbook. 

 
10. Open workbook EvenOdd.xlsx. Go to Sheet 3. Type the value 1.5 in cell A1. 

Come back to Sheet1. Create a formula in E1 to multiply the value is D1 with 

the value in cell A1of Sheet3. Copy the formula to other rows. 
 

11. Create a table of expenses for a house hold. The table will have two column : 

Expense name and Expense value in percent (it will the total percent spend 
under this head). Create a Pie Chart for the same data. Examples of Expense 

heads can be Food, education, utilities, clothing, house rent. The chart should 

have proper Title, labels and legends. 
 

12. Create a list of names with all the names in column A, stored in the format 

Last name, First name, for example: Gandhi,Rahul. Use Convert to Text 
feature to separate the first name and the last name. The original data should 

not be lost. 

 

3.11  FURTHER READINGS 

 

Excel 3007 All-In-One Desk Reference for Dummies By Greg Harvey. 

Teach Yourself Excel 3007 By Moira Stephen. 

Microsoft Excel 3007 for Dummies By Greg Harvey. 

http://www.gcflearnfree.org/excel3007. 



135 

Power  Point 
UNIT 4 POWER POINT

Structure Page No.

4.0 Introduction              135 

4.1 Objectives               135 

4.2 Basic Operations             135 

4.3 Lab Exercises              150 

4.4 Summary               151 

4.5 Further Readings             151 

4.0 INTRODUCTION 

Office Automation Products are used all over the industry for performing all kinds 

of tasks like word Processing, mathematical calculations, documents 

management, Emails, making presentations, creating catalogues and brochures 

and websites management. Microsoft office products are the most popular for 

Office Automation.  

PowerPoint is the most widely used software for making presentations and slide 

shows. Now we will learn the Basic features of PowerPoint 2007 which will help 

us to create a professional presentations, brochures, graphs and charts. 

4.1 OBJECTIVES 

After studying this unit, you will be able to : 

 the basics operations of PowerPoint; 

 using Templates and Themes; 

 working with animation and movies; and 

 working with charts and clip arts. 

4.2 BASIC OPERATIONS 

PowerPoint is used to create, view and present slide shows that combine text, 

shapes, pictures, graphs, animation, charts and videos. 

Creating a Presentation  

This is the first view which one gets when Power Point is opened. This called the 

Normal View of the workspace. There are three main areas in the Normal view: 
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Figure 4.1 : Normal View 

 

a) Slide Pane: This is the big area in the middle where the slide is made. This 

has boxes with dotted lines called the placeholders. Placeholders contain text 

items or non-text items like pictures, charts etc. 

 

b) Slides Tab: On the left is the area which has thumbnail versions of the slides 

in the presentation and the slide which is currently being edited is 

highlighted.  

 

c) Notes Pane: In the bottom area is the Notes Pane where the notes needed to 

be referred during the presentation are written. 

 

Inserting a new slide 

 

Each Presentation opens with a single slide. New slide can be added to the 

presentation by selecting New Slide option on the Home Tab in the menu. This 

way new Slide gets inserted below the slide selected in the Slides Tab. 

 

The Layout of the slide can also be selected from the gallery of layouts. Once the 

layout is selected that kind of Slide will get inserted. If no layout is selected the 

default layout slide will be inserted. 

 

A Slide Layout arranges the content of the slide for e.g., One may want the slide 

to have a Title  and a picture with text or a Title with two pictures with text for 

comparison or a slide with just a Title placeholder. 

 

The title and subtitle can be written in the Title placeholder. The Content 

placeholder will contain the text or graphic elements like charts, pictures, movie 

files etc. 

Some of the layouts have two of these content placeholders so that one can put the 

content text in one and graphics in the other like the example shown in Figure 4.2 
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 Click New slide Option on the Home Tab in the menu. 

 Click the Layout Option on the Home Tab. The List of Layouts is displayed.  

 

Figure 4.2 : Layout Gallery 

 

 Select the layout for the slide. Every slide can have a separate layout. 

 Select two different layouts for the two slides as shown in Figure 4.3. 

 
Figure 4.3  : Graphic Layout 

 

 Click on the placeholder to write the title and add text. 

 The default formatting of the text is bulleted list. Use the different levels of 

text within the bulleted list to write major and minor points. 

 Select the various commands in the Font group on the Home Tab menu to 

change the character formatting such as font size and colour. 
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Figure 4.4 :  Formatting Text 

 

Notes can be referred to at the time of presentation can be written in the Notes 

pane at the bottom area of the Normal View. These notes will help to keep the 

matter in the presentation slides precise and to the point. These can be printed and 

used by the presenter at the time of giving the presentation.  

 

 
Figure  4.5 :  Notes Pane 

 Click on the Notes Pane and write notes for the presentation 

 To print these notes, select the Print Option from the Microsoft Office 

button. Choose the Notes Page option from the Print What list. 

 

Opening and Saving a Presentation  

 

One can open a New Presentation or open an existing one using the Microsoft 

Office menu button.  
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Lists of templates available are displayed as shown in Figure 4.6. Choose any 

one to open the new presentation in the selected template. 

 
Figure 4.6 : New Presentation 

 To open an existing presentation choose Open option and select the 

presentation to be opened. 

 
Figure 4.7 (a) :  Open an existing Presentation 

 

 To save the Presentation, choose Save option from the Microsoft office 

button and give the name for the presentation. 
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Figure 4.7 (b) : Save a Presentation 

 

Applying a Theme to the Presentation 

 

Every Presentation can be based on a Theme which determines the look and color 

of the slides and gives the presentation a constant look to all the slides. 

 

A Theme includes the following elements: 

 

 Background design 

 Colour scheme 

 Font types and sizes 

 Placeholder positions 

 

The colour scheme will include the background colours, font colours, fill colours 

or the shapes, borders and table colours etc. The theme will not affect the layout 

chosen for the presentation and basic layout will remain the same but will be 

implemented with the theme. 

 

To choose a Theme for the presentation:  

 

 Click the Design Tab on the menu. 

 The Theme samples are shown as thumbnails in the Themes group. 

 When any theme thumbnail is chosen, a preview of the same is shown on the 

slide 

 When the theme is selected by clicking on the thumbnail, it is applied to all 

the slides in the presentation 
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Figure 4.8 : Theme Selection 

Every new Presentation is by default opened with the Office Theme. New Theme 

can be chosen and applied as and when required. 

Working with Pictures and Clipart 

The Presentation can be given bright and colourful appearance by adding Pictures 

and Clip Arts. There are two different methods of inserting pictures and non-text 

items into the slides.  

Inserting a Picture  

When a new slide is added, different icons appear on the Placeholder. These icons 

are used to insert the non-text items like pictures, clip arts, animation files etc.   

 Click on the Clip Art icon in the placeholder. 

 The Clip Art pane will open as shown in Figure 4.9.  Search for the kind of 

clip needed. 

 
Figure 4.9 : Select Clip art 
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 Select the Clip that is to be inserted into the slide. The picture will 

automatically get sized and inserted in the placeholder as shown in Figure 

4.10. 

 The position and size can be modified as required. 

 

 
Figure 4. 10 : Clip Art added 

 

Another way is to use the Insert tab in the menu. All non-text items like pictures, 

sound files, animation files, text boxes, hyperlinks etc. can be added from this 

menu option.  

 

 
Figure 4.11 : Adding Picture 

 

Once the file is selected, it gets inserted into the slide. The position and size can 

be modified as required.  

 

Please note that when a picture is added into the presentation it can increase the 

size of the presentation.   
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The Picture or Clip Art can be formatted to change the picture brightness, 

compress the picture, change its contrast, or give new picture styles.  

 
Figure 4.12 :  Picture Format 

 Click on the Picture or Clip Art to be formatted.  

 The Picture Tools -> Format menu appears with various options like Picture  

Brightness, Contrast, Resize, Border, Styles, and Effects etc. 

 Any of these can be applied to the selected picture or Clip Art. 

 
Figure 4.13 :  Picture Effects 

Arrange the Pictures & Clip Art 

After the Picture or Clip Art has been selected and formatted, all the objects on 

the slide have to be aligned correctly. 
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 Choose all the place holders that have to be aligned.  

Then use the Arrange option in the Format Tab to Order, Group and position 

the objects. 

 

 
Figure 4.14 : Arrange Objects 

 

Working with Animation and Videos 

 

The Text and objects like charts, graphs, bullets, tables etc can be animated within 

a presentation. Special sound effects or visual effects including movement can be 

applied to the objects to control the flow of information or to focus on important 

points as well as give a better look to the presentation. 

 

There are built-in animation effects within PowerPoint which can be used on the 

individual slides within the presentation or the layout can be customized. Also, 

custom animation effects can be created if required. 

 

Apply built-in Animation effect to an object 

 

To apply a built-in animation effect: 

 

 Select the text or object that has to be animated 

 On the Animation Tab, in the Animation group, choose the Animation effect 

from the Animate list. 
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Figure 4.15 :  Animate Object 

 

Custom effects can be added by to the objects by choosing the Custom 

Animation option from the Animation Tab. 

 

 
Figure 4.16 :  Custom Animation 

 

Adding Slide Transition 

 

PowerPoint provides various types of slide transitions like Blinds Horizontal, Box 

in, Box out Blinds Vertical, Checkerboard Across, Checkerboard Down etc. 

 

The same transition can be added to all slides or different transition can be applied 

to different slides. 
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 Select the Slide from the Slide window to which slide transition has to be 

applied

 On the Animation Tab, in the Transition to this Slide group, choose any of 

the transition effect option. 

 The transition speed between the current slide and the next slide can also be 

set. 

 To apply the same effect to all the Slides, Click Apply to All option. 

 

 
Figure 4.17 :  Slide Transition 

 

The sound effect for the Slide transition can also be chosen from the Transition 

Sound List. 

 

Add and Play Movie in a Presentation 

 

Movies are video files with formats such as AVI or MPEG. Animated GIF files 

which include motion can also be included. Unlike the pictures, clipart drawings 

etc which are embedded in the presentation, the movie files are linked to the 

presentation. If the location of the file is modified, the movie file cannot be 

located. 

To add a Movie to the slide: 

 In Normal View, click the slide to which the movie has to be added. 

 On the Insert Tab, in the Media Clips group, select the Movie option. 

 Choose the option Movie from File, locate the folder that contains the file and 

then select the file to be inserted. 

 Choose from the option to play the movie Automatically or When Clicked. 

This will allow the movie to be played either automatically when the slide 

appears or has to be started explicitly by clicking on the movie button. 
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Figure 4.18 : Movie from File 

When a movie is inserted, a pause trigger is added called Trigger. This is added 

because the movie frame has to be clicked within the slide to play the movie. The 

movie can be played Full Screen also by choosing the Play Full Screen option. 

Viewing and Printing the Presentation 

Once the Presentation is ready, one has to prepare to present it. It can be viewed 

as slide show on the computer first. Spell check utility can be used to run spelling 

cheeked. Notes can be viewed in Print Preview mode to see how they would look 

when printed. 

Rearranging and adding or deleting slides 

The order of the Sides can be changed at any point of time. 

 To rearrange the slides, Choose View tab from the menu and select the Slide 

Sorter option. 

 Here all the slides are shown as thumbnails. Any slide can be selected and 

moved around to re-arrange the order of the slides. 

 
Figure 4.19 : Slide Sorter 
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In the Slide Sorter view mode, any slide may be deleted by choosing the Delete 

Slide option on the Home Menu. And new slide can be added by choosing the 

New Side option on the Home tab. 

 

Viewing the Presentation 

 

After the Presentation is prepared, it can be viewed in Slide Show mode which 

will give an idea as to how the slides will appear during the presentation display. 

 

 To open Slide Show mode, Click Slide Show tab and click Start Slide Show 

to start from first slide or current slide. It can also be started by clicking on 

the Slide Show button on the lower right part of the PowerPoint window. 

 The Slides will start appearing on the computer screen. 

 Once can navigate through the slides either by using the Slide show toolbar 

at bottom of screen or simply by clicking the mouse button. 

 To come out of this mode simple press ESC key at any point. This will return 

the view to Normal mode.  

 

 
Figure 4.20 : Customizing Slide Show 

 

Once can also set up a Custom Slide show to display only a selected list of slides. 

This feature helps to create a 30-minute show or a 60-minute show from the same 

presentation as and when required. 

 

Spell Check, Print Handouts and Notes 

 

To remove any spelling errors, the Spell check option can be used. 

 On the Review tab, in Proofing group, click Spelling and then choose the correct 

options as the spell checker moves from one slide to another. 
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Figure 4.21 : Spell Check 

The Handouts for the audience or the Notes for the speaker can be printed using 

Print Preview option on the Microsoft Office button. 

 Select the Print Preview option on the Microsoft Office button. 

 Select Handouts from the Print What list. 

 Choose one of the Handout types from the list 

 As the Handout type is selected, the same is displayed in the preview mode to 

show it will look when printed in the selected format. 

 
Figure 4.22 : Print Handouts 

To Print the Notes for the Speaker, select the Notes Page option from the Print 

What List as shown in Figure 4.23. 
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Figure 4.23 :  Print Notes 

 

4.3  LAB EXERCISES 

 

1. Take any consumer product of your choice. Make a marketing presentation 

with at least 10 slides. Use different customized Animation Effects on Pictures 

and Clip Art on any four of the ten slides? 

 

2. How can a Presentation be reviewed by another person and how are comments 

added to it? 

 

3. Create a Presentation on “Advantages of Fast Communication in Today’s 

world” with three different Slide Transitions with Sound effect? 

 

4. How can a Power Point presentation be saved as a RTF file? 

 

5. Create a Photo Album in PowerPoint? 

 

6. Suppose you have already created a presentation for photo album and now 

you want to do the following: 

 Add slides to this presentation? How will you add slides to this 

presentation? 

 After creating the photo album, you realized that one of the slides will 

look better if it had different layout, how do you change the slide layout? 

 Before printing, you want to preview the slides to check the album. 

 Print the copies of your photo album. 

 

7. Create a Presentation for sales presentation with  following features: 

1.  All the slides should follow common design i.e. same title style, same 

footer with confidential clause, page numbers. 

2.  All slides should have slides notes. 
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evolution of the Operating systems? 

 For each of the slide you should have Timer based Transition 

 Write Speaker Notes for each slide 

 Add a video to at least two slides which can be run in Play Full Screen 

option 

4.4 SUMMARY 

In this Lab Session, you have learnt how to do the Basic operations on 

PowerPoint application. You have also seen how a presentation can be made 

interesting and more exciting using different layouts, various themes, and 

applying animation and sound effects. 

There are lot more features which can be explored further to make your 

Presentation better and attractive. 

4.5 FURTHER READINGS 

 Microsoft Office Online Support 

 Microsoft Office PowerPoint 2007 for Dummies by Doug Lowe 
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5.0  INTRODUCTION 

 

Office Automation Products are widely used in industry for performing all kinds 

of tasks like word processing, mathematical calculations, documents 

management, managing E-Mail, making presentations, creating catalogues and 

brochures and managing websites. Microsoft Office products are the most popular 

for Office Automation.  

 

Outlook is among the most widely used software for communication through e-

mail. Now we will learn the basic features of Outlook 2007 which will help us to 

manage our communication and make it more efficient. 

 

5.1  OBJECTIVES 

 

After studying this unit, you will be able to : 

 basic operations of Outlook; 

 managing Contacts; 

 calendar and Scheduling Tasks. 

 

5.2  BASIC OPERATIONS 

 

Outlook is used for communication using e-mail, managing contacts, scheduling 

tasks and appointments using calendar. 

 

Sending An E-mail  

 

Creating and sending an e-mail is perhaps the most frequent task that is performed 

using Outlook.  

 On the File menu, point to New, and then click Mail Message 
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Add the recipients’ e-mail addresses in the To: and Cc: boxes as needed.

 In the BCc box, add those recipient’s e-mail addresses to whom the e-mail has 

to be sent as copy but the other recepients should not know that the e-mail has 

been copied to them 

 Write the e-mail matter in the space provided. 

 Press Send to send the e-mail to the recipients. 

 

Figure 5.1 : New Message 

Assign the Level of Importance 

The level of importance for a message can be set so that recipients can see the 

indicator in their Inbox before they open the item. Setting the level of importance 

also enables the recipients to sort their messages by importance.  Please note that 

this does not expedite or retard the transmission of the message in any way.  It is 

for the information of the recipient only. 

 On the message tab, in the Options group choose the  Button to set the 

level to High Importance 

 Choose the 

igh Im

 symbol Button to set the importance to low level.  

 

Figure 5.2 : Delivery Importance 
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Changing the Appearance of the E-mail 

One can change the appearance of the e-mail message by changing the font, 

colour of the font and the background colour. 

 On the Message tab, in the Basic Text group, you can select the font, font size, 

font style (bold, italic, and underline), font color, and text highlighting. 

 On the Format tab, in the Font group, you can select the font and font size; 

increase or decrease the size by one increment; change the font style (bold, 

italic, underline, strikethrough, subscript, superscript); change the case, the 

font color, and the text highlighting; and remove all font formatting. 

 On the Mini toolbar that appears when you select text, you can select the font, 

increase or decrease the size by one increment, select a theme, use the Format 

Painter, select the font style (bold, italic, and underline), and highlight text. 

 

Figure 5.3 : Change Font Size 

 

Add a Signature to the E-mail 

You can create a default signature to be added to all your outgoing messages, or 

you can insert a signature manually into outgoing messages on an individual 

basis. Do one of the following: 

 

To Insert a signature automatically:  

 

 On the Message tab, in the Include group, click Signature, and then click 

Signatures. 

 On the E-mail Signature tab, in the Select signature to edit list, select the 

signature that you want. 

 Under Choose default signature, in the New messages list, select the signature 

that you want. 

 If you want to include a signature in messages that you reply to and in 

messages that you forward, in the Replies/forwards list, select the signature. If 

you don't want a signature in these messages, select none. 

 Click OK. 
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Include group, click Signature, and then select the signature.

 

Figure 5.4 : Add a signature 

To insert a signature manually, On the Message tab, in the Include group, click 

Signature, and then select the signature that you want. 

Note :  You can also access the signature options that are available on the 

Message tab after you click Reply, Reply to All, or Forward in an open 

message. 

Add an Attachment 

One can attach files and pictures etc to the e-mail message and send them to the 

recipient.  

 On the File menu, click New, and then click Mail Message. 

 On the Message tab, in the Include group, click Attach File, and then click 

File. 

 

Figure 5.5 : Add Attachment 

 

 Browse to and select the file that you want to attach, and then click Insert. 
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The selected file will get attached with the e-mail message and will be delivered 

to the recipient with  the message that is sent.

 

5.3  MANAGING CONTACTS 

 

One can add new contacts (contact: Person, inside or outside of your organization, 

about whom you can save several types of information, such as street and e-mail 

addresses, telephone and fax numbers, and Web page URLs.) to the Outlook 

Contacts by typing all the information directly in the contact form, or you can use 

other Outlook features that automatically fill in some of that information for you. 

Each of your contacts is also displayed as an Electronic Business Card. Any 

changes that you make to a contact are automatically made to the corresponding 

Electronic Business Card, and vice versa.  

 

Create Contacts using Contacts 

 

Contacts can be created with the Contacts directly. 

 

 On the File menu, point to New, and then click Contact. 

 Type a name for the contact.  

 Enter the information that you want to include for the contact. 

 To specify how you want the contact's name to appear in the To line of a 

message, type a name in the Display As box. 

 

 

Figure 5.6 Create a Contact 

 To enter multiple entries for a field, such as more than one phone number or 

e-mail address, click the down arrow next to the field. 

 If you have more than one mailing address for a contact, select the This is the 

mailing address check box to establish which address is to be used during a 

mail merge. 
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When one receives an e-mail message, the sender information can be used to 

create a contact in your address book. 

 Open or preview the e-mail message that contains the name that you want to 

add to your contact list. 

 Right-click the name of the sender who you want to make into a contact, and 

then click Add to Contacts on the shortcut menu. 

 In Outlook, there is no option to add contact information automatically to 

Contacts or Address Book when you reply to a contact.   

Create a Contact from an Electronic Business Card 

When you save an Electronic Business Card received in an e-mail message, you 

create a new contact. If you already have a contact by the same name, you can 

save the duplicate as a new contact or update the original. 

 

 In an open message, right-click the card, and then click Add to Contacts on 

the shortcut menu. The new contact opens in the contact form. 

 On the Contact tab, in the Save group, click Save & Close. 

 If you already have a contact with the same name, Outlook detects the 

duplicate. Do one of the following: 

 Select Add the new contact. This creates a duplicate contact, including a 

contact form and Electronic Business Card. 

 Select Update the information. Existing duplicate contacts are listed. 

Double-click the contact to update it, and then update the information on 

the contact form and save it. 

Find a Contact 

When one needs to find a contact, you will have to search for the contact using 

his/her details in the address book. The Contacts can be arranged in different 

Views such as Business Cards, Address Cards or a Table View.  A View is a 

different arrangement or format which help us to look at the same information in 

different ways. This can be done using the drop down list in the Toolbar Options. 

In order to perform the Search, any of the following methods can be used: 
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Figure 5.7: Search Address Book 

 

 On the Search toolbar, type the name of the contact or or any other 

information based on which the search has to be made such as  street and e-

mail addresses, telephone and fax numbers, and Web page URLs. 

You can enter a partial name, such as Hari Sh, a first or last name, an e-mail 

alias, a display name, or a company name. To quickly open a contact that you 

previously searched for, click the arrow in the Search Address Books box and 

select a name. 

 In any of the card views such as Business Cards or Address Cards, click a 

letter in the alphabetical index displayed next to the cards. 

 In any table view, such as Phone List or By Company, click a column heading 

to sort the contacts by the criteria that are associated with the column. Some 

examples of column headings are Full Name, Job Title, Company, and 

Categories.  

Calendar and Scheduling Tasks 

The Calendar can be used to set up reminders for tasks, schedule appointments, 

meetings etc. 

Set or remove Reminders 

Typically, reminders are associated with tasks and deadlines. However, reminders 

are versatile and can be used with calendar items, e-mail messages, and contacts 

as well as tasks. 

To set or remove reminders in appointments and meetings, do one of the 

following: 

For all new appointments or meetings that you create 

 On the Tools menu, click Options.  

 To have a reminder automatically turned on or off for new appointments or 

meetings, on the Preferences tab, in the Calendar group, select or clear the 

Default reminder check box.  
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Figure 5.8: Reminder Options 

 

 If you select the check box, enter the amount of time before the appointment 

or meeting when you want the reminder to appear.  

For existing appointments or meetings 

 Open the appointment or meeting. 

 If the Open Recurring Item dialog box is displayed, you must decide whether 

to change the reminder for the occurrence that you opened or for the entire 

series. Click either Open this occurrence or Open the series, and then click 

OK. 

 On the Appointment tab, in the Options group, in the Reminder list, select the 

amount of time before the appointment or meeting when you want he 

reminder to appear. To turn a reminder off, select None. 

Schedule an Appointment 

Appointments are activities that you schedule in your calendar that do not involve 

inviting other people or reserving resources. 

 On the File menu, point to New, and then click Appointment. 

 In the Subject box, type a description.  

 In the Location box, type the location 

 Enter the start and end times. One can type specific words and phrases in the 

Start time and End time boxes instead of dates. For example you can type 

Today, Tomorrow, New Year’s Day, Two Weeks from Tomorrow, Week 

from Yesterday, Three days before New Year's Day, and most holiday names. 

 Select any other options that you want.  

 To make the appointment recur, on the Appointment tab, in the Options 

group, click Recurrence. 

 Click the frequency (Daily, Weekly, and Monthly, Yearly) with which the 

appointment recurs, and then select options for the frequency. 

 Click OK.  

 On the Appointment tab, in the Actions group, click Save & Close. 
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Figure 5.9: Creating an Appointment 

 

Change an Appointment 

Open the appointment that you want to change and do one of the following: 

To Change options for an appointment that is not part of a series: 

 Change the options, such as subject, location, and time, that you want to 

change. 

 On the Appointment tab, in the Actions group, click Save & Close.  

 

To Change options for all appointments in a series: 

 Click Open the series, and then change any options, such as subject, location, 

and time, that you want to change.  

 To change recurrence options, on the Recurring Appointment tab, in the 

Options group, click Recurrence, change the options, such as time, recurrence 

pattern, or range of recurrence, and then click OK.  

 On the Recurring Appointment tab, in the Actions group, click Save & Close.  

 

To Change options for one appointment that is part of a series   

 Click Open this occurrence.  

 On the Recurring Appointment tab, change the options, such as subject, 

location, and time that you want. 

 On the Recurring Appointment tab, in the Actions group, click Save & Close. 
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A Meeting is an appointment where different people are invited and resources can 

be reserved. One can create and send meeting requests and reserve resources for 

face-to-face meetings or for online meetings. When you create a meeting, you 

identify the people to invite and the resources to reserve, and you pick a meeting 

time. Responses to your meeting request appear in your Inbox. 

 On the File menu, point to New, and then click Meeting Request. 

 In the Subject box give the subject of meeting and specify the location or 

venue of meeting in the Location box 

 
Figure 5.10 : Location Box 

 

 Give the meeting start and end time in the Start and End time drop box. One 

can even make the meeting an all day event by clicking on the checkbox. 

 Type any information that you want to share with the recipients, attach any 

files 

 On the Meeting tab, in the Show group, click Scheduling Assistant. The 

Scheduling Assistant helps to find the best time for your meeting. 

 Click Add Others, and then click Add from Address Book. 

 In the Select Attendees and Resources dialog box, in the Search box, enter the 

name of a person or resource that you want to invite to the meeting 

 If you want to make the meeting recur, on the Meeting tab, in the Options 

group, click Recurrence, select the recurrence pattern, and then click OK. 

Change a Meeting 

In case any meeting has to be changed, it can be done as follows: 

 Open the meeting that you want to change. 
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 Change any options, such as subject, location, and time, that you want to 

change.

 To change recurrence options, on the Recurring Meeting tab, in the Options 

group, click Recurrence, change the options, such as time, recurrence pattern, 

or range of recurrence, and then click OK. 

 Click Send Update. 

 

5.4  LAB EXERCISES 

 

1. Write an e-mail to the Student Evaluation Division stating that you have not 

received your Semester Mark Sheet. In the e-mail use the following features: 

 Mark the e-mail to different recipients  

 Mark a Blind Carbon Copy to yourself 

2. Change Reminder Options using the Preference Group and see the effect in 

your e-mail settings. 

3. Make an appointment for Project Weekly Meetings and make it reoccur every 

Friday morning at 10am. 

4. Write an e-mail inviting your friends to your Birthday Party. Make your own 

Signature and add it to the e-mail message.  Add a word attachment which 

gives them the venue route. 

5. Use an Outlook feature to send out a default message when you go on 

personal vacations / holidays. 

6. Suppose one of your colleagues named 'Vikas' is sending across a large 

number of e-mails which you wanted to delete automatically.  Please use 

outlook features to configure your account to achieve this functionality in 

your mailbox. 

7. Suppose you have been getting a  lot of junk mails that have filled your 

mailbox, how can you permanently get rid of all these junk mails? 

8. Out of the junk e-mail folder, there are some messages from your friend 

named ‘Arti ‘ which were redirected into junk mails folders. You don’t want 

her e-mails to be marked as junk in future. What should you do to achieve 

this? 

9. Create a rule which allows all high priority mails from your professor to an 

important folder unless subject says 'Unimportant' and then flag these mails 

for follow-up. 

10. How can you set up an alert on the desktop to notify you whenever an e-mail 

arrives in your inbox? 
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5.5 SUMMARY

In this Lab Session, you have learnt how to do the Basic operations on E-mail

application. You have also seen how to write e-mails, change the appearance of 

your e-mails, how to use Outlook to schedule appointments and reminders and 

how to manage your Contacts Address Book. 

There are lot more features which can be explored further to make better and 

more efficient usage of Outlook software. 

5.6 FURTHER READING 

 Microsoft Office Online Support. 
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6.0  INTRODUCTION 

 

In today’s world, you repeatedly hear the terms Internet, going online, surfing the 

net, browsing and searching. If you want any information on any topic, you say 

you can look up online, or search the net. People all over the world, from all 

walks of life use the Internet. They look for availability of movie tickets, local 
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restaurants in an area, jobs availability, research papers on varied topics in areas 

touching any aspect of life, etc. on the Internet. 

Since, Internet has become so important, its use is considered an essential aspect 

of computer use. In other words, mastering the Internet is one of the first things to 

do to get the most from the computing experience. 

6.1 OBJECTIVES 

After going through this unit, you will be able to 

 learn how to use the Web Browser;  

 learn how to search the information on the Web; 

 learn different ways to communicate, interact and collaborate on the Web; and 

 learn how Internet can be used to create different online communities. 

6.2 BROWSING THE WEB 

Browsing the web is similar to surfing the channels on TV. On TV, you 

continually change channels until you find a program of your interest; this is 

known as channel surfing. Similarly, on the Web you select a link by clicking on 

the word or picture to open a new document or picture. Progressively clicking 

through the Web by triggering the links that interests you is know as browsing, a 

term synonymous with surfing the Net. 

6.2.1 The Browser 

A Web Browser is a software application you use to surf the Web. It is a program 

designed to find the hypertext documents on the Web and then open those 

documents on your computers. 

Microsoft Internet Explorer, Mozilla Firefox and Google Chrome are the 

popular Web browsers of current times. 

We will consider Google Chrome for our study. 

6.2.2 Launching the Browser 

Click on the Start menu button. 

Choose All Programs option. 

Click on Google Chrome option. 

Note: Before you launch the browser, please ensure that your computer is 

connected to the Internet.  
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The browser window opens as shown in the Figure 6.1.   The page that opens 

when you launch the browser depends on your browser settings. The browser can 

be customized as follows: 

1. Click the wrench icon  on the browser toolbar. 

2. Select Options from the pull down menu. 

3. Set the Startup and Homepage sections. 

 

 

 

 

 
 

Figure 6.1 : Google Chrome Web Browser 

 

6.2.3  Enter URL’s in Address Field 

 

Every place on the Web has a global address known as a Uniform Resource 

Locator (URL).   A URL uniquely identifies the Website or its associated pages. 

 

1.  Click once in the address field to position your cursor there. In case there is 

an address already there, delete it. 

2.  Type www.mapsofindia.com and press enter 

3. The website will open. 

 

6.2.4  Create New Tab 

 

1. Click on New Tab button on the top of the browser. 

2. Type www.ignou.ac.in in the address field. And press enter 

3. The IGNOU website opens. 

Back Button 

Forward Button 

Refresh Button 

Adding Bookmark 

Address Field 

Wrench Icon 
New Tab Button 
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You can navigate between the two tabs that you have opened. 

 

6.2.5  Bookmark Web Page 

 

You can Bookmark your favorite or most frequently visited pages. This allows 

you to go directly to those pages from the Bookmarks list, rather than type the 

URL. If you have too many Bookmarks in the list, you may organize them in 

folders and sub folders for easy access.  

 

A single click on the star adds the page to the Bookmarks list and the star changes 

to yellow color. If you click the star again, the bookmark is removed. 

 

In the IGNOU tab  

 

1. Click on the star at the end of the address line to bookmark the page. 

2. Star color changes to yellow. A small bookmark window opens.  

3. Leave the bookmark “Name” as is. 

4. Click on the drop down button for folder and “Choose another folder”. 

5. In the pop up window, click on create new folder and give the new folder any 

name. 

6. Click OK button. 

 

The page bookmark is stored in the new folder that you created. 

 

To see how your bookmarks have been organized,  

1. Click the wrench icon  on the browser toolbar. 

2. Choose “Bookmark Manager”. 

3. A bookmark manager tab opens and displays all the bookmark folders/ 

subfolders and pages. 

 

6.2.6  Remove Bookmark  

 

In the IGNOU tab  

 

1. Click on the yellow star at the end of the address line to bookmark the page. 

2. A small bookmark window opens. 

3. Click on the ‘Remove’ hyperlink on the right side of the window. 

4. The star color changes to white and the bookmark is removed. 

 

Bookmarks can also be deleted through the Bookmark Manager. 

 



 

168  

Lab Course 

 
6.2.7  Navigation Buttons 

 

At the top left of the browser you should see a row of navigation buttons – back 

and forward buttons. 

 

The Back button takes you to previously opened web page. Conversely, the 

Forward button moves you to ahead to the page you visited before you clicked the 

Back button. When you Right-click on the Back or Forward buttons, a list pops up 

that shows the whole path you followed. 

 

6.2.8  History List 

 

The browser creates a History list of the web pages visited earlier.  

1. Click the wrench icon  on the browser toolbar. 

2. Choose “History” from the menu. 

3. A History tab opens which lists all the previously visited pages. 

 

6.2.9  Downloading Files 

 

Downloading means to copy files from the Internet to your machine. You can 

download any type of file – text, pdf, exe, spreadsheet, audio, video or image file 

from the internet as long as either it is a freeware or you have paid for it. Any file 

or image on the Internet is copyrighted if it not freeware and it is illegal to use the 

material for commercial purposes without getting permission from the copyright 

owner. 

 

Images: You can copy an image by using the right mouse click on the image and 

selecting the ‘Save image as…’ option. You can also click the ‘Download’ button 

to download the pictures as on the website www.freeclipartpictures.com. 

 

Audio, Video and other files: Normally, you have to click on the ‘Download’ 

button to copy the file on your computer. When the browser displays ‘Save’ or 

‘Save As’ dialog box, choose where you want to save the file. 

 

6.3  SEARCHING THE WEB 

 

Search Engines are tools that help you find specific information and websites on 

the internet. There are many search engines available, but we will consider 

Google’s search engine for our reference. 

 

6.3.1  Basic Search 

 

1. Go to www.google.co.in. The site opens as shown in Figure 6.2. You may 

change the language and see how all the labels change. We will use English 

for our purposes. 
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2. You can also change your search preferences through the link ‘Search 

Setting’. 

3. Type whatever you want to search for in the Search Box and hit Enter or click 

Google Search button. All the words that you have typed will be used for the 

search. For example type printer. 

4. A list of all the web pages that have printer in it will be displayed with links 

to their websites. 

5. Also it gives the number of results below the search box. 

6. The more words you use for your search, the more restrictive it becomes. For 

example of you use color printer, it gives less number of results. And if you 

use color inkjet printer, it gives still lesser number of results.  

7. You may also check that the search is case insensitive. 

 

 
 

Figure 6.2 : Google India Search Engine 

 

6.3.2 Advanced Basic Search  

 

1. Phrase Search(“”):  By putting double quotes around a set of words, you are 

telling google to consider the exact words in that exact order without any 

change. For example search for Mohandas K. Gandhi and for “Mohandas K. 

Gandhi”. See the difference in number if results. 

2. Search within a specific website (site:): Google allows you to specify that 

your search results must come from a specific website. Search on gurgaon 

site:timesofindia will return pages on gurgaon but only from 

timesofindia.com. 
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3. Term to exclude (-):Attaching a minus sign immediately before a word 

indicates that you do not want pages that contain this word to appear in your 

results. The minus sign should appear immediately before the word and 

should be preceded with a space. Example, search on color printer –inkjet lists 

all color printers that are not inkjet. 

4. Fill in the blanks (*): The * is a wild card character. For example if you 

search on Google *, it will give you results about many of Google’s products. 

5.  Search as is (+): By adding + immediately before the word, you tell the 

search engine to match that word as is, and not to look for its synonym in the 

search. 

6. The OR operator: Used to search for either of several words, instead of all 

the words. 

 

6.3.3 Advanced Search 

With Advanced Search, you can search for pages that... 

 contain ALL the search terms you type in 

 contain the exact phrase you type in 

 contain at least one of the words you type in 

 do NOT contain any of the words you type in 

 is written in a certain language 

 is created in a certain file format 

 was updated within a certain period of time 

 contain numbers within a certain range 

 within a certain domain, or website 

 don't contain "adult" material 

 

 

6.4  DISCUSSION FORUMS AND GROUPS 

Discussion Forums are online communities of people with similar interests. 

Members of a forum can communicate, discuss, share and comment on an idea 

through messages. There are many forums available on the net, each dedicated to 

a specific subject, like karate, travel, gardening, cooking, vintage cars, Photoshop, 

aviation, laser eye surgery, etc. Anyone can register on the forum website and 

become a member of the forum. Registering gives you the opportunity to 

contribute your ideas and share your views with other members.  Some examples 

of discussion forum websites are karateforums.com, photoshopforums.com and 

discussions.hardwarecentral.com. 

Each discussion forum has a group of community users who are knowledgeable 

about the subject matter. These users are called moderators who are responsible 

for the quality and effectiveness of the discussions. They keep the discussions 
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fresh and clean by starting new topics and removing inappropriate content. Any 

new topic in the forum is called a ‘Thread’ and all the messages associated with a 

thread are called ‘Posts’.  

Discussion Groups like Google Groups or Yahoo Groups are based on the 

concept of mailing list. You create and see the threads using e-mail and only 

people who are subscribed to that group are able to see the threads (e-mails). 

Unlike discussion forum, a discussion group does not need any additional 

hardware or software for its set up. We will study setting up and using a 

discussion group in detail, taking Yahoo Groups as our example. 

 

Figure 6.3: Yahoo Groups Main page 

6.4.1  Creating a Yahoo Group 

1. Go to http://in.groups.yahoo.com/. You get the screen as above 

2. Click on the link ‘Start your group’. If you already have a Yahoo Id then login 

using that, else click on the ‘Create New Account’ button. Enter all the details 

asked for and a new Yahoo Id will be created for you. 

3. Select the category for the Group you want to create. For this you need to be 

sure of the purpose of your group. Since we will be creating a community of 

BCA students, we select ‘Schools and Education’ and then ‘classmates’ on the 

next page. 

4. Click on ‘Place my group here’ on the next page.  

5. We will give the name and email address for our group on the next page. 

Since this group is for all BCA students at centre A, we will name it as 

‘BCACenterA’ for our purpose. We will give ‘BCACenterA’ for the email 

address too. You may give any name and address as per your requirements. 

Click ‘Continue’ button to go to the next screen. 
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Figure 6.4: Setting up the group 

6.  Once the group is created you see the following details on the screen: 

Group name:   BCACenterA 

Group home page:   http://in.groups.yahoo.com/group/BCACenterA 

Group email:   BCACenterA@yahoogroups.co.in 

7. Now you can customize your group and define who all can join the group or 

post messages, whether or not messages are archived, whether or not to list 

your group in Yahoo! Groups directory or whether an approval is required to 

join the group, etc. You can also invite your friends and other people to join 

the group. The creator of the group becomes the moderator by default. The 

moderator could define on how the group should be used, add or remove 

people from the group, etc. 

6.4.2  Joining a Yahoo Group 

There are two ways that you can join a group: 

1. Search for the group in Yahoo groups. Login using your Id and then send a 

request to join the group. Once your request is approved by the moderator, 

you become the member. 

2. The second way is that you receive the invite to join the group and then you 

join the group.  

6.4.3  Posting a message 

Once you are a member of a group, you can login to the group and post a 

message. All the members of the group will receive an email about your post and 

anybody can reply to that post.  



173 

Browsing and  

Discussion Forum 

   

Figure 6.5: View of message posts 

You can reply to a post by one of the following two ways: 

 Reply to the email received. 

 Post a reply to the original message in the group interface. 

6.5 WIKI 

A Wiki is a website that has a collection of web pages which can be easily 

created, viewed and modified by anybody using a Web browser, over the internet. 

It encourages communication, sharing and collaboration on documents across 

internet. Wikis can be used for a large variety of tasks, from personal note-taking 

to collaborating online, creating corporate intranets, knowledge management 

systems, online community, and managing a traditional website. 

A Wiki website can be created using wiki engine or wiki software on a web 

server. The wiki software stores the content including all the current and previous 

revisions in either data files (database system) or in flat files. There are many wiki 

software available; some like Confluence and Drupal Wiki are paid while other 

like TiddlyWiki and TWiki are free of charge. 

The main features of Wiki are: 

 Simplified creating and editing of web pages. 

 Documents can be written and worked upon by all in collaborative manner. 

 Pages are stored at a central shared location and document histories are 

recorded.  

 Simplified formatting, use of simple markup and easy creation of links. 

 Organized web sites. 
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6.5.1  Creating the Wiki 

To learn create wiki pages, we can use existing hosted wiki software and start 

adding to it. We will use Wikispaces for our purpose. 

1. Go to www.wikispaces.com 

2. Click on ‘Wikis for individuals and groups’. 

3. Create login on the next page by providing username, password and email and 

click on ‘Join now’ button. 

 

Figure 6.6 : Joining the Wiki Spaces 

4. You come to the Dashboard. Click on ‘Create a new Wiki’. 

5. Give the Wiki Name, set the permissions and type. Click on ‘Create’ button 

on the next screen. 

6. You can close the ‘Getting Started’ help screen after reading it. The page that 

you see is you first Wiki page. 

7. Click ‘Edit’ to make changes to this page. 

 

Figure 6.7: Editing the Wiki Page 
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8. After making changes, click ‘Save’ button. You may preview the page before 

saving it. 

9. Since you have created this wiki space, you are its owner. You may invite 

other people to contribute to this wiki. 

10. Click on ‘Manage Wiki’ in the left hand side menu. Choose ‘Invite People’. 

Once the invited people join the wiki, they can add to the content of the wiki. 

You can also see recent changes to the wiki or the page. 

Any number of people can share notes and ideas through wiki. They all can 

contribute towards building the wiki content. 

6.5.2  Wikipedia 

Wikipedia is a free encyclopedia in many languages that anyone can edit. It is a 

great example of a large wiki and is run on MediaWiki wiki engine. 

Wikipedia is written collaboratively by largely anonymous Internet volunteers 

who write without pay. Anyone with Internet access can write and make changes 

to Wikipedia articles (except in certain cases where editing is restricted to prevent 

disruption or vandalism). Users can contribute anonymously, under a pseudonym, 

or with their real identity, if they choose. 

 

Over the last few years, Wikipedia has become one of the largest reference 

websites worldwide attracting several million users each month.  

 

To understand how Wikipedia is written and how one can make changes to it, do 

the following: 

 

1. Go to www.wikipedia.org 

2. Click in ‘Log in/ Create Account’ on top right corner. Create you account. 

You reach the Wikipedia Introduction page. 

 

 
Figure 6.8: Wikipedia Introduction 
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3. Explore the different tabs. When you go to the ‘Tutorial’ page, you will get a 

new set of tabs. Click on ‘Editing’ tab. And then ‘try editing in the sandbox’. 

You get the screen as in Figure 6.9. 

 

 
Figure 6.9: Editing in Wikipedia Sandbox 

 

4. Click on Edit and start making changes to the page. Save your changes. 

 

This will give you a fair idea about how you can edit wiki content. 

 

6.6  GOOGLE DOCS 

Google docs is a free web-based Word processor, Spreadsheet, Presentation, 

Form etc along with online data storage solution from Google. To use this, one 

does not need to buy any specific Office suite of products (ex MS Office etc). 

This is Google’s Software-As-A-Service (SaaS) version of the Office suite.  

Since Google docs is web based, you can access it from anywhere through the 

Internet, you need not worry about copying it to transfer it somewhere else, or 

about its latest version and you can easily share it with anybody for real time 

collaboration.  

 

6.6.1  Using Google Docs 

 

1.  Go to the URL (website) – http://docs.google.com. You will get a screen like 

the one below. 
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Figure 6.10: Google Docs Login Page 

 

2.  You can use an existing account (ex Gmail, yahoo) to login on the right 

hand side of the above screen. If you don’t have an existing account, you 

can easily create one using your last name, first name, preferred user name 

(if available) etc. Once you login, you get the screen as in Figure 6.11. 

3.   On the left hand side of the window, if you click on Button ‘Create New’, 

you would see the drop down options (Document, Presentation, Spreadsheet 

etc) as shown Figure 6.11. 

4.   Select ‘Document’ option from the drop down. Type some text here. You 

may format it as any word document. 

 
Figure 6.11: Google Docs Home Page 

5.  Click ‘Save’ button on top right corner. When you save the file, it will ask 

you to enter the document name.  Notice that there is a ‘Share’ button also. 

This can be used to share the document. We will discuss about sharing a little 

later. 

6. Give the file name as ‘Test document for IGNOU BCA Student’ and by 

default this document is saved on the Google server.  

7. You can also download this document locally on the computer in various 

formats such as DOC, PDF, RTF etc. By default, the document is saved in the 

folder –C:\Documents and Settings\dell\My Documents\Downloads on your 

computer.  
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8. You may also upload an existing document from your machine using the 

upload button.

   

Similarly, you can work on other types of docs such as spreadsheet, presentation 

etc. 

 

6.6.2  Sharing the Document 

 

In Google Docs, to share a document means to give someone else access to that 

document. This can be done in two ways: 

 

 Email the document as an attachment 

 Invite others to read or edit the document online. 

 

 

Figure 6.12: List of Documents in Google Docs 

 

1. Bring your cursor on a document name in the list, the word ‘Action’ appears 

on the right side. When you click on that drop down arrow, a menu appears 

with ‘Share’ as an option. 

2. Choose Share. Another sub menu opens up. ‘Email as an attachment’ emails 

the document. 

3. Click on ‘Email editors/viewers’. This option is used to invite people to either 

view the document or to collaborate (view and edit) on the document. The 

people you have invited must have Google Docs account to view the 

document. 

4. A shared document is marked as ‘Shared’ in the list on the main page. 
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Lab Exercise 1 (Browsing the Web) 

1. In Google Chrome do the following: 

 Set it as the default browser. 

 Set www.ignou.ac.in as your home page. 

 Show ‘Home’ button in the tool bar. 

 Create a folder ‘Search Engines’ in the Bookmark Manager. 

 Go to the site www.yahoo.com  and bookmark it. Save the bookmark in the 

folder ‘Search Engines’ created above. Similarly, bookmark the sites 

www.google.com and www.bing.com and save the bookmarks in the same 

folder. 

 Check your history. 

 Go to the home page directly using the home button. 

 Create another folder called ‘email’. 

 Go to www.hotmail.com  and bookmark it in ‘email’ folder. 

 Delete the ‘email’ folder. 

     (Note: For all above options use icon  on the browser toolbar) 

2. Open Internet Explorer and do the following : 

 Set IE as your default browser. 

 Set blank page as the home page. 

 Change the appearance of the browser. 

 Go to many different sites. 

 Delete your history. 

 Explore different tabs and options under Internet Options. 

 Add and Delete pages to Favorites. 

(Note: For all above options use Tools à Internet Options from the main menu) 

3. Open Mozilla Firefox  

 Explore its menu options 

 Do all the exercises that you have done for Chrome and IE in question 1 

and question 2.  

4. Go to site www.hyundai.co.in and copy the image of all Hyundai cars on our 

computer. 

Lab Exercise 2 (Searching the Web) 

1. Use different Search Engines available – for example www.live.com, 

www.ask.com, www.about.com, www.shopzilla.com, www.yahoo.com, 

www.find.com, www.monster.com. Determine what each search engine can 

be used for. Name two more search engine that are not in the given list. 
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2.  Go to Google India site. Set the number of results on a page from 10 to 15. 

Save your settings.

3.  You want to buy a LCD TV. You want to compare only Sony and Samsung 

TV. Create a search string that gives only Sony and Samsung TV’s in the 

result list and not Toshiba or LG TV’s 

4.  Search on the author Erich Segal 

 Search on all the books written by Erich Segal. 

 Search on Erich Segal who is not an author or writer and has not written 

any story. 

5.  You want know the travel to Agra from Delhi by road. You have no idea 

about the distance and the direction. Using the internet search, find out all 

the details you need. 

6.  Search for all the museums you can visit in Mumbai.  

 

Lab Exercise 3 (discussion Forums and Groups) 

1. You and your friends are planning to go on a camping trip. Create a Yahoo 

group so that all the friends interact and plan for the trip. One of you can be a 

moderator who creates the group and invite all your friends to join the group. 

Each one can contribute to the discussion and planning of the trip, for example 

to decide on the location, things to take, bookings, etc. 

2.  Create a group in Google Groups.  

3.  Register for the forum on http://www.proud2bindian.in and participate in the 

discussion on the active topics. Check the latest posts, latest threads and 

popular forums. 

4. You want to set up your own Discussion Forum Community. Think of a 

subject for you forum. Search the Internet and study the hardware and 

software requirements to set up a forum. List all the steps need to be taken. 

Also note down free and paid forum software available. 

 

Lab Exercise 4 (Wiki) 

 

1.  You and your friends are planning to go on a camping trip. Set up a wiki and 

invite all your friends to join it. Create a link to the place where you would be 

going and a list of items that need to be taken. Ask your friends to update the 

list if they can bring any item from the list. This way everybody will know 

who is bringing what through the page. 

2.  Discuss how the communication in the above case (question 1) is different 

from communicating through email or through discussion group. 

3.  Search the Internet for different wiki engines available. Consider any five and 

compare them. 
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4. Go to www.pbworks.com and setup a wiki there. Develop wiki content in 

collaboration with few friends.  Check the page history. Compare the 

revisions of the page. 

Lab Exercise 5 (Google Docs) 

1. Create a new document in Google Docs. Share it with two other people. One 

should have only view access. 

2. Create a presentation on Google docs. Ask your friend to review it and 

comment on it. Use ‘Discussion’ option for your discussions on the 

presentation. 

3. Create a spreadsheet on your computer. Upload it to Google Docs. 

4. You are a group of four people who are working together on a project report. 

Create a report on Google Docs and work on it simultaneously, each from 

your own machines. Check different versions of the document. 

6.8 SUMMARY 

World Wide Web is one of the most used services of the Internet. You can search 

the internet for any kind of information. You can create communities of people 

with similar interests to interact with each other. There are tools like Wiki and 

Google Docs available to create, share, contribute and collaborate on content 

online. Internet has made it easier for physically distant people to connect with 

each other and work together. It has brought people closer. 
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